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Brother Numbers

IMPORTANT
For technical help, you must call the country where you bought the machine. Calls must be made from 
within that country.

 

Register your product online at
 

www.brother.com/registration 
 

By registering your product with Brother, you will be recorded as the original owner of the product. Your 
registration with Brother:

• may serve as confirmation of the purchase date of your product should you lose your receipt;

• may support an insurance claim by you in the event of product loss covered by insurance; and,

• will help us notify you of enhancements to your product and special offers.

Register your new product online at www.brother.com/html/registration 

FAQs (Frequently Asked Questions)

The Brother Solutions Center is our one-stop resource for all your Brother machine needs. You can download 
the latest software and user documentation, read FAQs and troubleshooting tips, and learn how to get the 
most from your Brother product.

 

support.brother.com 
 

NOTE
• You can check here for Brother driver updates.

• To keep your machine performance up to date, check here for the latest firmware upgrade. Otherwise, 
some of your machine’s functions may not be available.

 

www.brother.com/html/registration
www.brother.com/registration
http://support.brother.com
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User’s Guides and Where Do I Find Them?

1 Visit Brother Solutions Center at support.brother.com 

Which manual? What’s in it? Where is it?

Quick Setup Guide Follow the instructions for setting up your machine 
and installing the drivers and software for the 
operating system and connection type you are using.

Printed / In the box

Product Safety Guide Read this Guide first before you set up your machine. 
See this Guide for the operating system and 
connection type you are using.

Printed / In the box

User’s Guide Learn the Scan operations and security features, 
learn how to perform routine maintenance, and see 
troubleshooting tips.

PDF file / Brother 
Solutions Center 1

Network User’s Guide This Guide provides useful information about Ethernet 
network settings and security settings using the 
Brother machine. You can also find supported 
protocol information for your machine and detailed 
troubleshooting tips.

PDF file / Brother 
Solutions Center 1

Web Connect Guide 
(ADS-2800W / ADS-3600W)

This Guide provides useful information about 
accessing Internet services from the Brother 
machine, as well as downloading images and 
uploading files directly from Internet services.

PDF file / Brother 
Solutions Center 1

Mobile Print/Scan Guide for 
Brother iPrint&Scan 
(ADS-2800W / ADS-3600W)

This Guide shows how to use your Brother machine to 
scan to, and print from, your mobile device connected 
to a Wi-Fi network.

PDF file / Brother 
Solutions Center 1

Brother Image Viewer Guide 
for Android™

This Guide provides useful information about using 
your Android™ mobile device to view and edit 
documents that were scanned by a Brother machine.

PDF file / Brother 
Solutions Center 1

http://support.brother.com
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Getting Started

Features Applications What Can I Do?
Where Should I Go for 

More Information?

Scan to PC Scan to Image ControlCenter4 
(Windows®)

Brother iPrint & 
Scan (Mac)

Scan your document directly 
into a graphics application for 
image editing.

For scanning from the Control 
Panel of the machine:

 Home Mode: Save Scanned 
Documents on Your Computer 
in Home Mode on page 130

 Advanced Mode: Save 
Scanned Documents on Your 
Computer in Advanced Mode 
on page 133

For scanning from ControlCenter4 
(Windows®):

 Home Mode: Basic Scan 
on page 78

 Advanced Mode: Basic Scan 
on page 85

Scan to OCR Scan your document and 
convert it to text. This text can 
be edited using your favourite 
word processing software.

For scanning from the Control 
Panel of the machine:

 Home Mode: Save Scanned 
Documents on Your Computer 
in Home Mode on page 130

 Advanced Mode: Save 
Scanned Documents on Your 
Computer in Advanced Mode 
on page 133

For scanning from ControlCenter4 
(Windows®):

 Home Mode: Basic Scan 
on page 78

 Advanced Mode: Basic Scan 
on page 85
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Scan to PC

(continued)

Scan to Email ControlCenter4 
(Windows®)

Brother iPrint & 
Scan (Mac)

(continued)

Scan your document to your 
default email application so 
you can send the scanned job 
as an attachment.

For scanning from the Control 
Panel of the machine:

 Home Mode: Save Scanned 
Documents on Your Computer 
in Home Mode on page 130

 Advanced Mode: Save 
Scanned Documents on Your 
Computer in Advanced Mode 
on page 133

For scanning from ControlCenter4 
(Windows®):

 Home Mode: Basic Scan 
on page 78

 Advanced Mode: Basic Scan 
on page 85

Scan to File Scan your document and save 
it to a folder on your hard disk 
in one of the file types shown in 
the file type list (for example: 
as a PDF file).

For scanning from the Control 
Panel of the machine:

 Home Mode: Save Scanned 
Documents on Your Computer 
in Home Mode on page 130

 Advanced Mode: Save 
Scanned Documents on Your 
Computer in Advanced Mode 
on page 133

For scanning from ControlCenter4 
(Windows®):

 Home Mode: Basic Scan 
on page 78

 Advanced Mode: Basic Scan 
on page 85

Features Applications What Can I Do?
Where Should I Go for 

More Information?
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Scan to PC

(continued)

Scan Using the 
TWAIN/WIA 
Driver for 
Windows® 
Users

Applications 
supporting the 
TWAIN/WIA 
driver such as:

Nuance™ 
PaperPort™ 
14SE

Windows® Fax 
and Scan

Windows® 
Photo Gallery

Use the Nuance™ 
PaperPort™ 14SE application 
included in the scanner driver, 
or other applications 
supporting TWAIN or WIA 
specifications, for scanning.

For scanning using the 
TWAIN/WIA driver:

Scan Using Nuance™ 
PaperPort™ 14SE or Other 
Windows® Applications 
on page 105

Scan Using the 
TWAIN/ICA 
Driver for 
Macintosh Users

Applications 
supporting the 
ICA driver, such 
as:

ABBYY 
FineReader Pro

Applications 
supporting the 
TWAIN/ICA 
driver, such as:

Apple Image 
Capture

Use the applications 
supporting TWAIN 
specifications for scanning.

After installing the scanner 
driver, you can also use the 
Apple Image Capture 
application for scanning.

For scanning using the TWAIN 
driver:

Scan Using TWAIN Applications 
(Macintosh) on page 122

For scanning using the ICA driver:

Scan Using Apple Image Capture 
(ICA Driver) on page 126

WS Scan 
(Windows® 
users only)
(ADS-2800W / 
ADS-3600W)

Windows® Fax 
and Scan

Windows® 
Photo Gallery

Scan your document using 
the Web Services protocol. 
The Web Services protocol 
enables you to scan over a 
network using your machine 
and a computer running 
Windows Vista®, Windows® 7, 
Windows® 8, Windows® 8.1 or 
Windows® 10.

For installing drivers:

Install Drivers Used for 
Scanning via Web Services  
(Windows Vista®, Windows® 7, 
Windows® 8, Windows® 8.1, 
Windows® 10) in the Network 
User’s Guide

For scanning from the Control 
Panel of the machine:

Scan Using Web Services 
(Windows Vista®, Windows® 7, 
Windows® 8, Windows® 8.1 and 
Windows® 10) on page 177

Features Applications What Can I Do?
Where Should I Go for 

More Information?
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Scan from 
the Control 
Panel of the 
Machine

Scan to USB — Scan your document and save 
the scanned image on a USB 
flash drive.

(ADS-2800W / ADS-3600W)

You can configure the settings 
on the machine’s control panel.

Save Scanned Documents on a 
USB Flash Drive on page 137

Scan to FTP Scan your document directly 
to an FTP server on your local 
network, or on the Internet.

Scan Documents to an FTP 
Server on page 142

Scan to SFTP Scan your document directly to 
an SFTP server on your local 
network, or on the Internet.

Scan Documents to an SFTP 
Server on page 151

Scan to 
SharePoint

Scan your document directly 
to a SharePoint server.

Scan Documents to SharePoint 
on page 169

Scan to Apps

(ADS-2800W / 
ADS-3600W)

Convert the scanned data to a 
Microsoft Office compatible 
document.

Network User’s Guide

Scan to Network 
(Windows® 
users only)

Scan your document directly 
to a shared folder on your local 
network, or on the Internet.

Scan Documents to a Shared 
Folder / Network Location 
(Windows®) on page 160

Scan to Email 
Server 

(ADS-2800W / 
ADS-3600W)

— Scan your document and send 
it directly to an email address 
from the machine. In addition, 
because this feature can 
assign an email address to 
the machine, you can use the 
machine to send documents 
over your local network or 
the Internet to computers.

Send Scanned Documents 
Directly to an Email Address 
(ADS-2800W / ADS-3600W) 
on page 179

Scan to Web

(ADS-2800W / 
ADS-3600W)

Scan your document and 
upload it directly to Web 
Services, such as Evernote, 
Dropbox, Box and OneDrive, 
without using a computer.

Web Connect Guide

Features Applications What Can I Do?
Where Should I Go for 

More Information?



vii

From 
Mobile 
Devices

Scan 
Documents 
(Brother 
iPrint&Scan)

Brother 
iPrint&Scan

Scan your document directly 
from your Android™ devices, 
iOS devices, and Windows® 
Phone without using a 
computer.

You can download and install 
Brother iPrint&Scan from 
Google Play, the App Store, or 
the Windows® Phone Store.

Mobile Print/Scan Guide 
for Brother iPrint&Scan

View or Edit 
Scanned Data 
(Android™)
(ADS-2800W / 
ADS-3600W)

Brother Image 
Viewer

Use your Android™ mobile 
device to view and edit 
documents that were scanned 
by a Brother machine.

You can download and install 
Brother Image Viewer from 
Google Play.

Brother Image Viewer Guide 
for Android™

Features Applications What Can I Do?
Where Should I Go for 

More Information?
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You Can Use the Following Features

Manage the machine securely

Streamlining Work

Feature Description
Where Should I Go for 

More Information?

Secure Function Lock 3.0
(ADS-2800W / ADS-3600W)

Allows users to choose which functions each user 
can use.

Secure Function Lock 3.0 
(ADS-2800W / ADS-3600W) 
on page 39

Active Directory Authentication
(ADS-2800W / ADS-3600W)

Restricts the use of the Brother machine unless 
users provide the user ID and password.

Active Directory 
Authentication (ADS-2800W / 
ADS-3600W) on page 48

Setting Lock
(ADS-2800W / ADS-3600W)

Allows you to prevent users who do not know the 
password from changing the machine’s settings.

Setting Lock (ADS-2800W / 
ADS-3600W) on page 37

LDAP Authentication Restricts the use of the Brother machine unless 
users enter the user name and password.

LDAP Authentication 
(ADS-2800W / ADS-3600W) 
on page 49

Feature Description
Where Should I Go for 

More Information?

Scan Using Near Field 
Communication (NFC) 
(ADS-3600W)

Allows you to scan using the settings you saved 
when you registered your NFC ID card to a 
Shortcut.

Adding ID Card Shortcuts 
(ADS-3600W only) 
on page 14

BRAdmin Light (Windows® only)

BRAdmin Professional 3 
(Windows® only) 

Allows you to manage Brother machines connected 
to a network. Using a computer, you can search for 
Brother machines on the network, display device 
status information, and change network settings.

Launch the BRAdmin Utility 
on page 73

One touch scan
(ADS-2800W / ADS-3600W)

Allows you to scan documents in your favourite 
settings with one button. To use this function, you 
must create a one touch setting in your shortcut 
and set the shortcut number on your Home screen.

Shortcut Settings 
(ADS-2800W / ADS-3600W) 
on page 10
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Saving Space and Managing Your Data

Feature Description See

Scan to FTP/SFTP Allows you to transmit scanned data directly to an 
FTP/SFTP server without using a computer. This 
feature makes it easy to share large data files that 
cannot be sent by email.

Scan Documents to an 
FTP Server on page 142

Scan Documents to an 
SFTP Server on page 151

Scan to SharePoint Allows you to transmit scanned data directly to 
SharePoint without using a computer.

Scan Documents to 
SharePoint on page 169

Scan to Email server
(ADS-2800W / ADS-3600W)

Allows you to scan documents and send them 
directly to an email address from the machine.

Send Scanned Documents 
Directly to an Email 
Address (ADS-2800W / 
ADS-3600W) on page 179

Scan to Web
(ADS-2800W / ADS-3600W)

Allows you to scan your documents and upload them 
directly to Web Services.

Upload Scanned 
Documents to the Web 
(ADS-2800W / 
ADS-3600W) on page 185

Scan to Network Allows you to scan your documents and upload them 
directly to a Network.

Scan Using Scan to 
Network Profiles 
on page 167
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Using the Guide 1

Thank you for buying a Brother machine! Reading the documentation will help you make the most of your 
machine.

Symbols and Conventions Used in the Guide 1

The following symbols and conventions are used throughout this guide.

NOTE
• Unless otherwise specified, screens and illustrations in this guide show the ADS-3600W.

• Unless otherwise specified, the screens in this manual are from Windows® 7 and OS X 10.10.x. Screens 
on your computer may vary depending on your operating system.

 

General Information 1

 CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injuries.

IMPORTANT IMPORTANT indicates a potentially hazardous situation which, if not avoided, 
may result in damage to property or loss of product functionality.

NOTE Notes tell you how you should respond to a situation that may arise or give tips about 
other scanning features.

Bold Bold typeface identifies keys on the machine control panel or computer screen.

Italics Italicised typeface emphasises an important point or refers you to a related topic.

Courier New 
(ADS-2800W / ADS-3600W)

Text in Courier New font identifies messages on the machine’s Touchscreen.
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2

1
About This Machine 1

 

1 Extendable Automatic Document Feeder (ADF)

2 Paper Guides

3 Control Panel

4 Front Cover

5 Extendable Output Tray

6 Document Stopper

7 USB 2.0 Port

8 Ethernet Cable Port

9 Hi-Speed USB 2.0 Port (ADS-2400N / ADS-2800W)
USB 3.0 SuperSpeed Port (ADS-3000N / ADS-3600W)

10 AC Adapter Connector

11 Security Slot

4

1
2

7

5

6
8

3

9
10

11
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1
Control Panel Overview (ADS-2400N / ADS-3000N) 1

 

1 Error Indicator (with LED)
Blinks when the machine is in an error state. For more information, see LED Indications (ADS-2400N / 
ADS-3000N) on page 249.

2 Power button (with LED)

You can turn the machine on and off.

Press  to turn the machine on.

Press and hold  to turn the machine off.

3 Stop button
Press the Stop button to:
 Stop document feed
 Cancel a job 
 Wake the machine up
 Recover from an error 
 Disconnect Remote Setup 

4 Scan to USB button (with LED)
Press the Scan to USB button to:
 Scan to USB 
 Wake the machine up 

5 Scan to PC button (with LED)
Press the Scan to PC button (USB Connect) to:
 Scan to PC 
 Wake the machine up

6 5 4 3 2 1
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1
6

You can assign the Scan to FTP/SFTP, Scan to Network, Scan to Sharepoint, Scan to PC (Network Connect), 
or WS Scan functions to these buttons. After configuring the settings, press the button to select your assigned 
function. 
These buttons are available only if the machine was set up using the wired network method with the 
installation disc and a USB cable (see the Quick Setup Guide). 
For more information, see Scan Documents to an FTP Server on page 142, or Scan Using Web Services 
(Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1 and Windows® 10) on page 177.
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1
Control Panel Overview (ADS-2800W / ADS-3600W) 1

 

1  (Back Button)
Press to go back to the previous screen or menu. The Back button lights up when it is available.

2  (Power On/Off)

Press  to turn the machine on. Press and hold  to turn the machine off. The Touchscreen displays 

Shutting Down and stays on for a few seconds before going off.

3  (Home Button)
Press to return to the Home Screen and Ready Mode. The Home button lights up when it is available.

4  (Stop Button)
Press to stop or cancel your current action and return to Ready Mode. The Stop button lights up when it 
is available. 

5 Touchscreen LCD
Access the menus and options by pressing the Touchscreen.

6 NFC (Near Field Communication) Reader
(ADS-3600W)
You can use card authentication by touching the IC card to the NFC Reader on the control panel.
If your Android™ device supports the NFC standard, you can scan to your device by touching it to the NFC 
logo. You must download and install Brother iPrint&Scan to your Android™ device to use this feature.

5 4 36 2 1
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1
Touchscreen LCD 1

You can select one of four screens as the Home screen. When the Home screen is displayed, you can 
change the displayed screen by swiping left or right, or pressing d or c.

The following screens display the machine’s status when the machine is idle:

NOTE
“Swiping” means sliding your finger across the Touchscreen to display the next page or item.

 

 Scan 1 screen

The Scan 1 screen provides access to scan features, such as 
Scan to Web, Scan to PC, Scan to Network.

 Scan 2 screen

The Scan 2 screen provides access to scan features, such as 
Scan to FTP/SFTP, Scan to E-mail Server, Scan to SharePoint.

 Scan 3 screen

The Scan 3 screen provides access to scan features, such as WS Scan 
and Scan to USB, and additional features, such as Apps. The WS Scan 
screen appears if you have set up the WS Scan function. 

4 5 63

1 2

7 8 9

10 11 12
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1
1  (WiFi Setup)

A four-level indicator on the Ready Mode screen displays the current wireless signal strength when using 
a wireless connection.

2  (All Settings)

Press to access the main settings (for more information, see Settings screen on page 9).

3  (Shortcuts)

Press to set up Shortcuts.

You can quickly scan and connect to web services using the options set as Shortcuts.

NOTE
 

Eight Shortcut tabs are available. You can set up to six Shortcuts in each Shortcut tab. A total of 48 Shortcuts 
are available.
 

4 to Web

Press to connect the Brother machine to an Internet service (for more information, see the Web Connect 
Guide).

5 to PC

Press to access the Scan to PC function.

6 to Network

Press to access the Scan to Network function.

7 to FTP/SFTP

Press to access the Scan to FTP/SFTP function.

8 to E-mail Server

Press to access the Scan to E-mail Server function.

9 to SharePoint

Press to access the Scan to SharePoint function.

    

0 Max
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1
10 Apps

Press to connect the Brother machine to the Brother Apps menu. (For more information, see the Web 
Connect Guide.)

11 WS Scan

Press to access the WS Scan function. 

This icon appears when you have selected WS scan. (For more information, see the Network User’s Guide.)

12 to USB 

Press to access the Scan to USB function.

13 Warning icon 

The warning icon  appears when there is an error or maintenance message;  press  to return to 
Ready Mode.

For more information, see Error and Maintenance Messages on page 225.

NOTE
This product adopts the font of ARPHIC TECHNOLOGY CO., LTD.
 

Auto Start Scan 1

The Auto Start Scan feature allows you to start scanning automatically as soon as a document is placed in the ADF. 
To use Auto Start Scan, you must first create an Auto Start Scan Shortcut, and then enable the Auto Start Scan 
setting in General Setup:

1 Press Shortcuts.

2 Press the 9th Shortcut tab.
 

3 Press  to add the Auto Start Scan Shortcut.

4 Select the Shortcut function (for example, Scan to PC).

5 Press Save as Shortcut. When the LCD displays These settings will be saved as a 
shortcut., press OK.

6 Enter the Shortcut Name. When the LCD displays Make this a One Touch Shortcut?, press OK.

7 Press  (All Settings) to access the Settings menu.  Press General Setup > Auto Start Scan 

Mode and select On.
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1
NOTE

Only one Auto Start Scan profile can be saved at a time.
 

Settings screen 1

Press  (All Settings) to check and access all the machine’s settings.

 General Setup

Press to access the full Settings menu.

 Shortcut Settings

Press to set Shortcuts.

For more information, see Shortcut Settings (ADS-2800W / ADS-3600W) on page 10.

 Network

Press to access Network settings.

 Machine Info.

Press to check the machine’s information.

 Initial Setup

Press to access the Date & Time, Scan offset correction, Reset and Local Language menus.

Basic Operations 1

Press your finger on the Touchscreen to operate it. To display and access all the screen menus or options, 
swipe left, right, up, down, or press d c or a b to scroll through them.

IMPORTANT
DO NOT press the Touchscreen with a sharp object, such as a pen or stylus. It may damage the machine.

 

The following example shows how to change a machine setting. In this example, the Document Size setting 
in Scan to USB is changed to Auto.

1 Swipe left or right, or press d or c to display Scan 3.

2 Press to USB.

3 Press Options.

4 Press a or b to display Document Size.

5 Press Document Size.

6 Press a or b to display Auto.

7 Press Auto.

NOTE

Press  to go back to the previous screen or menu.
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Shortcut Settings (ADS-2800W / ADS-3600W) 1

You can add the scan and Web Connect settings you use most frequently as your Shortcuts. Later you can 
recall and apply these settings quickly. You can add up to 48 Shortcuts.

Adding Scan Shortcuts 1

The following settings can be included in a scan Shortcut:

*1 The Profile name setting contains many items. For more information, see the Network User’s Guide.

1 Press .

2 Press a tab from 1 to 8.

3 Press  where you want to add a Shortcut.

Setting to PC to USB
to E-mail 
Server

to FTP / 
SFTP

to Network
to 

SharePoint

PC Name  

- - - - -

Scan Settings  

- - - - -

2-sided Scan    

- - -

Scan Type    

- - -

Resolution    

- - -

File Type    

- - -

Document Size    

- - -

File Name -
  

- - -

File Name Style -
  

- - -

File Size -
  

- - -

Auto Deskew    

- - -

Skip Blank Page    

- - -

Brightness    

- - -

Contrast    

- - -

Colour -
  

- - -

Black and White/Grey -
  

- - -

Skip blank page 
sensitivity

   

- - -

Margin Settings -
  

- - -

Document Separation -
     

Profile name *1 - - -
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4 Swipe up or down, or press a or b to display the type of scan you want, and then press it.

5 Do one of the following:

 If you pressed to USB, go to step 8.

 If you pressed to E-mail Server, go to step6.

 If you pressed to OCR, to File, to Image or to E-mail, go to step7.

 If you pressed to FTP/SFTP, to Network or to SharePoint, swipe up or down, or press a or b 
to display the Profile Name, and then press it. Go to stepB.

NOTE
To add a Shortcut for to FTP/SFTP, to Network or to SharePoint you create a Profile Name first.

 

6 Do one of the following:

 To enter an email address manually, press Manual. Enter the email address you want using the 
keyboard on the machine’s Touchscreen. (For help with entering text using the Touchscreen, 
see Entering Text (ADS-2800W / ADS-3600W) on page 248.)

Press OK.

 To enter an email address from the Address Book, press Address Book. Swipe up or down, 
or press a or b to display the email address you want, and then press it.

Press OK.

After you confirm the email address you have entered, press OK. Go to step8.

NOTE
Press Detail to view the list of addresses you have entered.

 

7 Do one of the following:

When the machine is connected to a computer using a USB connection:

Press USB to confirm that USB is selected as the PC Name. Go to step A.

When the machine is connected to a network:

Swipe up or down, or press a or b to display the PC Name, and then press it. Go to step8.

8 Press Options.

9 Swipe up or down, or press a or b to display the available settings, and then press the setting you want.

0 Swipe up or down, or press a or b to display the available options for the setting, and then press the 
option you want.
Repeat steps 9 and 0 until you have selected all the settings for this Shortcut.
Press OK.

A Review the settings you have selected:

 To make more changes, return to step8.

 To finish, press Save as Shortcut.
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B Review your settings on the Touchscreen, and then press OK.

C Enter a name for the Shortcut using the keyboard on the machine’s Touchscreen. (For help with entering 
text using the Touchscreen see Entering Text (ADS-2800W / ADS-3600W) on page 248.)
Press OK.

D Press OK to save your Shortcut.

Adding Web Connect Shortcuts 1

The settings for these services can be included in a Web Connect Shortcut:

 Box

 Google Drive™

 Evernote®

 Evernote Business

 Dropbox

 OneDrive

 OneNote

NOTE
• Web services may have been added or service names may have been changed by the provider since this 

document was published.

• To add a Web Connect Shortcut, you must have an account with the service you want to use (for more 
information, see the Web Connect Guide).

 

1 Press .

2 Press a tab from 1 to 8.

3 Press  where you have not added a Shortcut.

4 Press to Web.

5 If information about the Internet connection appears, read the information and confirm it by pressing OK.

6 Swipe left or right, or press d or c to display the available services, and then press the service you want.

7 Press your account.
If the account needs a PIN (Personal Identification Number), enter the PIN for the account using the 
keyboard on the machine’s Touchscreen.
Press OK.

8 Press the function you want.

NOTE
The functions that can be set may vary depending on the selected service.
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9 Read and confirm the displayed list of functions you have selected, and then press OK.

0 Enter a name for the Shortcut using the keyboard on the machine’s Touchscreen. (For help with entering 
text using the Touchscreen see Entering Text (ADS-2800W / ADS-3600W) on page 248.)
Press OK.

A Press OK to save your Shortcut.

Adding Apps Shortcuts 1

The settings for these services can be included in an Apps Shortcut:

 NoteScan

 Outline&Scan

NOTE
Web services may have been added or service names may have been changed by the provider since this 
document was published.

 

1 Press .

2 Press a tab from 1 to 8.

3 Press  where you have not added a Shortcut.

4 Press Apps.

5 If information about the Internet connection appears, read the information and confirm it by pressing OK.

6 Swipe left or right, or press d or c to display the available apps, and then press the app you want.

NOTE
The available apps depend on the selected service.

 

7 Press your account.
If the account needs a PIN, enter the PIN for the account using the keyboard on the machine’s 
Touchscreen.
Press OK.

8 Read and confirm the displayed list of apps you have selected, and then press OK.

9 Enter a name for the Shortcut using the keyboard on the machine’s Touchscreen. (For help with entering 
text using the Touchscreen see Entering Text (ADS-2800W / ADS-3600W) on page 248.)
Press OK.

0 Press OK to save your Shortcut.
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Adding ID Card Shortcuts (ADS-3600W only) 1

1 Press .

2 Press a tab from 1 to 8 to display the Shortcut you want.

3 Press and hold the Shortcut button.

4 Press Register NFC.

NOTE
• You cannot use the same ID card for different Shortcuts.

• To use the ID card for another Shortcut, unregister the card first, and then register it with the new Shortcut.

 

Changing Shortcuts 1

You can change the settings in a Shortcut.

NOTE
To change a Web Connect Shortcut, delete it first, and then add a new Shortcut.

(For more information, see Deleting Shortcuts on page 15 and Adding Web Connect Shortcuts 
on page 12.)

 

1 Press .

2 Press a tab from 1 to 8 to display the Shortcut you want to change.

3 Press the Shortcut you want, and then press Options. The settings for the Shortcut that you have 
selected appear.

4 Change the settings for the Shortcut you have selected in step3 (for more information, see Shortcut 
Settings (ADS-2800W / ADS-3600W) on page 10).

5 When finished, press OK, and then press Save as Shortcut.

6 Press OK to confirm.

7 Do one of the following:

 To overwrite the Shortcut, press Yes.

 To keep the existing Shortcut, press No to enter a new Shortcut name. Go to step8.

8 To create a new Shortcut, press  and hold down  to delete the current name, and then enter a new 
name using the keyboard on the machine’s Touchscreen. (For help with entering text using the 
Touchscreen, see Entering Text (ADS-2800W / ADS-3600W) on page 248.)
Press OK.

9 Press OK to confirm.
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Editing Shortcut Names 1

You can edit a Shortcut name.

1 Press .

2 Press a tab from 1 to 8 to display the Shortcut you want.

3 Press and hold the Shortcut button.

4 Press Rename.

5 To edit the name, press and hold  to delete the current name, and then enter a new name using 
the keyboard on the machine’s Touchscreen. (For help with entering text using the Touchscreen, 
see Entering Text (ADS-2800W / ADS-3600W) on page 248.)
Press OK.

Deleting Shortcuts 1

You can delete a Shortcut.

1 Press .

2 Press a tab from 1 to 8 to display the Shortcut you want.

3 Press and hold the Shortcut button.

4 Press Delete to delete the Shortcut that you have selected in step3.

5 Press Yes to confirm.

Recalling Shortcuts 1

The Shortcut settings appear on the Shortcut screen. To recall a Shortcut, simply press the Shortcut name.

1 Press .

2 Press a tab from 1 to 8 to display the Shortcut you want.

3 Press the Shortcut button.
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Accessing Brother Utilities (Windows®) 1

Brother Utilities  is an application launcher that offers convenient access to all Brother applications 
installed on your computer.

1 Launch Brother Utilities for your operating system:

Windows® 7 / Windows Vista® / Windows® XP

Click  (Start) menu, select All Programs > Brother >  (Brother Utilities).

Windows® 8

Tap or click  (Brother Utilities) either on the Start screen or the desktop.

Windows® 8.1

Move your mouse to the lower left corner of the Start screen and click  (if using a touch-based 
device, swipe up from the bottom of the Start screen to bring up the Apps screen). When the Apps 

screen appears, tap or click  (Brother Utilities).

Windows® 10

Click  (Start) menu, select All apps > Brother >  (Brother Utilities).

2 Select your machine.
 

3 Select the operation you want to use.
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General Setup (ADS-2400N / ADS-3000N) 1

Set Date&Time 1

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE

If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 Click the Remote Setup button. The Remote Setup window appears.

NOTE
For more information about Remote Setup, see Set Up the Brother Machine from Your Computer 
on page 199. 

 

http://support.brother.com
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1
3 Select Initial Setup in the navigation tree.

Windows®
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1
 Macintosh

 

4 Select Date&Time.

If you set Auto Daylight to On, the time will be adjusted forward one hour in Spring and adjusted 
backwards one hour in Autumn.

5 Click OK.



General Information 

21

1
Set Sleep Time 1

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE

If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 The Remote Setup window appears.

NOTE
For more information about Remote Setup, see Set Up the Brother Machine from Your Computer 
on page 199. 

 

http://support.brother.com
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1
3 Select General Setup in the navigation tree.

Windows®
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1
 Macintosh

 

4 Select how long the machine must be idle before going to sleep. To wake the machine do one of the 
following:

 Press any key.

 Open the top cover.

 Load your document.

 Touch the Screen

 Touch an IC Card to the NFC reader

5 Click OK.
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Select Your Language 1

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE

If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 The Remote Setup window appears.

http://support.brother.com
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1
3 Select Language in the navigation tree.

Windows®
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1
 Macintosh

 

4 Select the language you want from the Language on Remote Setup drop-down list.

5 Click OK.

NOTE
You must close the Remote Setup window to save the new language setting.
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Assign the Scan Feature to the Network Device Key 1-3 1

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Scan to Net Settings button.
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1
NOTE

If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 Confirm that your Brother machine is connected to the same network as your computer or mobile 
device.

2 Start your web browser.

3 Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is 
the machine's IP address).
For example: http://192.168.1.2

NOTE
• You can see your machine’s IP address in the Network menu on the control panel of your machine.

• If you have set a login password for Web Based Management, type your password in the Login box, then 

click .
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1
2 The Web Based Management window appears.

NOTE
The Scan to Network Device option appears only if you have selected LAN in the connection interface 
during installation.

 

 

3 Select the network device (1, 2 or 3) where you want to assign the Scan to Network feature.

4 Select Scan to Network, Scan to Sharepoint, Scan to FTP/SFTP, Scan to PC, WS Scan or None 
from the Type drop-down list for the device you have selected in 3.

5 Select a profile name from the Destination drop-down list for the device you have selected in 3.

6 Click Submit.

Your Machine’s Control Panel Icon Setting

Network Device 1

Network Device 2

Network Device 3
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General Setup (ADS-2800W / ADS-3600W) 1

Set the Backlight Brightness 1

You can adjust the brightness of the Touchscreen backlight. If you are having difficulty reading the 
Touchscreen, try changing the brightness setting.

1 Press  (All Settings).

2 Press General Setup.

3 Press LCD Settings.

4 Press Backlight.

5 Press Light, Med or Dark.

6 Press .

Set the Dim Timer for the Backlight 1

You can set how long the Touchscreen backlight stays on after the Ready Screen appears.

1 Press  (All Settings).

2 Press General Setup.

3 Press LCD Settings.

4 Press Dim Timer.

5 Press Off, 10Secs, 20Secs or 30Secs.

6 Press .

Set the Home Screen 1

Set the Ready screen to either Scan 1-3 or Shortcut 1-8.
For examples of these screens, see Touchscreen LCD on page 6.

When the machine is idle, or if you press , the Touchscreen displays the screen you have set.

1 Press  (All Settings).

2 Press General Setup.

3 Press Screen Settings.

4 Press Home Screen.

5 Press Scan 1-3 or Shortcut 1-8.

6 Press .
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Select Your Language 1

1 Press  (All Settings).

2 Press a or b to display Initial Setup.

3 Press Initial Setup.

4 Press Local Language.

5 Press a or b to display your language.
Press your language.

6 Press .

Memory Storage 1

Your menu settings are stored permanently and, in the event of a power failure, only temporary settings will 
be lost. If you have selected Set New Default for your Scan to USB and Scan to E-mail Server preferred 
settings, those settings will not be lost. Also, during a power failure, the machine keeps the date and time 
settings for approximately 24 hours.

Beep Volume 1

When the Beep setting is Low, Med or High, the machine beeps when you press a key or make a mistake.

You can choose from a range of beep volume levels (from Low to High), or choose Off.

1 Press  (All Settings).

2 Press General Setup.

3 Press Volume.

4 Press Beep.

5 Press Low, Med, High or Off.

6 Press .
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Automatic Daylight Saving Time 1

You can set the machine to change the time automatically for daylight saving time. The time is adjusted 
forward one hour in Spring and adjusted backwards one hour in Autumn. Make sure you have set the correct 
date and time in the Date & Time settings.

The factory setting is Off. To change the Automatic Daylight Saving Time setting to On:

1 Press  (All Settings).

2 Press a or b to display Initial Setup.

3 Press Initial Setup.

4 Press Date & Time.

5 Press Auto Daylight.

6 Press On.

7 Press .

Sleep Time 1

You can enter how long the machine must remain idle (the maximum setting is 90 Mins and the default 
setting is 10 Mins) before it enters Sleep Mode. The timer restarts if any operation is carried out on the 
machine.

1 Press  (All Settings).

2 Press General Setup.

3 Press Ecology.

4 Press Sleep Time.

5 Enter the period of time the machine is idle before entering Sleep Mode.

6 Press OK.

7 Press .
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Auto Power Off 1

The Auto Power Off feature can reduce power consumption. Set the period of time that the machine will be 
in Sleep Mode before it automatically powers off. When this feature is set to Off, you must turn the machine 

off manually. To turn the machine on after the Auto Power Off feature has turned it off, press . 

The timer will restart if you do one of the following: 

 Press .

 Press any buttons.

 Open the ADF cover.

1 Press  (All Settings).

2 Press General Setup.

3 Press Ecology.

4 Press Auto Power Off.

5 Select the period of time the machine is idle before entering Auto Power Off Mode.

6 Press .

Auto Power Off will be activated when all of the below conditions are met:

 Network cable is not plugged in.

Wireless LAN is disabled.

 Auto Power Off setting is not set Off.

 The machine has been in Sleep Mode for more than the set period.
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Multifeed Detection 1

Multifeed occurs when the machine feeds multiple pages at the same time. When the Multifeed Detection 
feature is set to On, and your machine detects a multifeed, you must confirm that the data scanned so far has 
been saved, and then start scanning again at the next page or the beginning of the document.

NOTE
(Scan to USB only) (ADS-2400N / ADS-3000N)

If you have selected JPEG as the file type, your Brother machine saves all data scanned before the 
multifeed error occurred.

 

1 Press  (All Settings).

2 Press General Setup.

3 Press a or b to display Multi-feed Detection.

4 Press Multi-feed Detection.

5 Press On (or Off).

6 Press .
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Setting Lock (ADS-2800W / ADS-3600W) 1

Setting Lock lets you set a password to stop other users from accidentally changing your machine’s settings. 
Write down your password carefully. If you forget it, you must reset the passwords stored in the machine or 
contact your administrator or Brother customer service.

When Setting Lock is On, you cannot change the following settings without a password:

 General Setup

 Shortcut Settings

 Network

 Machine Info.

 Initial Setup

 Save as Shortcut in all scan-to actions

 Set New Default and Factory Reset in to USB

 Address Book, Set New Default and Factory Reset in to E-mail Server

Set the Password 1

1 Press  (All Settings).

2 Press General Setup.

3 Press Setting Lock.

4 Enter a four-digit number for the password using numbers 0-9.
Press OK.

5 Re-enter your password when the Touchscreen displays Verify:.
Press OK.

6 Press .
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1
Change the Password 1

1 Press  (All Settings).

2 Press General Setup.

3 Press Setting Lock.

4 Press Set Password.

5 Enter your existing four-digit password.
Press OK.

6 Enter a new four-digit number as the password.
Press OK.

7 Re-enter your new password when the Touchscreen displays Verify:.
Press OK.

8 Press .

Turn Setting Lock On/Off 1

If the Touchscreen displays Wrong Password, enter the correct password.

Turn Setting Lock On 1

1 Press  (All Settings).

2 Press General Setup.

3 Press Setting Lock.

4 Press Lock OffOn.

5 Enter the registered four-digit password using the keyboard on the machine’s Touchscreen, and then 
press OK.

Turn Setting Lock Off 1

1 Press .

2 Enter the registered four-digit administrator password using the keyboard on the machine’s 
Touchscreen.
Press OK.

3 Press .
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Secure Function Lock 3.0 (ADS-2800W / ADS-3600W) 1

Using the Secure Function Lock feature you can restrict public access to the following features of your Brother 
machine:

 Scan to PC

 Scan to FTP

 Scan to Network

 Scan to USB

 Scan to Web

 Scan to Email Server

 Scan to SharePoint

 Scan to WSS (Web Service Scan)

 Apps

This feature also prevents users from changing the default settings of the machine by limiting access to the 
machine’s settings.

The administrator can set up restrictions for individual users along with a user password.

NOTE
• Secure Function Lock can be set using Web Based Management or BRAdmin Professional 3 

(Windows® only).

• Only administrators can set limitations and make changes for each user.

• (For ADS-3600W) 
Use card authentication to switch to a different user and access operations, such as Scan to PC, Scan to FTP, 
or Scan to Network.
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Before you Begin to Use Secure Function Lock 3.0 1

You can configure the Secure Function Lock settings using a web browser. Before you begin, do the following:

1 Start your web browser.

2 In your browser’s address bar, type your machine’s IP address (or your print server name). 
For example: http://192.168.1.2/
You can use the machine’s LCD to find its IP address.

NOTE
• You can find the machine’s IP address in the Network Configuration List (see the Network User’s Guide).

• If using a Domain Name System, or have enabled a NetBIOS name, enter another name such as 
“SharedScanner” instead of the IP address.

• For example:
http://SharedScanner/
If you have enabled a NetBIOS name, you can also use the node name.

• For example:
http://brwxxxxxxxxxxxx/
You can find the NetBIOS name on the LCD, under Node Name.

 

3 Type the Administrator password in the Login box. (This is a password to log on to the machine’s web 
page.) Click .
 

NOTE
If using a web browser to configure the machine’s settings for the first time, set a password (see the 
Network User’s Guide).
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1
Turning Secure Function Lock On/Off 1

1 Click Administrator.

2 Click User Restriction Function.

3 Select Secure Function Lock or Off.

4 Click Submit.

NOTE
The Secure Function Lock icon appears at the top of the screen.
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Configure Secure Function Lock 3.0 Using Web Based Management 1

Set up groups with restrictions and users with a password and card ID 1. You can set up to 100 restricted 
groups and 100 users using a web browser. To set up the web page, see Before you Begin to Use Secure 
Function Lock 3.0 on page 40, and then follow these steps:
1 For ADS-3600W

1 Click Administrator.

2 Click Restricted Functions xx-xx.

3 Type an alphanumeric Group name (up to 15 characters) in the User List / Restricted Functions field.
 

4 In the Scan to and Apps, clear the check box to restrict access to operations. 

5 Click Submit.

6 Click User List xx-xx.

7 In the User List field, type the user name up to 20 characters.

8 In the PIN Number field, type a four-digit password.

9 (For ADS-3600W)
In the Card ID field, type the card number (up to 16 characters). 1

1 You can use numbers from 0 to 9 and letters from A to F (not case-sensitive).
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1
0 Select User List / Restricted Functions from the drop-down list for each user.

 

A Click Submit.
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Setting Up the Card Authentication for Users (For ADS-3600W) 1

Before setting up the card authentication users, you must set up restricted operations and a user list using 
the web browser.

For more information, see Configure Secure Function Lock 3.0 Using Web Based Management on page 42.

1 Switch to the restricted user mode using the Touchscreen (for more information, see Switching to the 
restricted user mode using the Touchscreen on page 46).

2 Press .

3 Press Register Card.

4 Touch the card to the NFC Reader. The Touchscreen displays the card ID.

5 Press OK.

NOTE
• To change the card ID, touch the new card to the NFC Reader in step 4.

• If the card is in a case or cover, the NFC Reader may not be able to detect it. Always remove the card from 
a case or cover when you touch the card to the NFC Reader.

 

Setting Up and Changing the Public User Mode 1

The public user mode restricts the operations that are available for all users who do not have a password.

To set up restrictions for public users, use Web Based Management or BRAdmin Professional 3 (Windows® 
only) (see the Network User’s Guide).

1 Click Administrator.

2 Click Restricted Functions xx-xx.

XXXXX
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3 In the Public Mode row, clear the check box to restrict the operation in the public user mode. 

 

4 Click Submit.



General Information 

46

1
Switching Users 1

This setting allows you to switch between registered restricted users or Public mode when Secure Function 
Lock is turned on.

Switching to the restricted user mode using the Touchscreen 1

1 Press  or . 

(Where xxxxx is the user’s name.)

2 Press Change User.

3 Swipe up or down, or press a or b to display your user name.

4 Press your user name.

5 Enter your four-digit user password using the Touchscreen keyboard.
Press OK.

NOTE
If the current ID is restricted for the operation you want, Access Denied appears on the Touchscreen.

 

Switching to the restricted user mode using the NFC Reader (For ADS-3600W) 1

1 Press  to return to the Ready screen.

2 Touch the card to the NFC Reader.

NOTE
• You can log on by touching the card to the NFC Reader even if the machine is set to Public mode or 

another user is logged on.

• If the card is in a case or cover, the NFC Reader may not be able to detect it. Always remove the card from 
a case or cover when you touch the card to the NFC Reader.

 

XXXXX
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Switching to Public mode using the Touchscreen 1

1 Press . 

(Where xxxxx is the user’s name.)

2 Press Go to Public.

NOTE
• After a restricted user has finished using the machine, it returns to Public mode after one minute.

• If the operation you want is restricted for all users, Access Denied appears on the Touchscreen followed 
by the Change User screen. You cannot access the operation. Contact your administrator to check your 
Secure Function Lock Settings.

 

XXXXX
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Active Directory Authentication (ADS-2800W / ADS-3600W) 1

Active Directory Authentication restricts the use of the Brother machine. If Active Directory Authentication 
is enabled, the machine’s control panel is locked. The machine’s settings cannot be changed until the user 
enters the user ID and password.

Active Directory Authentication allows you to:

 Obtain the user’s email address from the LDAP server

 Obtain the user’s home directory and set the storage directory for Scan to Network

You can change the Active Directory Authentication setting using Web Based Management or BRAdmin 
Professional 3 (Windows®).

For more information about Active Directory Authentication, see the Network User’s Guide.

Turning Active Directory Authentication Lock On/Off 1

1 Start your web browser.

2 In your browser’s address bar, type your machine’s IP address (or your print server name).
For example: http://192.168.1.2/
You can use the machine’s LCD to find its IP address.

3 Click Administrator.

4 Click User Restriction Function.

5 Select Active Directory Authentication or Off.

6 Click Submit.

NOTE
• You must configure Active Directory Server Settings to enable Active Directory Authentication.

• Control Panel Lock is enabled only if Active Directory Server is configured correctly. 
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LDAP Authentication (ADS-2800W / ADS-3600W) 1

LDAP Authentication restricts the use of your Brother machine. The machine’s settings cannot be changed 
until the user enters the user ID and password.

For more information about LDAP Authentication, see the Network User’s Guide.

Turning LDAP Authentication Lock On/Off 1

1 Start your web browser.

2 In your browser’s address bar, type your machine’s IP address (or your print server name). 
For example: http://192.168.1.2/
You can use the machine’s LCD to find its IP address.

3 Click Administrator.

4 Click User Restriction Function.

5 Select LDAP Authentication or Off.

6 Click Submit.
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Acceptable Documents 2

NOTE
Do not load documents of varying page thickness or paper quality.

 

Standard Paper

*1 For best performance we recommend using a carrier sheet for documents between 27 g/m2 and 39 g/m2.

Thick Paper

Document Specifications 2

Length 51 mm to 297 mm

Width 51 mm to 215.9 mm

Weight *1 27 g/m2 to 413 g/m2 

Thickness 0.05 mm to 0.26 mm
To scan thinner documents, use the Carrier Sheet.

Maximum Number of Pages Up to 50 pages and less than 5 mm

Standard Paper Size A4 210 mm × 297 mm

A5 148 mm × 210 mm

A6 105 mm × 148 mm

A7 74 mm × 105 mm

A8 52 mm × 74 mm

B5 182 mm × 257 mm

B6 128 mm × 182 mm

B7 91 mm × 128 mm

B8 64 mm × 91 mm

Legal 215.9 mm × 355.6 mm

Mexican Legal 215.9 mm × 339.9 mm

India Legal 215 mm × 345 mm

Letter 215.9 mm × 279.4 mm

Length 51 mm to 297 mm

Width 51 mm to 215.9 mm

Weight 210 g/m2 to 413 g/m2

Thickness 0.26 mm to 0.5 mm

Maximum Number of Pages Less than 5 mm
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Long Paper

NOTE
• To scan a document between 355.6 mm and 5,000 mm, select Long Paper as Scan Size or Document 

Size in the settings dialog box.

• The maximum length will change depending on the resolution and file format when scanning.
 

Plastic Card

NOTE
You can scan and save a plastic card to your computer as an image file. Select the Plastic Card Mode 
check box in the settings dialog box.

 

Carrier Sheet

NOTE
A Carrier Sheet can be used when saving the scanned image to your computer. The Carrier Sheet cannot 
be used when scanning to a USB flash drive. Select the Carrier Sheet Mode check box in the settings 
dialog box. 

 

Length 297 mm to 355.6 mm

Width 51 mm to 215.9 mm

Weight 40 g/m2 to 209 g/m2

Thickness 0.06 mm to 0.26 mm
To scan thinner documents, use the Carrier Sheet.

Maximum Number of Pages Up to 40 pages and less than 4 mm

Size (ISO) 85.6 mm × 54.0 mm 

Material Plastic (PET)

Type Plastic cards, such as a driving licence or store card

Thickness Up to 1.4 mm

Maximum Number of Pages Up to 5 cards and less than 5.0 mm

Thickness A total thickness of no more than 0.6 mm (one 0.3 mm document 
plus the Carrier Sheet)

Maximum Number of Pages 1 page
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Unacceptable Documents 2

The following types of documents may not be scanned successfully:

 Documents with a carbon sheet attached 

 Documents written in pencil 

 Documents of uneven thickness, such as envelopes 

 Documents with large wrinkles or curls 

 Documents that use tracing paper 

 Documents that use coated paper 

 Photographs (photographic paper) 

 Documents printed on perforated paper 

 Documents printed on unusually-shaped paper (not square or rectangular) 

 Documents with photos, notes, or stickers affixed to them 

 Documents that use carbonless paper 

 Documents that use loose-leaf paper or any paper with holes in it 

 Documents with paper clips or staples 

 Documents with wet ink 

 Fabrics, metallic sheets, or overhead projector sheets 

 Glossy or mirrored media 

 Documents that exceed recommended thicknesses

IMPORTANT
• Carbonless papers contain chemical substances that may damage the rollers (for example, the pick-up 

roller). If paper jams occur frequently, clean the reverse roller and pick-up roller. (See Clean the Scanner 
and Rollers on page 205.) The life of the reverse roller and pick-up roller may be reduced compared to 
scanning wood-containing paper.

• When scanning wood-containing papers, the life of the reverse roller and pick-up roller may be reduced 
compared to scanning wood-free paper.

• The reverse roller and pick-up roller may become damaged when a photo or sticky note on the document 
touches these parts during scanning.

• The surface of the document may be damaged when scanning glossy papers such as photographs.

• The damage caused by using any unacceptable documents with your Brother machine may not be 
covered under warranty.
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Loading Capacity 2

The number of sheets that can be loaded in the Paper Guides is determined by the paper size and paper 
weight. See the graph below. 
 

Capacity (Sheets) vs Paper Type

Unit Paper Type 25 40 52 64 75 80 90 104 127 157 209 256 413

Capacity 
(Sheets)

A4, LTR 50 50 50 50 50 50 44 38 31 25 19 16 10

LGL - 41 41 41 41 41 36 31 26 21 16 13 8

Paper weight (g/m2)

C
ap

ac
ity

 (
sh

ee
ts

)
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Area Not to be Perforated 2

An error may occur if your document has punched holes in the area shaded in light blue in the following figure:
 

NOTE
The above condition applies when the document is set in the centre of the pick-up roller.

 

(Unit: mm)

Top
Reference point

Front side

Feed
direction

Bottom

35

Centre

40
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Conditions for Multifeed Detection 2

Multifeed is an error where two or more sheets are fed through the ADF at once. It is also called a multifeed 
when a different document length is detected.

Multifeed detection is performed by either checking the overlapping of documents, length of the documents, 
or the combination of both. The following conditions are required for an accurate detection.

 Detection by overlapping

• Load documents of the same paper weight in the Paper Guides.

• Suitable paper weight: between 27 g/m2 and 413 g/m2.

• Do not punch holes within 40 mm over the centre of the document.

• Do not attach other documents within 40 mm over the centre of the document.

NOTE
• The condition applies when the document is set in the centre of the pick-up roller.

• When you use detection by overlapping, scanning thick documents, such as plastic cards, will be 
incorrectly detected as a multifeed.

To scan these documents successfully, disable the multifeed detection function.
 

Scanning a Mixed Batch 2

The following conditions apply when scanning a mixed batch of documents with different paper weights, 
friction coefficients or sizes.

Make sure to test a few sheets first to check if the documents can be scanned.

 Paper direction

Align the direction of the paper fibre with the feed direction.

 Paper weight

Only paper weights between 40 g/m2 and 413 g/m2 can be used.

 Friction coefficient

We recommend using the same type of paper from the same manufacturer.

When papers of different manufacturers/brands are mixed, it affects the feeding performance as the 
difference in the friction coefficient increases.

We recommend using friction coefficients between 0.35 and 0.60 (reference value for paper friction 
coefficient).

 Document position

Use paper sizes that fit the 39 mm width of the pick-up roller in the centre.
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 Paper size

When you scan a mixed batch with different sizes, not feeding the documents straight may cause 
problems, such as paper jams or part of the image to appear missing.

We recommend checking the documents thoroughly before scanning and also checking the image if the 
document was skewed.

IMPORTANT
When scanning a mixed batch with different sizes, documents are more likely to skew because the paper 
guides do not contact every sheet.
 

 Documents that cannot be scanned in a mixed batch

The following types of documents cannot be mixed in the same batch:

• Carbonless paper

• Bond paper

• Perforated documents

• Thermal paper

• Carbon-backed paper

• OHP film

• Tracing paper

• Synthetic paper

IMPORTANT
The following types of documents may not be scanned successfully:

• Bent or damaged documents

• Thin paper (less than 40 g/m2)
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Carrier Sheet Recommendations 2

 Documents with a carbon sheet attached

 Documents written in pencil

 Documents narrower than 51 mm

 Documents shorter than 70 mm

 Pages thinner than 0.08 mm

 Documents of uneven thickness, such as envelopes

 Documents with large wrinkles or curls

 Bent or damaged documents

 Documents that use tracing paper

 Documents that use coated paper

 Photographs (photographic paper)

 Documents printed on perforated paper

 Documents printed on unusually-shaped paper (not square or rectangular)

 Documents with photos, notes, or stickers attached to them

 Documents that use carbonless paper

 Documents that use loose-leaf paper or any paper with holes in it

CAUTION
 

To avoid cutting yourself, do not slide or scrape your hand or fingers along the edge of the Carrier Sheet.

 

IMPORTANT
• To avoid warping the Carrier Sheet, do not place the Carrier Sheet in direct sunlight or in an area subject 

to high temperatures and high humidity.

• To avoid damaging the Carrier Sheet, do not bend or pull it. Do not use a damaged Carrier Sheet as it may 
produce incorrect scan results.

 

IMPORTANT
• To avoid document jams, do not load the Carrier Sheet upside down. For more information, refer to the 

instructions printed on the Carrier Sheet itself or see Load Documents on page 59.

• To avoid document jams, do not put several small documents into the Carrier Sheet at the same time. 
Insert only one document into the Carrier Sheet at a time. 

• Do not write on the Carrier Sheet as the writing may be seen in scanned documents. If the Carrier Sheet 
becomes dirty, wipe it with a dry cloth.

• Do not leave documents in the Carrier Sheet for extended periods of time, as the printing on the documents 
may bleed through onto the Carrier Sheet.

The damage caused by using any unacceptable document with your Brother machine may not be covered 
under warranty.
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Set Up Your Scanner 3

Pull the Output Tray and the Extendable Automatic Document Feeder out of the machine.
Carefully position the Output Tray. If the Output Tray is even slightly longer than the document size, 
the original order of pages may not be preserved when they are ejected from the scanner.

 

Scan Preparation 3
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Load Documents 3

The Automatic Document Feeder (ADF) can hold up to 50 pages and feeds each sheet individually. 
Use 80 g/m2 paper and always fan the pages before placing them in the ADF.

IMPORTANT
• Make sure documents with ink or correction fluid are completely dry.

• DO NOT pull on the document while it is feeding.

• DO NOT use paper that is curled, wrinkled, folded, ripped, stapled, paper-clipped, pasted or taped.

• DO NOT use cardboard or fabric.
 

Standard-size Documents 3

1 Adjust the Paper Guides1 to fit the width of your document.
 

2 Fan the pages several times along both the long edge and the short edge.
 

1
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3 Align the edges of the pages.
 

4 Place the pages, face down, top edge first in the ADF between the Guides until you feel they touch the 
inside of the machine. Feed thin pages slowly and carefully to keep the edge from being folded.
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Business Cards 3

1 Adjust the Paper Guides1 to fit the width of your document.
 

2 Pull the output tray out until you see the engraved card mark.
 

1
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3 Place your card, face down and top edge first in the ADF between the Guides until you feel it touch the 
inside of the machine.
 

NOTE
• You can load up to 25 business cards (total thickness less than 5 mm at a time).
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Plastic Cards 3

1 Adjust the Paper Guides1 to fit the width of your document.
 

2 Place your card, face down and top edge first in the ADF between the Guides until you feel it touch the 
inside of the machine.
 

NOTE
• You can load up to five plastic cards (total thickness less than 5 mm) at a time.

• Certain types of plastic cards may be scratched when scanned.

• Rigid cards may not be fed correctly.

• If the surface of the card is dirty with grease marks (for example, fingerprints) or similar, wipe the dirt off 
before scanning.

• Scanning plastic cards can be incorrectly detected as a multifeed.
To scan these documents successfully, disable the multifeed detection function.

 

1
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Documents Longer than Standard-size 3

Make sure documents with ink or correction fluid are completely dry.

1 Adjust the Paper Guides1 to fit the width of your document.
 

2 Place your document, face down, top edge first in the ADF between the Guides until you feel it touch 
the inside of the machine.
 

NOTE
• Load only one document at a time.

• Support the document with your hand if the document is longer than the extended ADF.
 

1
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Documents Not Printed on Standard-size Paper 3

Make sure documents with ink or correction fluid are completely dry.

1 Fold your document in half and insert it into the Carrier Sheet.
 

NOTE
Set the document in the centre of the Carrier Sheet and align the top of the document with the top of the 
Carrier Sheet.

 

2 Adjust the Paper Guides1 to fit the width of the Carrier Sheet.
 

1
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3 Place the Carrier Sheet in the ADF between the Guides until you feel it touch the inside of the machine.

NOTE
To reduce the white space in the centre of a scanned page, position the folded edge of the original 
document close to the edge of the Carrier Sheet.

 

 

Documents with Facing Pages 3

Follow the steps of Documents Not Printed on Standard-size Paper on page 65.

Receipts, Clippings, Photos, and Other Documents 3

Make sure documents with ink or correction fluid are completely dry.

1 Insert the document into the Carrier Sheet.
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NOTE
• Set the document in the centre of the Carrier Sheet and align the top of the document with the top of the 

Carrier Sheet.

• If the receipt is longer than the Carrier Sheet, you can fold the receipt in two places so that it overlaps when 
you insert it into the Carrier Sheet.

 

 

2 Adjust the Paper Guides1 to fit the width of the Carrier Sheet.
 

3 Place the Carrier Sheet in the ADF between the Guides until you feel it touch the inside of the machine.
 

1
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Before Scanning 4

Before scanning, confirm the following:

 Make sure you have installed the scanner driver by following the steps in the Quick Setup Guide.

 If your Brother machine is connected via a network cable, make sure the interface cable is physically 
secure.

Before Network Scanning 4

Network Licence (Windows®) 4

This product includes a computer licence for up to two users.

This licence supports the installation of the scanner driver including Nuance™ PaperPort™ 14SE on up to 
two computers on the network.

Configure Network Scanning for Windows®
4

If using a machine different from the one that was originally registered to your computer during the installation 
of the scanner driver, follow the steps below:

1 Do one of the following:

Windows® 7, Windows® 8, Windows® 8.1 and Windows® 10

Click (Brother Utilities) on your desktop, and then click the drop-down list and select your 

model name (if not already selected). Click Scan in the left navigation bar, and then click Scanners 
and Cameras.

Windows® XP, Windows Vista®

Click  (Start) menu, select Control Panel > click Scanners and Cameras.

2 Do one of the following:

Windows® XP

Right-click the Scanner Device icon and select Properties.

The Network Scanner Properties dialog box appears.

Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1 and Windows® 10

Click the Properties button.

Prepare Your Network for Scanning with 
Your Computer 4
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NOTE
(Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1 and Windows® 10)

If the User Account Control screen appears, do the following:

• For users who have administrator rights: Click Continue or Yes.
 

• For users who do not have administrator rights: type the administrator password, and then click OK 
or Yes.
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3 Click the Network Setting tab and select the appropriate connection method.
 

Specify your machine by address

Type the IP address of the machine in IP Address, and then click Apply or OK.

Specify your machine by name 4

1 Type the machine node name in Node Name, or click Browse and select the machine you want to use.

2 Click OK.
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4 Click the Scan To Button tab and type your computer name in the Display Name field. The machine’s 
Touchscreen displays the name you enter. The default setting is your computer name. You can type any 
name you want.
 

5 (ADS-2800W / ADS-3600W) 
To avoid receiving unwanted documents, type a four-digit PIN in the Pin number and Retype Pin number 
fields. 
If you send scan data to a computer protected by a PIN, the machine’s Touchscreen prompts you to 
enter the PIN before the document can be scanned and sent to the computer.
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Configure Network Scanning for Macintosh 4

If you followed the network installation steps in the Quick Setup Guide, your Brother machine was added to 
your network automatically.

To use the machine as a network scanner, the machine must be configured with a TCP/IP address. You can 
set or change the address settings from the Control Panel.

(Brother iPrint&Scan)

1 In the Finder menu bar, click Go > Applications, and then double-click the Brother iPrint&Scan icon.

2 The Brother iPrint&Scan window appears. 

3 Click the Select your Machine button, and then follow the on-screen instructions to reselect your 
network machine.

(TWAIN driver)

1 In the Finder menu bar, click Go > Applications > Brother, and then double-click the Device Selector 
icon.

2 The Device Selector window appears. 

3 Reselect your network machine, make sure Status is idle, and then click OK.
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Launch the BRAdmin Utility 4

If you have installed BRAdmin Light or BRAdmin Professional 3 1, the BRAdmin button lets you open the 
BRAdmin Light or BRAdmin Professional 3 1 utility.

The BRAdmin Light utility is designed for initial setup of Brother network-connected devices. It can also 
search for Brother products in a TCP/IP environment, view the status and configure basic network settings, 
such as the IP address. For information about installing BRAdmin Light from the supplied installation disc, 
see the Network User’s Guide.

If you require more advanced machine management, use the latest version of BRAdmin Professional 3 1 
utility that is available as a download from support.brother.com 

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab.

3 Click BRAdmin. The BRAdmin Light or BRAdmin Professional 3 1 utility dialog box appears.

NOTE
(Windows® only)

If you have installed both BRAdmin Light and BRAdmin Professional, ControlCenter4 will launch BRAdmin 
Professional 3.

 

1 Windows® only.

http://support.brother.com
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You can scan using the following methods:

 Using your computer

 Using your machine’s Control Panel

The available settings vary depending on the method you select. See the table in Appendix on page 261 for 
the settings available for each method. 

Before scanning 5
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Change the ControlCenter4 User Interface (Windows®) 6

ControlCenter4 is a software utility that lets you quickly and easily access your frequently-used applications. 
Using ControlCenter4, you no longer have to manually launch specific applications.

ControlCenter4 also controls the settings for the  (for ADS-2400N / ADS-3000N), or to PC button 
(for ADS-2800W / ADS-3600W) on your Brother machine. For more information about how to configure the 
settings on the machine, see Change Scan to PC Settings (Windows®) on page 186.

ControlCenter4 has two operation modes: Home Mode and Advanced Mode. You can change the mode at 
any time.

 Home Mode

Allows you to access your machine’s main functions.
 

1 Document Type option
Allows you to select a document type.

2 Custom Settings button
Allows you to configure scan settings.

3 Scan Size drop-down list
Allows you to select a scan size.

4 Scan button
Starts scanning.

5 Image viewer
Displays a scanned image.

Scan Using Your Computer 6

5

6

7

8

9

1

2

4

3

10



Scan Using Your Computer 

76

6

6 Save button
Saves a scanned image to a folder on your hard disk or uploads it to SharePoint as one of the file types 
shown in the file type list.

7 Print button
Prints the scanned document on your printer.

8 Open with an Application button
Scans an image directly to your graphics editor.

9 Send E-mail button
Scans a document to your default email application.

10 OCR button
Scans a document and converts it to text.

 Advanced Mode

Gives you more control over the details of your machine’s functions. You can adjust one-button scan-to 
actions to your scanning needs.
 

1 Image button
Scans a document directly to any image viewer/editor application.

2 OCR button
Scans a document and converts it to text.

3 E-mail button
Scans a document to your default email application.

4 File button
Saves a scanned image to a folder on your hard disk or uploads it to SharePoint as one of the file types 
shown in the file type list.

5 Print button
Prints the scanned document on your printer.

1 2 3 4 5
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To change the ControlCenter4 operation mode:

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.
 

NOTE

If the  icon is not displayed in the task tray, click (Brother Utilities) on your desktop, and then 

click the drop-down list and select your model name (if not already selected). Click Scan in the left 
navigation bar, and then click ControlCenter4.

 

2 Click Configuration, and then select Mode Select.

3 Select Home Mode or Advanced Mode, and then click OK.
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Scan Using ControlCenter4 in Home Mode (Windows®) 6

There are five scan options: Save, Print, Open with an Application, Send E-mail and OCR.

This section briefly introduces the Scan tab function. For more details of each function, click (Help).

Basic Scan 6

1 Select the Document Type and Scan Size for your document.

2 Click (Scan).

3 Confirm and edit (if needed) the scanned image in the image viewer.

4 Click one of the following:

 For (Save)

Select your Destination Folder and other settings. Click OK.

The image is now saved in the folder you have selected.

 For (Print)

Select your printer from the drop-down list, configure the printer settings, and then click OK.

The scanned document will be printed.

 For (Open with an Application)

Select the application from the drop-down list, and then click OK.

The image appears in the application you have selected.

NOTE
If you have installed the Evernote application on your computer, you can select Evernote from the 
drop-down list, and then click OK to upload the scanned data to Evernote directly.

 

 For (Send E-mail)

Configure the attached file settings, and then click OK.

Your default email application displays the image and attaches it to a new email.

 For (OCR)

Configure the OCR settings, and then click OK.

The application you have selected opens the document containing the converted text data.
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Scan Documents Using the Carrier Sheet 6

1 Load your document into the Carrier Sheet, and then load the Carrier Sheet into your machine (see 
Receipts, Clippings, Photos, and Other Documents on page 66).

NOTE
Load only one Carrier Sheet at a time.

 

2 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

NOTE

If the  icon is not displayed in the task tray, click (Brother Utilities) on your desktop, and then click 

the drop-down list and select your model name (if not already selected). Click Scan in the left navigation 
bar, and then click ControlCenter4.

 

3 Click the Scan tab.
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4 Select Custom in the Document Type drop-down list, and then click the Custom Settings button.
The Custom Scan Settings dialog box appears.
 

5 Select the Carrier Sheet Mode check box.

6 Select a scan size other than Auto from the Scan Size drop-down list.

7 Configure other settings as needed (see Change Scan Settings (ControlCenter4) (Windows®) 
on page 98).

8 Click the (Scan) button. The machine starts scanning, and then the Scanning Completed dialog 
box appears and displays the number of scanned pages. The scanned image appears in the image 
viewer.

NOTE
If the Scanning Completed dialog box does not appear and you want to display the number of scanned 
pages, select the Display Scanning Results check box in Advanced Settings.

 

9 Do one of the following:

 Click the (Save) button to save the scanned data. See Basic Scan on page 78.

 Click the (Print) button to print the scanned data. See Basic Scan on page 78.

 Click the (Open with an Application) button to open the scanned data in another application. 
See Basic Scan on page 78.

 Click the (Send E-mail) button to attach the scanned data to an email. See Basic Scan 
on page 78.

 Click the (OCR) button to scan to an editable text file. See Basic Scan on page 78.
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Scan Plastic Cards 6

1 Load a plastic card (see Plastic Cards on page 63).

NOTE
Load up to five plastic cards at a time.

 

2 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

3 Click the Scan tab.
 

4 Select Custom in the Document Type drop-down list, and then click the Custom Settings button.
The Custom Scan Settings dialog box appears.
 

5 Select the Plastic Card Mode check box.

6 Configure other settings as needed (see Change Scan Settings (ControlCenter4) (Windows®) 
on page 98).
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7 Click the (Scan) button. The machine starts scanning, and then the Scanning Completed dialog 
box appears. The scanned image appears in the image viewer.

NOTE
If the Scanning Completed dialog box does not appear and you want to display the number of scanned 
pages, select the Display Scanning Results check box in Advanced Settings.

 

8 Do one of the following:

 Click the (Save) button to save the scanned data. See Basic Scan on page 78.

 Click the (Print) button to print the scanned data. See Basic Scan on page 78. 

 Click the (Open with an Application) button to open the scanned data in another application. 
See Basic Scan on page 78.

 Click the (Send E-mail) button to attach the scanned data to an email. See Basic Scan 
on page 78.

 Click the (OCR) button to scan to an editable text file. See Basic Scan on page 78.

NOTE
Plastic Card Mode automatically uses these settings:

• Resolution: 600 x 600 dpi

• Document Size: 2 in 1 (Auto)

• 2-sided Scanning: On (Short-edge binding)

• Auto Deskew: Off

• Multifeed Detection: Off

• Auto Image Rotation: Off

 

Original Layout Scan Result
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Scan Documents to SharePoint 6

Scan documents and save them to a SharePoint server using this feature. To use this feature, connect your 
Brother machine to a network that has access to the Internet through a wireless (ADS-2800W / ADS-3600W) 
or Ethernet connection.

1 Load your document (see Standard-size Documents on page 59).

2 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

3 Click the Scan tab.
 

4 Select the document type.

5 Change the size of your document, as needed.

6 Configure other settings as needed (see Change Scan Settings (ControlCenter4) (Windows®) 
on page 98).

7 Click the (Scan) button. The machine starts scanning, and then the Scanning Completed dialog 
box appears and displays the number of scanned pages. The scanned image appears in the image 
viewer.

NOTE
If the Scanning Completed dialog box does not appear and you want to display the number of scanned 
pages, select the Display Scanning Results check box in Advanced Settings.

 

8 Click (Save). The Save dialog box appears.
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9 Click the File Type drop-down list, and then select the file type. 

NOTE
To save the document as a password-protected PDF, select Secure PDF (*.pdf) from the File Type 

drop-down list, click , and then type the password. 
 

0 In the File Name field, type a prefix for your file name, if needed. 

A In the Scan Location field, select the SharePoint radio button, and then type the server address where 
you want to save your scanned documents. 

B Click the Connection Test button to confirm the server connection. 
The message Connected appears.

NOTE
If the security dialog box appears, type your user name and password. 

 

C Click OK. If a message dialog box regarding the Internet connection appears, read the information and 
click OK.
The scanned document is saved on the destination server. 
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Scan Using ControlCenter4 in Advanced Mode (Windows®) 6

There are five scan options available in Advanced Mode: Image, OCR, E-mail, File and Print.

This section briefly introduces the Scan tab function. For more information about each function, click (Help).

Basic Scan 6

1 Click the Scan tab.

2 Click one of the following:

 For (Image)

Select the application from the drop-down list and click Scan.

The image appears in the application you have selected.

 For (OCR)

Configure the OCR settings and click Scan.

The selected application opens the document containing the converted text data.

 For (E-mail)

Configure the attached file settings and click Scan.

Your default email application displays the image and attaches it to a new email.

 For (File)

Select your Scan Location and other settings. Click Scan.

The image is saved in the folder you have selected.

 For (Print)

Select your printer from the drop-down list, configure the printer settings, and then click Scan.

The scanned document will be printed.

NOTE
(For Image and OCR) 

If you have installed the Evernote application on your computer, you can select Evernote from the 
drop-down list, and then click OK to upload the scanned data to Evernote directly.
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Scan to Image 6

The Scan to Image feature lets you scan an image directly into your graphics application for image editing.

1 Click the Scan tab.

2 Click  (Image).

The Image dialog box appears.
 

3 Configure the scan settings, if needed.

 To scan a 2-sided document, select the 2-sided Scanning check box and choose Long-edge 
binding or Short-edge binding.

 To change the application that you want to use, choose the appropriate application from the Target 
Application drop-down list.

4 Click Scan.
Your default application will start and display the image.

NOTE
If you have selected Secure PDF (*.pdf) from the File Type list, the Set PDF Password dialog box 
appears. Enter your password in the Password and Re-type Password boxes, and then click OK. 
You can also select Secure PDF (*.pdf) for Scan to E-mail and Scan to File.
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Scan to OCR 6

The Scan to OCR feature lets you scan and convert a document into text that can be edited by any word 
processing application. You can change the default word processing application.

1 Click the Scan tab.

2 Click  (OCR).

The OCR dialog box appears.
 

3 Configure the scan settings, if needed.

 To scan a 2-sided document, select the 2-sided Scanning check box and choose Long-edge 
binding or Short-edge binding.

 To change the word processing application that you want to use, choose the appropriate application 
from the Target Application drop-down list.

4 Click Scan.
Your default word processing application will start and display the converted text data.
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Scan to E-mail 6

The Scan to E-mail feature lets you scan a document to your default email application so you can send the 
scanned document as an attachment.

1 Click the Scan tab.

2 Click  (E-mail).

The E-mail dialog box appears.
 

3 Configure the scan settings, if needed.

 To scan a 2-sided document, select the 2-sided Scanning check box and choose Long-edge 
binding or Short-edge binding.

4 Click Scan.
Your default email application will start and the image will be attached to a new email.

NOTE
The Scan to E-mail feature does not support Webmail services. Use the Scan to Image or Scan to File 
feature to scan a document or picture, and then attach the file of the scanned data to a message.

 



Scan Using Your Computer 

89

6

Scan to File 6

The Scan to File feature lets you scan an image to a folder on your hard disk in a supported file format. This 
feature allows you to archive your paper documents.

1 Click the Scan tab.

2 Click  (File).

The File dialog box appears.
 

3 Configure the scan settings, if needed.

 To scan a 2-sided document, select the 2-sided Scanning check box and choose Long-edge 
binding or Short-edge binding.

 To change the file name, enter the file name you want to use for the document (up to 100 characters) 
in the File Name box. The file name will be the file name you entered plus the current date and a 
sequential number.

 Choose the file type for the saved image from the File Type drop-down list. You can save the file to 

the default folder, or choose your preferred folder by clicking  (Browse).

 To show where the scanned image is saved when scanning is finished, select the Show Folder check 
box. If you want to specify the destination of the scanned image every time, select the Show Save 
As Window check box.

4 Click Scan.
The image will be saved in the folder you have selected.
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Change a Scan Button’s Default Settings 6

1 Right-click the button you want to configure and click Button settings. The settings dialog box appears.

2 Configure other settings as needed.

3 Click OK. The new settings are now saved as default settings.

Scan Using the Carrier Sheet 6

1 Load your document into the Carrier Sheet and load the Carrier Sheet into your machine (see Receipts, 
Clippings, Photos, and Other Documents on page 66).

NOTE
Load only one Carrier Sheet at a time.

 

2 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

3 Select the Scan tab.
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4 Click the button you want to use ( (Image), (OCR), (E-mail), (File) or (Print)). The 

settings dialog box appears (the example below uses Image).
 

5 Select the Carrier Sheet Mode check box.

6 Select a document size other than Auto from the Document Size drop-down list.

7 Change other settings as needed (see Change Scan Settings (ControlCenter4) (Windows®) on page 98).

8 Click the Scan button.
The machine starts scanning.

NOTE
If you do not want to see the settings dialog box again, select the Don’t show me again. check box.
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Scan Plastic Cards 6

1 Load a plastic card (see Plastic Cards on page 63).

NOTE
Load up to five plastic cards at a time.

 

2 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

3 Click the Scan tab.
 

4 Click the button you want to use ( (Image), (OCR), (E-mail), (File), or (Print)). 

The settings dialog box appears (the example below uses Image).
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5 Select the Plastic Card Mode check box.

6 Change other settings as needed (see Change Scan Settings (ControlCenter4) (Windows®) 
on page 98).

7 Click the Scan button.
The machine starts scanning.

NOTE
• If you do not want to see the settings dialog box again, select the Don’t show me again. check box.

• Plastic Card Mode automatically uses these settings:

• Resolution: 600 x 600 dpi

• Document Size: 2 in 1 (Auto)

• 2-sided Scanning: On (Short-edge binding)

• Auto Deskew: Off

• Auto Image Rotation: Off

• Multifeed Detection: Off

 

Original Layout Scan Result
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Scan Documents to SharePoint 6

Scan documents and save them to a SharePoint server using this feature. To use this feature, your Brother 
machine must be connected to a network that has access to the Internet through a wireless (ADS-2800W / 
ADS-3600W) or wired connection.

1 Load your document (see Standard-size Documents on page 59).

2 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

3 Click the Scan tab.
 

4 Click  (File). The settings dialog box appears.
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5 In the Scan Location field, select the SharePoint radio button, and then type the server address where 
you want to save your scanned documents. 

6 Change other settings as needed (see Change Scan Settings (ControlCenter4) (Windows®) on page 98).

7 Click the Connection Test button to confirm the server connection. 
The Connected message appears. 

NOTE
If the security dialog box appears, type your user name and password. 

 

8 Click Scan. If a message dialog box regarding the Internet connection appears, read the information and 
click OK.
The scanned document is saved on the destination server. 
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Create a Custom Tab (ControlCenter4 Advanced Mode) 
(Windows®) 6

You can create up to three tabs that include up to five buttons containing your preferred settings.

Create a Custom Tab 6

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.
 

2 Click Configuration, and then select Create custom tab. You can also create a custom tab by 
right-clicking the tab area and selecting Create custom tab. 
 

3 To change the name of a custom tab, right-click the custom tab and select Rename custom tab. Enter 
the new name. The name appears in the upper left corner of the custom tab.

NOTE
• You can also change the name of the custom tab by clicking Configuration, and then Rename custom tab.

• You can make up to three custom tabs.
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Create a Custom Button in a Custom Tab 6

1 Create a Custom tab. See Create a Custom Tab on page 96.

2 Right-click the new Custom tab, and select Create custom button. Select a button you want to create 
from the menu. The settings dialog box appears.
 

NOTE
• You can also copy a custom button by selecting Copy custom button from the menu that appears when 

you right-click the Custom tab.

• You can make up to five custom buttons.
 

3 Type the button name and change the settings as needed. Click OK.
(The setting options may vary depending on the type of button you create.)
 

NOTE
You can change or remove the tab, button, or settings you created. Click Configuration and continue as 
prompted.
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Change Scan Settings (ControlCenter4) (Windows®) 6

The following settings can be changed:

Setting Description Applicable Feature

Image OCR E-mail File Print

File Type Select the file type you want to use for the scanned data.

NOTE
• To save the document as a password-protected PDF, 

select Secure PDF (*.pdf) from the File Type 

drop-down list, click the (Set PDF Password) 

button, and enter the password (Image, E-mail and 
File only).

• Searchable PDF is a file format that includes the text 
data layer over a scanned image. This layer allows 
you to search the text in the image data. 
OCR Language in the OCR setting must be set to 
match the language in the searchable PDF.

• To save the document as a searchable PDF, select 
Searchable PDF (*.pdf) from the File Type 
drop-down list.

• To save the document as a high compression PDF, 
select 300 x 300 dpi from the Resolution 
drop-down list, High Compression PDF (*.pdf) 
from the File Type drop-down list and True Grey or 
24bit Colour from the Scan Type drop-down list.

 

Yes Yes Yes Yes -

Target 
Application

Select the destination application including Nuance™ 
PaperPort™ 14SE and Evernote from the drop-down 
list.

Yes Yes - - -

OCR 
Language

Select a language to match the scanned document’s 
text.

- Yes - - -

Printer Name Select the printer you want to use to print the scanned 
data.

- - - - Yes

File Name Click the Change button for Image, OCR or E-mail. 
Enter a prefix for the file name if needed. The maximum 
number of characters is 100 characters.

Yes Yes Yes Yes -

Print Options Click the Print Options button to configure the printer 
settings.

- - - - Yes

Show Save 
As Window

To specify the destination of the scanned image every 
time you scan, select the Show Save As Window 
check box.

- - - Yes -

Destination 
Folder

Click the folder icon to change the folder where you 
want to save your scanned document.

Yes Yes Yes - -



Scan Using Your Computer 

99

6

1 Depending on the condition of the original document, this function may not work correctly.

Scan 
Location

Select one of the Scan Locations:

• Folder

Click the folder icon and browse to the folder where 
you want to save your scanned document. Select 
Show Folder to automatically display the destination 
folder after scanning.

• SharePoint

Write the URL address where you want to save your 
scanned document. Click Connection Test to 
confirm the destination.

- - - Yes -

File Size 
Priority

Adjust the file size by moving the slider to the right or 
left.

NOTE
File size can be adjusted depending on your 
selected File Type.

 

Yes - Yes Yes -

PreScan Select PreScan to preview your image and crop 
unwanted portions before scanning. 

Yes Yes Yes Yes Yes

Resolution Select a scanning resolution from the Resolution 
drop-down list. Higher resolutions need more memory 
and transfer time, but produce finer scanned images.

Yes Yes Yes Yes Yes

Scan Type Select from several colour depth options for scanned 
images:

Auto

Automatically selects suitable colours for your 
document. 1

Black & White

Use for text or line art images.

Grey (Error Diffusion)

Use for photographic images or graphics. (Error Diffusion 
is a method for creating simulated grey images without 
using true grey dots. Black dots are put in a specific 
pattern to give a grey appearance.)

True Grey

Use for photographic images or graphics. This mode is 
more exact because it uses up to 256 shades of grey.

24bit Colour

Uses up to 16.8 million colours to scan the image. 
Although using 24bit Colour creates an image with the 
most accurate colour reproduction, it requires the most 
memory and has the longest transfer time.

Yes Yes Yes Yes Yes

Setting Description Applicable Feature

Image OCR E-mail File Print
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1 Depending on the condition of the original document, this function may not work correctly.

Setting Description Applicable Feature

Image OCR E-mail File Print

Document 
Size

Document size is set to Auto by default. You can scan 
documents of any size without making any adjustments 
to Document Size. 1 For faster scan speeds, select the 
exact size of your document from the Document Size 
drop-down list.

NOTE
• If you select a 1 to 2 document size, the scanned 

image is divided into two documents that are half 
the size of the setting. If you select 1 to 2(A4), 
the scanned image is divided into two A5-size 
documents.

• To use 1 to 2 scanning, clear the Auto Image 
Rotation check box in the Advanced Settings 
dialog box.

• If you select a 2 in 1 document size, two scanned 
images are combined into one document.

 

Yes Yes Yes Yes Yes

Brightness Adjust the setting (from -50 to 50) to get the best image. 
The default value of 0 represents an average and is 
usually suitable for most images. You can set the 
brightness level by dragging the slider to the right or left 
to lighten or darken the image. You can also enter a 
value in the box to set the level. If the scanned image 
is too light, set a lower brightness level and scan the 
document again. If the image is too dark, set a higher 
brightness level and scan the document again.

Yes Yes Yes Yes Yes
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Setting Description Applicable Feature

Image OCR E-mail File Print

Contrast Adjust the setting (from -50 to 50) to get the best image. 
The default value of 0 represents an average and is 
usually suitable for most images. You can increase or 
decrease the contrast level by moving the slider to the 
right or left. An increase emphasises dark and light 
areas of the image, while a decrease reveals more 
details in grey areas. You can also enter a value in the 
box to set the Contrast.

NOTE
The Contrast setting is only available when setting 
Scan Type to Auto, Grey (Error Diffusion), 
True Grey or 24bit Colour.

 

Yes Yes Yes Yes Yes

Continuous 
Scanning

Scan multiple pages. After the page has been scanned, 
you can either continue or finish scanning. By using this 
method, you can scan more pages than the ADF can 
hold.

Yes Yes Yes Yes Yes

2-sided 
Scanning

If you select this box, the machine scans both sides 
of the document. When using the automatic 2-sided 
(duplex) scan feature, you must select Long-edge 
binding or Short-edge binding depending on the 
layout of your original to make sure the data file created 
appears correctly in the scanned document.

Yes Yes Yes Yes Yes

Carrier Sheet 
Mode

Scan the following document types using the Carrier 
Sheet. For this mode, you can select any setting other 
than Auto from the Document Size drop-down list.

 Large-sized Documents (A3, B4 and Ledger)

Fold the document in half and insert it in the Carrier 
Sheet for 2-sided (duplex) scanning. Both the front 
and back pages are combined into a single page. 
Select 2 in 1(A4) for an A3 document, 2 in 1(B5) 
for a B4 document or 2 in 1(Letter) for a Ledger 
document from the Document Size drop-down list.

 Important documents (photos, contracts)

 Thin paper (receipts)

 Irregularly-shaped paper (clippings)

NOTE
• Load only one Carrier Sheet at a time.

• Load the document in the centre of the Carrier Sheet 
and align the top of the document with the top of the 
Carrier Sheet.

 

Yes Yes Yes Yes Yes
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Plastic Card 
Mode

Scan cards, such as driving licences or insurance cards, 
using these automatic settings:

 Resolution: 600 x 600 dpi

 Document Size: 2 in 1 (Auto)

 2-sided Scanning: On (Short-edge binding)

 Auto Deskew: Off

 Auto Image Rotation: Off

 Multifeed Detection: Off

NOTE
• To scan a plastic card with different settings, set 

Plastic Card Mode to Off and Resolution to 
600 dpi.

• Load up to five plastic cards at a time.
 

Yes Yes Yes Yes Yes

Default Restore all settings to their factory default values. Yes Yes Yes Yes Yes

Setting Description Applicable Feature

Image OCR E-mail File Print



Scan Using Your Computer 

103

6

You can configure more settings in the Advanced Settings dialog box. Click the Advanced Settings button.

1 Depending on the condition of the original document, this function may not work correctly.

Setting Description Applicable Feature

Image OCR E-mail File Print

Auto Deskew Corrects the skew (less than 9 mm from the centre of the 
document to the edge) of the scanned data. 1

 

Yes Yes Yes Yes Yes

Auto Image 
Rotation

Changes the direction of the document based on the 
text orientation. 1

Yes Yes Yes Yes Yes

Remove 
Bleed-
through / 
Pattern / 
Remove  
Background 
Colour

Prevents bleed-through and removes background colour 
of documents such as newspapers to make the scanned 
data more recognisable. 1

The sensitivity of the Remove Bleed-through / Pattern / 
Background Colour function can be adjusted with the 
slider. Moving the slider towards “High” will make the 
scanner more likely to remove bleed-throughs, patterns 
or background colours, while moving it towards “Low” 
makes the scanner less likely to remove them.

Yes Yes Yes Yes Yes

Skip Blank 
Page

Removes blank pages of the document from the 
scanning results. 1

Yes Yes Yes Yes Yes

Multifeed 
Detection

Uses an ultrasonic sensor to detect when a multifeed 
has occurred. When your machine detects a multifeed, 
you must confirm that the data scanned so far has been 
saved, and then start scanning again at the next page or 
the beginning of the document.

Yes Yes Yes Yes Yes

Display 
Scanning 
Results

Shows the numbers of total pages saved and blank 
pages skipped on your computer screen.

Yes Yes Yes Yes Yes

less than 9 mm

centre of the 
document

docu
ment

right edge of the 
paper feed tray

left edge of the 
paper feed tray

centre of the 
transport path

Scanning
direction



Scan Using Your Computer 

104

6

Scan Using Brother iPrint&Scan (Mac) 6

NOTE
• Use Brother iPrint&Scan for Mac to print and scan from your computer.

• Download and install Brother iPrint&Scan from the App Store.
 

1 In the Finder menu bar, click Go > Applications, and then double-click the iPrint&Scan icon.
The Brother iPrint&Scan screen appears.

2 If your Brother machine is not selected, click the Select your Machine button, and then follow the on-
screen instructions to select your Brother machine.

3 Click the Scan icon, and then follow the on-screen instructions to scan your documents.

Change Scan Button Settings from Brother iPrint&Scan (Mac) 6

1 In the Finder menu bar, click Go > Applications, and then double-click iPrint&Scan icon.
The Brother iPrint&Scan screen appears.

2 If your Brother machine is not selected, click the Select your Machine button, and then follow the on-
screen instructions to select your Brother machine

3 Click the Machine Scan Settings button, and then follow the on-screen instructions to change the scan 
settings.
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Scan Using Nuance™ PaperPort™ 14SE or Other Windows® 
Applications 6

Scan Using Nuance™ PaperPort™ 14SE 6

You can use the Nuance™ PaperPort™ 14SE application, which is included in the scanner driver, for scanning. 
Nuance™ PaperPort™ 14SE supports both TWAIN and WIA drivers; the TWAIN driver (recommended) is used 
in the example in this section. For an example using the WIA driver, see Scan Using Windows® Photo Gallery 
or Windows® Fax and Scan on page 120.

NOTE
• Nuance™ PaperPort™ 14SE supports Windows® XP 32 bit (SP3), Windows Vista®, Windows® 7, 

Windows® 8, Windows® 8.1 and Windows® 10.

• For more information about the application refer to the Nuance™ PaperPort™ 14SE help file, which you 
can access from the Nuance™ PaperPort™ 14SE Help menu.

 

These instructions are for Nuance™ PaperPort™ 14SE, but are similar for other Windows® applications.

1 Load your document.

2 Start Nuance™ PaperPort™ 14SE. Do one of the following:

Windows® XP, Windows Vista® and Windows® 7

Click (Start) > All Programs > Nuance PaperPort 14 > PaperPort.

Windows® 8, Windows® 8.1 and Windows® 10

Click (PaperPort).

The Nuance™ PaperPort™ 14SE window appears.
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3 Click Scan Settings from the Desktop tab on the ribbon.
The Scan or Get Photo panel appears on the left side of the window.
 

4 Click the Select button.

5 From the Available Scanners list, select TWAIN: TW-Brother ADS-XXXXX (where ADS-XXXXX is the 
model name of your machine). To use the WIA driver, select the Brother driver that has “WIA” as the 
prefix.
Click OK.

6 Select the Display scanner dialog box check box in the Scan or Get Photo panel.
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7 Click the Scan button.
The scanner setup dialog box appears.
 

8 Adjust the settings in the scanner setup dialog box as needed (Resolution, Scan Type, 2-sided 
Scanning, and Document Size).

 For more information about TWAIN Driver Settings, see page 108.

 For more information about WIA Driver Settings, see page 120. 

9 From the Document Size drop-down list, select your document size.

NOTE
After you have selected a document size, you can adjust the scanning area further by clicking the left 
mouse button and dragging the selection. This is also required when cropping an image for scanning.

 

0 Click the Start button.
The machine starts scanning.
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TWAIN Driver Settings 6

Click either the Basic screen or the Advanced Settings for TWAIN driver settings.

 Basic screen
 

1 Scan (Image Type)
Select Photo, Web, or Text.

You can add new items by clicking . You cannot change the name of Photo, Web and Text, 

but you can change the name of added items.

Scan (Image Type) Resolution Scan Type

Photo Use for scanning photo images 300 x 300 dpi 24bit Colour

Web Use for attaching the scanned 
image to web pages

100 x 100 dpi 24bit Colour

Text Use for scanning text documents 200 x 200 dpi Black & White

1
2

3

4

5

6

7
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2 Resolution
Select a scanning resolution from the Resolution drop-down list. Higher resolutions need more 
memory and transfer time, but produce finer scanned images.

3 Scan Type
Select one of the following:
 Auto

Automatically detects whether the document uses colour and generates a scanned image of it. For 
documents that mix colour and black and white pages, colour pages will be scanned in Colour mode, 
while black and white pages will be scanned in Black & White mode.

 Black & White
Use for text or line art images.

 Grey (Error Diffusion)
Use for photographic images or graphics. (Error Diffusion is a method for creating simulated grey 
images without using true grey dots. Black dots are put in a specific pattern to give a grey 
appearance.)

 True Grey
Use for photographic images or graphics. This mode is more exact because it uses up to 256 shades 
of grey.

 24bit Colour
Uses up to 16.8 million colours to scan the image. Although using 24bit Colour creates an image 
with the most accurate colour reproduction, it requires the most memory and has the longest transfer 
time.

Resolution

100 x 100 dpi

150 x 150 dpi

200 x 200 dpi

300 x 300 dpi

400 x 400 dpi

600 x 600 dpi

1,200 x 1,200 dpi
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4 2-sided Scanning
Select Long-edge binding or Short-edge binding depending on the layout of your original to make 
sure the data file created appears correctly in the scanned document.

5 Document Size
Document size is set to Auto by default. For faster scan speeds, select the exact size of your document 
from the Document Size drop-down list. If you select Custom, the Custom Document Size dialog 
box, in which you can specify the document size, appears.

6 PreScan 
Click PreScan to preview your image and crop unwanted areas before scanning. 
Cropping is available in these settings:
 2-sided scanning: Off
 Auto Deskew: Off
 Auto Image Rotation: Off
 Detect End of Page: Off
 Document Size: a scan size other than Auto and Long Paper

7 Save as new profile
Click Save as new profile to save your frequently-used scan settings. 
The following settings are saved as part of the profile:
 Settings configured in the Basic screen
 Settings configured in the Advanced Settings
 The scan boundaries as specified on the preview image
You can create up to 64 profiles.
Created profiles are added to the Scan or Get Photo panel. To edit a profile, click Settings on the 
Scan or Get Photo panel. To delete a profile, click Delete.

2-sided Scan Setting Original Layout Scan Result

Long-edge binding   

Short-edge binding   
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 Advanced Settings

 

Document Correction 6

1 Cropping
 Auto Deskew

Corrects the skew of the scanned data.

NOTE
• If you enable Carrier Sheet Mode, you cannot enable Auto Deskew.

• This function does not apply to the Long Paper document size or the Carrier Sheet Mode.

 

 Detect End of Page

Detects the end of page and automatically adjusts the size of a page when the length of the document is 
shorter than the Document Size selected.

NOTE
If you enable Carrier Sheet Mode, you cannot enable Detect End of Page.
 

 Margin Settings

This feature allows you to add or remove a specific margin (from -3 mm to 3 mm) at the edge of the image.

2 Rotate Image

Changes the direction of the document based on the text orientation when Auto is selected.
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3 Edge Fill

You can select Auto or Custom. When Custom is selected, select White or Black and set a value to add 
a white or black edge around the border of your scanned image.

4 Punch Hole Removal

This feature removes the punch hole markings by filling hole marks with white or the surrounding colour.

White

Fill punch holes with white.

 Surrounding colour

Fill punch holes with the surrounding colour.

5 Auto Colour Detect Adjust

When scan type Auto is selected, you can adjust the detection level of colour, B&W and greyscale.

 B&W/Grey - Colour

Increasing the slider value makes the machine more likely to determine that a given document is a colour 
document. Decreasing the value makes the machine more likely to determine that a given document is a 
black and white or greyscale document.

 B&W - Grey

Increasing the slider value makes the machine more likely to determine that a given document is a 
greyscale document. Decreasing the value makes the machine more likely to determine that a given 
document is black and white.

6 Skip Blank Page

Removes blank pages of the document from the scanning results. 
The sensitivity of the Skip Blank Page function can be adjusted with the slider. Moving the slider towards 
High makes the machine more likely to skip pages, while moving it towards Low makes the machine less 
likely to skip pages. If you enable the Show Results setting, the computer displays how many blank pages 
have been skipped when the scan is complete. 
If the Skip Blank Page function is triggered for all document pages, no scanned image is displayed. 
Instead, the computer displays a warning message indicating that all document pages are blank.

NOTE
This function does not apply to the Long Paper document size.
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Image Quality 6

1 Diffusion Adjustment – Grey

This function adjusts the brightness and contrast to create grey images.

 Brightness

Larger values lighten the image.

 Contrast

Larger values increase the contrast in the image. Excessively large values may result in a black and 
white image.

NOTE
This function is available when the Grey (Error Diffusion) scan type is selected.

 

2 Colour Tone Adjustment

Allows you to adjust the brightness, contrast, shadow, highlight, and gamma during grey and colour 
scanning. 

The default setting is Custom.

 Auto

Scans the document using the optimal settings based on its content.

 Custom

Allows you to set the Brightness, Contrast, Shadow, Highlight and Gamma manually.

NOTE
• Shadow cannot be set to a larger value than Highlight.

• This function is available when the Auto, True Grey, or 24bit Colour scan type is selected. 
 

  

Original Brightness: 25
Contrast: 25
Shadow: 122
Highlight: 240
Gamma: 5.0



Scan Using Your Computer 

114

6

3 Background Processing
 Remove Bleed-through / Pattern

Enabling this function prevents the bleed through phenomenon on a two-sided document.

 Remove Background Colour

If you enable the Remove Background Colour setting, the machine removes the base colour of 
documents such as newspapers to make the scanned data more recognisable.

 Level

Adjusts the strength of the Remove Bleed-through / Pattern and Remove Background Colour 
effects.

4 Colour Drop 

Removes specific colours from your scan data.

Select one of the following:

 Chromatic colour 

Use to remove all colours except Black.

 Red 

Use to remove the Red colour.

 Green 

Use to remove the Green colour.

 Blue 

Use to remove the Blue colour.

 Custom 

Select the colour you want to remove.

5 Edge Emphasis

This feature allows you to make blurred images and document or magazine text appear more clearly for 
improved readability. You can use the slider to adjust the strength of the Edge Emphasis effect. 

NOTE
• This function is available when the Auto, True Grey, or 24bit Colour scan type is selected.

• This function does not apply for the Long Paper document size.

 

B&W Image Quality 6

1 B&W Threshold Adjustment

This setting allows you to adjust the image quality when scanning in Black & White mode. 

Larger values increase the amount of black in the scanned image, while smaller values increase the 
amount of white.

NOTE
This function is available when the Black & White scan type is selected.
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2 Character Correction
 Blurred Character Correction

When there is faint or broken text in the scanned image, this feature allows the machine to correct the 
letters so that they are more readily detectable as text, correcting not only text, but also black dots and 
lines. If both Boldface Formatting and Blurred Character Correction are enabled, only the Boldface 
Formatting function is performed. 

NOTE
This function is available when the Black & White scan type is selected.
 

 Boldface Formatting

This feature allows you to enlarge and thicken black areas of documents, making thin text thicker. It has 
the effect of thickening not only text, but all dots and lines. If both Boldface Formatting and Blurred 
Character Correction are enabled, only the Boldface Formatting function is performed.

NOTE
This function is available when the Black & White scan type is selected.

 

3 B&W Inversion

Create a black and white inverted version of the scanned image using this function. 

  

Normal Blurred Character Correction

  

Normal Boldface Formatting

abc2016 abc2016

abc2016 abc2016abc2016
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NOTE
This function is available when the Black & White scan type is selected.
 

4 Noise Reduction

This feature allows you to remove small dots or specks called “noise”, from the background of scanned 
images. Removing unwanted specks helps to reduce compressed file size. 

NOTE
• This function is available when the Black & White scan type is selected.

• This function does not apply to the Long Paper document size.
 

5 Remove Ruled Line

This feature allows you to remove lines in the document. You can select the type of line direction to remove 
(Vertical, Horizontal, Vertical and Horizontal). Angled lines are detected as lines and removed if they 
are less than 9 mm from the centre of the document to the edge of the horizontal or vertical plane.

 Minimum Line Length

Lines longer than or equal to the specified length are removed.

 Maximum Clearance

If lines are broken, for example due to fading of the image, the lines that are broken for an interval less 
than or equal to the specified broken line distance will be detected and removed.

NOTE
• This function is available when the Black & White scan type is selected.

• This function does not apply to the Long Paper document size.
 

   

When there is a horizontal line The horizontal line is not gone
   

When there is a vertical line shorter 
than 2 cm

The vertical line is not gone
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Feed Control 6

1 Layout

Scan a two-page document combined into one page, or scan a one-page document divided into two 
pages. Choose one of the following options:

 2in1: Long edge

Combine a two-page document into a single page using landscape orientation.
 

   

When there is a break below 5 mm 
between vertical lines longer than 2 cm

The vertical line is gone

   

When there is a 5 mm or more break 
between a vertical line longer than 2 cm 

and shorter than 2 cm

The vertical line shorter than 2 cm 
is not gone
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 2in1: Short edge

Combine a two-page document into a single page using portrait orientation.
 

 1 to 2: Long edge

Divide a one-page document into two pages using portrait orientation.
 

 1 to 2: Short edge

Divide a one-page document into two pages using landscape orientation.
 

2 Carrier Sheet Mode

Use the Carrier Sheet to scan the following document types:

 Important documents (photos, contracts)
 Thin paper (receipts)
 Irregularly-shaped paper (clippings)

NOTE
• For this mode, you can select any settings other than Auto and Long Paper document sizes.

• If you enable Multifeed Detection or Plastic Card Mode, you cannot enable Carrier Sheet Mode, Auto 
Deskew or Detect End of Page.
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3 Plastic Card Mode

Scan cards, such as driving licenses or insurance cards, using these automatic settings:

 Resolution: 600 x 600 dpi
 Document Size: 2 in 1 (Auto) 
 2-sided Scanning: On (Short-edge binding)
 Auto Deskew: Off
 Detect End of Page: Off
 Auto Image Rotation: Off
 Multifeed Detection: Off
 Carrier Sheet Mode: Off

4 Single Page Scan

Single page scan feeds one page at a time from the ADF, regardless of the number of pages in the ADF.

5 Continuous Scan

This feature allows you to scan additional documents using the same settings when a scan has been 
completed. It is useful when you are scanning more documents than the ADF can hold or when you are 
scanning several documents at once.

6 Multifeed Detection

When your machine detects a multifeed, you must confirm that the data scanned so far has been saved, 
and then start scanning again at the next page or the beginning of the document.

NOTE
• Disable this setting when scanning thick paper. Otherwise it is more likely for the machine to detect a 

multifeed.

• If you enable Carrier Sheet Mode or Plastic Card Mode, you cannot enable Multifeed Detection.
 

Additional Functions

Barcode Detection

The machine reads the barcode printed on the scanned image. 
Specify the barcode type and detection area.

JPEG Compression

Changes the quality of the JPEG file to be saved.

NOTE
This function is available in Disk File mode only.
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WIA Driver Settings 6

 

1 Paper source
You can select Document Feeder only.

2 Picture Type (Image Type)
Select Colour picture, Greyscale picture, Black and white picture or text, or Custom Settings.
To change advanced settings, click Adjust the quality of the scanned picture.

 Resolution

Select a scanning resolution from the Resolution text box. Higher resolutions need more memory and 
transfer time, but produce finer scanned images.

 Brightness

Adjust the setting (from -50 to 50) to get the best image. The default value of 0 represents an average 
and is usually suitable for most images. You can set the brightness level by dragging the slider to the 
right or left to lighten or darken the image. You can also enter a value in the box to set the level. If the 
scanned image is too light, set a lower brightness level and scan the document again. If the image is 
too dark, set a higher brightness level and scan the document again.

 Contrast

Adjust the setting (from -50 to 50) to get the best image. The default value of 0 represents an average 
and is usually suitable for most images. You can increase or decrease the contrast level by moving the 
slider to the right or left. An increase emphasises dark and light areas of the image, while a decrease 
reveals more details in grey areas. You can also enter a value in the box to set the Contrast.

Scan Using Windows® Photo Gallery or Windows® Fax and Scan 6

You can use the Windows® Photo Gallery or Windows® Fax and Scan applications for scanning. These 
applications use the WIA scanner driver. The steps below will guide you through the scanning operations. 
You may need to download Windows® Photo Gallery or Windows® Fax and Scan.

1 Load your document.

1

2
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2 Open your software application to scan the document. Do one of the following:

Windows® Photo Gallery

1 Click File, and then Import from Camera or Scanner.

2 Select the scanner you want to use.

3 Click the Import button.
The settings dialog box appears.

Windows® Fax and Scan

Click File > New > Scan.

The settings dialog box appears.
 

Profile

Profiles can be used to save settings, such as Page Size, Source, Format, and others.

3 Adjust the settings in the settings dialog box as needed.

NOTE
To save your settings, select Add Profile in the Profile drop-down list.

 

4 Click the Scan button.
The machine starts scanning.

Use ABBYY FineReader 6

You can use the ABBYY FineReader application for scanning. It converts the scanned data into an editable 
format, such as Microsoft® Word, Microsoft® Excel, Adobe® PDF, HTML and EPUB. 

See the ABBYY FineReader Help menu for more information about using ABBYY FineReader.
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Scan Using TWAIN Applications (Macintosh) 6

The bundled applications cannot change TWAIN settings. However, you can use other applications, such as 
Presto! PageManager, to configure TWAIN settings. The instructions below are for Presto! PageManager, 
but are similar for other Macintosh applications.

Scan Using TWAIN Applications (for example, Presto! PageManager) 6

1 Start Presto! PageManager by double-clicking the Presto! PageManager icon on your computer screen.

NOTE
The first time you use the Brother TWAIN driver, set it as the default driver:

1 Click File > Select Source.

2 Select Brother TWAIN 2.
 

2 Click File > Acquire Image Data.
The scanner setup dialog box appears.

3 Adjust the settings in the scanner setup dialog box if needed.

4 From the Document Size pop-up menu, select your document size.

NOTE
After you have selected a document size, you can adjust the scanning area further by clicking the left 
mouse button and dragging it. This is required when cropping an image for scanning.

 

5 Click the Start button.
The machine starts scanning.

 

(The Brother TWAIN screen supports languages specified in the TWAIN-compliant application you use.)
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TWAIN Driver Settings 6

1 Resolution

Select a scanning resolution from the Resolution pop-up menu. Higher resolutions need more memory 
and transfer time, but produce finer scanned images.

2 Scan Type

Select one of the following:

 Black & White

Use for text or line art images.

 Grey (Error Diffusion)

Use for photographic images or graphics. (Error Diffusion is a method for creating simulated grey 
images without using true grey dots. Black dots are put in a specific pattern to give a grey appearance.)

 True Grey

Use for photographic images or graphics. This mode is more exact because it uses up to 256 shades 
of grey.

 24bit Colour

Uses up to 16.8 million colours to scan the image. Although using 24bit Colour creates an image with 
the most accurate colour reproduction, it requires the most memory and has the longest transfer time.

3 Document Size

Document size is set to Letter by default. If you select Custom, you can specify the document size.

 

(The Brother TWAIN screen supports languages specified in the TWAIN-compliant application you use.)

1

2

5

4

3

6
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4 Adjust Image

Click the Adjust Image button for adjusting the image.

 Brightness

Adjust the setting (from -50 to 50) to get the best image. The default value of 0 represents an average 
and is usually suitable for most images. You can set the brightness level by dragging the slider to the 
right or left to lighten or darken the image. You can also enter a value in the box to set the level. If the 
scanned image is too light, set a lower brightness level and scan the document again. If the image is 
too dark, set a higher brightness level and scan the document again.

 Contrast

Adjust the setting (from -50 to 50) to get the best image. The default value of 0 represents an average 
and is usually suitable for most images. You can increase or decrease the contrast level by moving the 
slider to the right or left. An increase emphasises dark and light areas of the image, while a decrease 
reveals more details in grey areas. You can also enter a value in the box to set the Contrast.

NOTE
The Contrast setting is available only when setting Scan Type to Grey (Error Diffusion), True Grey or 
24bit Colour.

 

 Reduce Noise

You can improve and enhance the quality of your scanned images with this selection. The Reduce 
Noise setting is available when using 24bit Colour and scan resolutions of 300 dpi × 300 dpi, 
400 dpi × 400 dpi or 600 dpi × 600 dpi.
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5 2-sided Scanning

Select Long-edge binding or Short-edge binding depending on the layout of your original to make sure 
the data file created appears correctly in the scanned document.

6 PreScan

Click PreScan to preview your image and crop unwanted areas before scanning. 

Cropping is available when 2-sided scanning setting is Off.

2-sided Scan Setting Original Layout Scan Result

Long-edge binding   

Short-edge binding   
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Scan Using Apple Image Capture (ICA Driver) 6

You can scan a document using the ICA driver. Install the ICA driver from the Brother Solutions Center 
(support.brother.com). You can also scan directly using the Image Capture application.

Scan Using Apple Image Capture 6

1 Launch the Image Capture application.
 

http://support.brother.com
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2 Select your machine from the DEVICES list on the left side of the window.
Machines connected via wireless (ADS-2800W / ADS-3600W) or Ethernet LAN, appear in the SHARED 
list.
 

3 Load your document.

4 Select a size of your document.

5 Select the destination folder or destination application.

6 Click the Scan button.
The machine starts scanning.
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ICA Driver Settings 6

 

To adjust image capture settings, click Show Details. Note that the item name and assignable value may 
vary depending on the machine.

1 Kind

Allows you to select from Colour, Black & White or Text.

2 Resolution

Specifies the document resolution you want.

3 Scan Size or Size

Specifies the paper size of the document.

4 Orientation

Specifies the orientation of the document.

5 Duplex

Allows you to select the Duplex check box to perform 2-sided (duplex) scanning.

6 Scan To

Specifies the destination folder or destination application.

7 Name

Allows you to enter the prefix text used for the name of the scanned image.

8 Format

Specifies the file format of the scanned data.

ADS-XXXXX

ADS-XXXXX

1
2
3
4
5
6
7
8
9

10
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9 Combine into single document

Allows you to scan a document as one item and save it as one file when selecting PDF or TIFF for the file 
format.

10 Image Correction

Depending on the Kind option selected, it allows you to configure the following settings:

Kind Configurable Settings

Colour Brightness, Tint, Temperature, Saturation

Black & White Brightness, Contrast

Text Threshold
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Save Scanned Documents on Your Computer in Home Mode 7

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
 

Scan Using the Control Panel 7
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 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.

 

2 The Remote Setup window appears.

Windows®

 

http://support.brother.com
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 Macintosh
 

3 Select a scan-to action you want to assign (Image, OCR, E-mail, or File) from the pop-up menu.

4 Click OK to close the Remote Setup window.

5 Change other settings as needed (see Change Scan to PC Settings (Windows®) on page 186).

6 Load your document.

7 Press Scan to PC. The machine scans the document.
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Save Scanned Documents on Your Computer in 
Advanced Mode 7

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the  tab (the example below uses Advanced Mode).

3 Click the Remote Setup button.
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 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.

 

2 The Remote Setup window appears.

Windows®

 

http://support.brother.com
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 Macintosh
 

3 Select a scan-to action you want to assign (Image, OCR, E-mail, or File) from the pop-up menu.

4 Click OK to close the Remote Setup window.

5 Change other settings as needed (see Change Scan to PC Settings (Windows®) on page 186).

6 Load your document.

7 Press Scan to PC. The machine scans the document.

(ADS-2800W / ADS-3600W)

1 Load your document.

2 Swipe left or right.

3 Press to PC.

4 Swipe left or right to display the scan-to action you want to perform (to OCR, to File, to Image or 
to E-mail).

5 Press the scan-to action you want to perform.
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6 If multiple computers are connected to the machine, press a or b to display the destination computer you 
want to save on.
Press the destination computer.

7 Press Options.

8 Configure the following settings as needed: (To configure other settings, press Advanced Settings. 
For more information, see page 194.) 

 Scan Settings

 2-sided Scan

 Scan Type

 Resolution

 File Type

 Document Size

 Auto Deskew

 Skip Blank Page

 Advanced Settings

9 Press OK.

0 Press Start.
The machine starts scanning.

NOTE
• You can configure the scan-to settings from your computer. See Change Scan to PC Settings (Windows®) 

on page 186.

• To save the settings as a shortcut, press Save as Shortcut. For more information, see Adding Scan 
Shortcuts on page 10.
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Save Scanned Documents on a USB Flash Drive 7

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.

 

2 The Remote Setup window appears.

http://support.brother.com
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3 Select Scan to USB in the navigation tree, and then configure scan settings as needed.

Windows®
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 Macintosh
 

4 Click Apply and then OK.

5 Insert a USB flash drive into the machine.

6 Load your document.

7 Press Scan to USB on the control panel. The machine starts scanning.

NOTE
The file name consists of the current date and a two-digit sequential number.

 

(ADS-2800W / ADS-3600W)

1 Insert a USB flash drive into your machine.

2 Load your document.

3 Swipe left or right.

4 Press to USB.
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5 Press Options.

6 Configure the following settings as needed: (To configure other settings, press Advanced Settings. 
For more information, see page 194.) 

 2-sided Scan

 Scan Type

 Resolution

 File Type

 Document Size

 File Name

 File Name Style

 File Size

 Auto Deskew

 Skip Blank Page

 Document Separation

 Advanced Settings

NOTE
• To select Long Paper for Document Size, use the following settings:

Scan Type: Colour or Black & White

• To save your new settings as default settings, press Set New Default.

• To restore factory settings, press Factory Reset.
 

7 Press OK.

8 Press Start.
The machine starts scanning, and then the scanned data is saved on the USB flash drive.

NOTE
To save the settings as a shortcut, press Save as Shortcut. For more information, see Adding Scan 
Shortcuts on page 10.

 

IMPORTANT
DO NOT remove the USB flash drive while the machine is scanning to the USB flash drive to avoid 
damaging the drive or the data stored on it.
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Scan Documents to an FTP Server 7

When you select Scan to FTP, you can scan a black and white or colour document directly to an FTP server 
on your local network, or on the Internet.

The details required to use Scan to FTP can be entered using Web Based Management to set up and store 
the details in an FTP Profile.

NOTE
• Scan to FTP is available when FTP profiles are configured using Web Based Management.

• We recommend Microsoft® Internet Explorer® 8/10/11 for Windows® and Safari 8.0 for Macintosh. Also 
make sure your web browser has both Javascript and cookies enabled. If using a different web browser, 
make sure it is compatible with HTTP 1.0 and HTTP 1.1.
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Start Web Based Management 7

NOTE
To use Web Based Management you must set up the machine using the wireless (ADS-2800W / 
ADS-3600W) network method with the installation disc (see the Quick Setup Guide).

 

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Scan to Net Settings button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 Confirm that your Brother machine is connected to the same network as your computer or mobile 
device.

2 Start your web browser.

3 Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is 
the machine's IP address).
For example: http://192.168.1.2

NOTE
• You can see your machine’s IP address in the Network menu on the control panel of your machine.

• If you have set a login password for Web Based Management, type your password in the Login box, then 

click .
 

2 The Web Based Management window appears.

(ADS-2800W / ADS-3600W)

Start your web browser.
In your browser’s address bar, type your machine’s IP address (or your print server name). For example: 
http://192.168.1.2. You can use the machine’s LCD to find its IP address. No password is required by 

default. If you have previously set a password, type it, and then press .
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Configure the FTP Default Settings 7

1 Click the Scan tab.

2 Click the Scan to FTP/SFTP/Network/SharePoint menu in the left navigation bar.

3 Select the FTP option, and then click Submit.

4 Click the Scan to FTP/SFTP/Network/SharePoint Profile menu in the left navigation bar.
 

5 Select the profile you want to set up or change.

6 In the Profile Name field, type a name for this server profile (up to 15 alphanumeric characters). This 
name appears in the Destination field when you click Scan to Network Device in the left navigation bar 
(ADS-2400N / ADS-3000N) or on the Touchscreen of the machine (ADS-2800W / ADS-3600W).

7 In the Host Address field, type the Host Address (for example: “ftp.example.com”; up to 64 characters) 
or the IP address (for example: “192.23.56.189”), and type the path (up to 60 characters) to the folder 
on the FTP server where you want to send your scanned data. Do not type a slash mark at the beginning 
of the path.

8 In the Username field, type the user name (up to 32 characters) that has permission to write data to the 
FTP server.

9 In the Password field, type the password (up to 32 characters) associated with the user name you 
entered in the Username field. Type the password again in the Retype Password field.

0 In the Store Directory field, enter the destination folder where your document will be stored on the 
FTP server (up to 60 characters).
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A Click the File Name drop-down list, and then select a file name prefix from the three preset names 
provided, or from fourteen user-defined names. The file name used for the scanned document will be the 
file name prefix you have selected, followed by the last six digits of the scanner counter and the file 
extension (for example: “Estimate_098765.pdf”).

B Select the Colour or Black and White/Grey options to adjust the detection level.

C Select the quality, file type, document size, file size, brightness, contrast and 2-sided scan options you 
want to use for the scanned data. The following settings can be changed:

Setting Options Description

Quality Colour 100 dpi

Colour 150 dpi

Colour 200 dpi

Colour 300 dpi

Colour 600 dpi

Colour Auto

Grey 100 dpi

Grey 150 dpi

Grey 200 dpi

Grey 300 dpi

Grey 600 dpi

Grey Auto

B&W 100 dpi

B&W 150 dpi

B&W 200 dpi

B&W 300 dpi

B&W 600 dpi

B&W Auto

Auto 100 dpi

Auto 150 dpi

Auto 200 dpi

Auto 300 dpi

Auto 600 dpi

Auto

User Select

 You can select a scanning quality from the Quality drop-down list. 
Higher qualities need more memory and transfer time, but produce 
finer scanned images.

 If you select User Select, you must select the setting from the control 
panel of the machine.
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File Type PDF Single-Page

PDF Multi-Page

JPEG

PDF/A Single-Page

PDF/A Multi-Page

Secure PDF 
Single-Page

Secure PDF 
Multi-Page

Signed PDF 
Single-Page

Signed PDF 
Multi-Page

High Compression 
PDF Single-Page

High Compression 
PDF Multi-Page

XPS

TIFF Single-Page

TIFF Multi-Page

User Select

 You can select the file type you want to use for the scanned data.

 If you select Secure PDF, the machine will ask you to enter a 
four-digit password using numbers 0-9 before it starts scanning.

 If you select Signed PDF, you must install a certificate to your 
machine using Web Based Management. Select Signed PDF from 
Administrator in Web Based Management. See the Network User’s 
Guide.

 PDF/A is a PDF file format intended for long-term archiving. This 
format contains all the information necessary to reproduce the 
document after long-term storage.

 Signed PDF helps prevent data tampering and the impersonation of 
an author by including a digital certificate within the document.

 You can select PDF, Secure PDF, PDF/A, Signed PDF, JPEG or 
XPS if you select Colour or Grey in Quality.

 You can select PDF, Secure PDF, PDF/A, Signed PDF or TIFF if 
you select B&W in Quality.

 You can select PDF, Secure PDF or Signed PDF if you select Auto 
in Quality.

 If you select User Select, you must select the setting from the control 
panel of the machine.

 If you select High Compression PDF, you can select only Colour 
300dpi/Grey 300dpi.

Document Size Auto

A4

Letter

Legal

B5

A5

B6

A6

Business Card

Long Paper

 If you select Auto, you can scan documents of any size without 
making any adjustments to Document Size. For faster scan speeds, 
you can select the exact size of your document from the 
Document Size drop-down list.

 If you select 600 dpi for Quality, you cannot select Auto.

 When Auto Deskew is set to Off, you can select A4, Letter, Legal, 
B5, A5, B6, A6, Business Card or Long Paper (when 
Auto XXX dpi is not selected as the Quality).

 You can select Long Paper if you configure the settings as follows:

• Quality: other than Auto

• Auto Deskew: Off 

• Skip Blank Page: Off

File Size Small

Medium

Large

User Select

 You can adjust the file size for the scanned data.

 If you select Colour or Grey in Quality, select the file size for the 
scanned data from the drop-down list.

 If you select User Select, you must select the setting from the control 
panel of the machine.

Setting Options Description
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D In the Margin Settings, enter a value between -3 and 3 to add or remove a specific margin at the edge 
of the image.

2-sided Scan Off

Long edge

Short edge

When using 2-sided scanning, select Long edge or Short edge so the 
layout of the data file’s pages matches your original.

Brightness -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images. 
If the scanned image is too light, set a lower Brightness level and scan 
the document again.

If the image is too dark, set a higher Brightness level and scan the 
document again.

Contrast -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images.

An increase emphasises dark and light areas of the image, while 
a decrease reveals more details in grey areas.

Setting Options Description
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E Set Auto Deskew 1 to Auto if you want to correct the skew (less than 9 mm from the centre of the 
document to the edge) of the scanned data.

F To remove blank pages of the document from the scanned data, set Skip Blank Page 1 to On.

G Select a value between -5 and 5 from the drop-down list to adjust the Skip Blank Page sensitivity.

H Select Number of Documents or Number of Pages in Document Separation settings to split a 
scanned file.

I To continue scanning, set Continuous Scan to On.

J Set the Passive Mode option to Off or On depending on your FTP server and network firewall 
configuration. The default setting is On. In most cases this setting does not need to be changed.

K Change the Port Number setting used to access the FTP server. The default for this setting is port 21. 
In most cases this setting does not need to be changed.

L Click Submit.
1 Depending on the condition of the original document, this function may not work correctly.

NOTE
Using the following characters: ?, /, \, ", :, <, >, | or * may cause a sending error.

 

Scan Using FTP Server Profiles 7

NOTE
• If you have set up the machine using the USB interface method, you must set up the machine using the 

wireless (ADS-2800W / ADS-3600W) network method with the installation disc (see the Quick Setup 
Guide) to use the Scan to FTP feature.

• Before starting Scan to FTP, you must configure the Scan to FTP profile (see Scan Documents to an FTP 
Server on page 142).

 

(ADS-2400N / ADS-3000N)

1 Load your document.

2 Press the ,  or  button to which you have assigned the Scan to FTP feature. The 

machine starts scanning.
To assign the scan feature to the Network Device key, see Assign the Scan Feature to the Network 
Device Key 1-3 on page 29.

(ADS-2800W / ADS-3600W)

1 Load your document.

2 Press d or c to display to FTP/SFTP.
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3 Press to FTP/SFTP.

4 Press a or b to select one of the FTP server profiles listed.
Do one of the following:

 If the Scan to FTP profile is complete, go to 8.

 If the Scan to FTP profile is not complete, go to 5.

5 Press Options.

6 Configure the following settings as needed: (To configure other settings, press Advanced Settings. 
For more information, see on page 194.) 

 2-sided Scan

 Scan Type

 Resolution

 File Type

 Document Size

 File Name

 File Name Style

 File Size

 Auto Deskew

 Skip Blank Page

 User Name

 Document Separation

 Advanced Settings

7 Press OK.

8 Press Start.
The Touchscreen displays Connecting. If the connection to the FTP server is successful, the machine 
starts scanning.

NOTE
To save the profile as a shortcut, press Save as Shortcut.
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Scan Documents to an SFTP Server 7

When you select Scan to SFTP, you can scan a black and white or colour document directly to an SFTP 
server on your local network, or on the Internet.

The details required to use Scan to SFTP can be entered using Web Based Management to set up and store 
the details in an SFTP Profile.

NOTE
• Scan to SFTP is available when SFTP profiles are configured using Web Based Management.

• We recommend Microsoft® Internet Explorer® 8/10/11 for Windows® and Safari 8.0 for Macintosh. Also 
make sure your web browser has both Javascript and cookies enabled. If using a different web browser, 
make sure it is compatible with HTTP 1.0 and HTTP 1.1.
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Start Web Based Management 7

NOTE
If you have set up the machine using the USB interface method, you must set up the machine using the 
wireless network method with the installation disc (see the Quick Setup Guide) to use Web Based 
Management.

 

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the  (ControlCenter4) icon in the task tray, and then select Open from the menu. The 
ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Scan to Net Settings button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 Confirm that your Brother machine is connected to the same network as your computer or mobile 
device.

2 Start your web browser.

3 Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is 
the machine's IP address).
For example: http://192.168.1.2

NOTE
• You can see your machine’s IP address in the Network menu on the control panel of your machine.

• If you have set a login password for Web Based Management, type your password in the Login box, then 

click .
 

2 The Web Based Management window appears.

(ADS-2800W / ADS-3600W)

Start your web browser.
In your browser’s address bar, type your machine’s IP address (or your print server name). For example: 
http://192.168.1.2. You can use the machine’s LCD to find its IP address. No password is required by 

default. If you have previously set a password, type it, and then press .
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Configure the SFTP Default Settings 7

1 Click the Scan tab.

2 Click the Scan to FTP/SFTP/Network/SharePoint menu in the left navigation bar.

3 Select the SFTP option, and then click Submit.

4 Click the Scan to FTP/SFTP/Network/SharePoint Profile menu in the left navigation bar.
 

5 Select the profile you want to set up or change.

6 In the Profile Name field, type a name for this server profile (up to 15 alphanumeric characters). This 
name appears in Destination in Scan to Network Device from the Scan tab (ADS-2400N / ADS-3000N) 
or on the Touchscreen of the machine (ADS-2800W / ADS-3600W).

7 In the Host Address field, type the Host Address (for example: “sftp.example.com”; up to 64 characters) 
or the IP address (for example: “192.23.56.189”), and type the path (up to 60 characters) to the folder 
on the SFTP server where you want to send your scanned data. Do not type a slash mark at the 
beginning of the path.

8 In the Username field, type the user name (up to 32 characters) that has permission to write data to the 
SFTP server.

9 In the Auth. Method field, select Password or Public Key.

0 Do one of the following:

 If you have selected Password, type the password (up to 32 characters) associated with the user 
name you typed in the Username field. Type the password again in the Retype Password field.

 If you have selected Public Key, select the authentication type from the Client Key Pair drop-down list.
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A Select the authentication type from the Server Public Key drop-down list.

B In the Store Directory field, enter the destination folder where your document will be stored on the SFTP 
server (up to 60 characters).

C Click the File Name drop-down list, and then select a file name prefix from the three preset names 
provided, or from fourteen user-defined names. The file name used for the scanned document will be the 
file name prefix you have selected, followed by the last six digits of the scanner counter and the file 
extension (for example: “Estimate_098765.pdf”).

D Select the quality, file type, document size, file size, 2-sided scan, brightness and contrast options you 
want to use for the scanned data. The following settings can be changed:

Setting Options Description

Quality Colour 100 dpi

Colour 150 dpi

Colour 200 dpi

Colour 300 dpi

Colour 600 dpi

Colour Auto

Grey 100 dpi

Grey 150 dpi

Grey 200 dpi

Grey 300 dpi

Grey 600 dpi

Grey Auto

B&W 100 dpi

B&W 150 dpi

B&W 200 dpi

B&W 300 dpi

B&W 600 dpi

B&W Auto

Auto 100 dpi

Auto 150 dpi

Auto 200 dpi

Auto 300 dpi

Auto 600 dpi

Auto

User Select

 You can select a scanning quality from the Quality drop-down list. 
Higher qualities need more memory and transfer time, but produce 
finer scanned images.

 If you select User Select, you must select the setting from your 
machine’s control panel.
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File Type PDF Single-Page

PDF Multi-Page

JPEG

PDF/A Single-Page

PDF/A Multi-Page

Secure PDF 
Single-Page

Secure PDF 
Multi-Page

Signed PDF 
Single-Page

Signed PDF 
Multi-Page

High Compression 
PDF Single-Page

High Compression 
PDF Multi-Page

XPS

TIFF Single-Page

TIFF Multi-Page

User Select

 You can select the file type you want to use for the scanned data.

 If you select Secure PDF, the machine will ask you to enter a 
four-digit password using numbers 0-9 before it starts scanning.

 If you select Signed PDF, you must install a certificate to your 
machine using Web Based Management. Select Signed PDF from 
Administrator in Web Based Management. See the Network User’s 
Guide.

 PDF/A is a PDF file format intended for long-term archiving. This 
format contains all the information necessary to reproduce the 
document after long-term storage.

 Signed PDF helps prevent data tampering and the impersonation of 
an author by including a digital certificate within the document.

 You can select PDF, Secure PDF, PDF/A, Signed PDF, JPEG or 
XPS if you select Colour or Grey in Quality.

 You can select PDF, Secure PDF, PDF/A, Signed PDF or TIFF if 
you select B&W in Quality.

 You can select PDF, Secure PDF or Signed PDF if you select Auto 
in Quality.

 If you select User Select, you must select the setting from the control 
panel of the machine.

 If you select High Compression PDF, you can select only Colour 
300dpi or Grey 300dpi.

Document Size Auto

A4

Letter

Legal

B5

A5

B6

A6

Business Card

Long Paper

User Select

 If you select Auto, you can scan documents of any size without 
making any adjustments to Document Size. For faster scan speeds, 
you can select the exact size of your document from the 
Document Size drop-down list.

 If you select 600 dpi for Quality, you cannot select Auto.

 When Auto Deskew is set to Off, you can select A4, Letter, Legal, 
B5, A5, B6, A6, Business Card or Long Paper (when 
Auto XXX dpi is not selected as the Quality).

 You can select Long Paper if you configure the settings as follows:

• Quality: other than Auto

• Auto Deskew: Off 

• Skip Blank Page: Off

File Size Small

Medium

Large

User Select

 You can adjust the file size for the scanned data.

 If you select Colour or Grey in Quality, select the file size for the 
scanned data from the drop-down list.

 If you select User Select, you must select the setting from the control 
panel of the machine.

Setting Options Description
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E Select the Colour or Black and White/Grey to adjust the detection level.

F In the Margin Settings, enter a value between -3 and 3 to add or remove a specific margin at the edge 
of the image.

2-sided Scan Off

Long edge

Short edge

To scan both sides of the document, select Long edge or Short edge 
depending on the layout of your original to make sure that the data file 
created appears correctly in the scanned document.

Brightness -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images. 
If the scanned image is too light, set a lower Brightness level and scan 
the document again.

If the image is too dark, set a higher Brightness level and scan the 
document again.

Contrast -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images.

An increase emphasises dark and light areas of the image, while a 
decrease reveals more details in grey areas.

Setting Options Description
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G Set Auto Deskew 1 to Auto if you want to correct the skew (less than 9 mm from the centre of the 
document to the edge) of the scanned data.

H If you want to remove blank pages of the document from the scanned data, set Skip Blank Page 1 to On.

I Select a value between -5 and 5 from the drop-down list to adjust the Skip Blank Page sensitivity.

J Select Number of Documents or Number of Pages in Document Separation settings to split a 
scanned file.

K To continue scanning, set Continuous Scan to On.

L Change the Port Number setting used to access the SFTP server. The default for this setting is port 21. 
In most cases this setting does not need to be changed.

M Click Submit.
1 Depending on the condition of the original document, this function may not work correctly.

NOTE
Using the following characters: ?, /, \, ", :, <, >, | or * may cause a sending error.

 

Scan Using SFTP Server Profiles 7

NOTE
• If you have set up the machine using the USB interface method, you must set up the machine using the 

wireless network method with the installation disc (see the Quick Setup Guide) to use the Scan to SFTP 
feature.

• Before starting Scan to SFTP, you must configure the Scan to SFTP profile (see Scan Documents to an 
SFTP Server on page 151).

 

(ADS-2400N / ADS-3000N)

1 Load your document.

2 Press the ,  or  button to which you have assigned the Scan to SFTP feature. The 

machine starts scanning.

To assign the scan feature to the Network Device key, see Assign the Scan Feature to the Network 
Device Key 1-3 on page 29.

(ADS-2800W / ADS-3600W)

1 Load your document.

2 Press d or c to display to FTP/SFTP.

3 Press to FTP/SFTP.
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4 Press a or b to select one of the SFTP server profiles listed.
Do one of the following:

 If the Scan to SFTP profile is complete, go to 7.

 If the Scan to SFTP profile is not complete, go to 5.

5 Press Options.

6 Configure the following settings as needed: (To configure other settings, press Advanced Settings. 
For more information, see page 194.)

 2-sided Scan

 Scan Type

 Resolution

 File Type

 Document Size

 File Name

 File Name Style

 File Size

 Auto Deskew

 Skip Blank Page

 User Name

 Document Separation

 Advanced Settings

7 Press Start.

The Touchscreen displays Connecting. If the connection to the SFTP server is successful, the 
machine starts scanning.

NOTE
To save the profile as a shortcut, press Save as Shortcut.
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Scan Documents to a Shared Folder / Network Location 
(Windows®) 7

When you select Scan to Network, you can scan documents directly to a shared folder located on your local 
network or the Internet.

The details required to use Scan to Network can be entered using Web Based Management to set up and 
store the details in a Scan to Network profile. The Scan to Network profile stores user information and 
configuration settings for use on a network, or the Internet.

NOTE
• Scan to Network is available when Scan to Network profiles are configured using Web Based 

Management.

• You must configure the SNTP protocol (network time server), or set the date, time, and time zone correctly 
for authentication. For more information, see the Network User’s Guide.

• We recommend Microsoft® Internet Explorer® 8/10/11. Also make sure your web browser has both 
Javascript and cookies enabled. If using a different web browser, make sure it is compatible with HTTP 1.0 
and HTTP 1.1.
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Start Web Based Management 7

NOTE
To use Web Based Management you must set up the machine using the wireless (ADS-2800W / 
ADS-3600W) network method with the installation disc (see the Quick Setup Guide).

 

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Scan to Net Settings button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 Confirm that your Brother machine is connected to the same network as your computer or mobile 
device.

2 Start your web browser.

3 Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is 
the machine's IP address).
For example: http://192.168.1.2

NOTE
• You can see your machine’s IP address in the Network menu on the control panel of your machine.

• If you have set a login password for Web Based Management, type your password in the Login box, then 

click .
 

2 The Web Based Management window appears.

(ADS-2800W / ADS-3600W)

Start your web browser.
In your browser’s address bar, type your machine’s IP address (or your print server name). For example: 
http://192.168.1.2. You can use the machine’s LCD to find its IP address. If you have previously set a 

password, type it, and then press .
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Configure the Scan to Network Default Settings 7

1 Click the Scan tab.

2 Click the Scan to FTP/SFTP/Network/SharePoint, menu in the left navigation bar.

3 Select the Network option, and then click Submit.

4 Click the Scan to FTP/SFTP/Network/SharePoint Profile menu in the left navigation bar.
 

5 Select the profile you want to set up or change.

6 In the Profile Name field, type a name for this server profile (up to 15 alphanumeric characters). This 
name appears in Destination in Scan to Network Device from the Scan tab (ADS-2400N / ADS-3000N) 
or on the Touchscreen of the machine (ADS-2800W / ADS-3600W).

7 The Network Folder Path is the destination address (for example \\ComputerName\SharedFolder) 
(up to 255 characters).

8 Click the File Name drop-down list, and then select a file name prefix from the three preset names 
provided, or from fourteen user-defined names. The file name used for the scanned document will be the 
file name prefix you have selected, followed by the last six digits of the scanner counter and the file 
extension (for example: “Estimate_098765.pdf”).

9 In the Margin Settings, enter a value between -3 and 3 to add or remove a specific margin at the edge 
of the image.



Scan Using the Control Panel 

164

7

0 Select the quality, file type, document size, file size, 2-sided scan, brightness and contrast settings to 
use for the scanned data. The following settings can be changed:

Setting Options Description

Quality Colour 100 dpi

Colour 150 dpi

Colour 200 dpi

Colour 300 dpi

Colour 600 dpi

Colour Auto

Grey 100 dpi

Grey 150 dpi

Grey 200 dpi

Grey 300 dpi

Grey 600 dpi

Grey Auto

B&W 100 dpi

B&W 150 dpi

B&W 200 dpi

B&W 300 dpi

B&W 600 dpi

B&W Auto

Auto 100 dpi

Auto 150 dpi

Auto 200 dpi

Auto 300 dpi

Auto 600 dpi

Auto

User Select

 You can select a scanning quality from the Quality drop-down list. 
Higher qualities take more memory and transfer time, but produce 
finer scanned images.

 If you select User Select, you must select the setting from the control 
panel of the machine.
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File Type PDF Single-Page

PDF Multi-Page

JPEG

PDF/A Single-Page

PDF/A Multi-Page

Secure PDF 
Single-Page

Secure PDF 
Multi-Page

Signed PDF 
Single-Page

Signed PDF 
Multi-Page

High Compression 
PDF Single-Page

High Compression 
PDF Multi-Page

XPS

TIFF Single-Page

TIFF Multi-Page

User Select

 You can select the file type you want to use for the scanned data.

 If you select Secure PDF, the machine will ask you to enter a 4 digit 
password using numbers 0-9 before it starts scanning.

 If you select Signed PDF, you must install a certificate to your 
machine using Web Based Management. Select Signed PDF from 
Administrator in Web Based Management. See the Network User’s 
Guide.

 PDF/A is a PDF file format intended for long-term archiving. This 
format contains all the necessary information to be able to reproduce 
the document after long-term storage.

 Signed PDF helps prevent data tampering and the impersonation of 
an author by including a digital certificate within the document.

 You can select PDF, Secure PDF, PDF/A, Signed PDF, JPEG or 
XPS when you select Colour or Grey in Quality.

 You can select PDF, Secure PDF, PDF/A, Signed PDF or TIFF 
when you select B&W in Quality.

 You can select PDF, Secure PDF or Signed PDF when you select 
Auto in Quality.

 If you select User Select, you must select the setting from the control 
panel of the machine.

 If you select High Compression PDF, you can select only Colour 
300dpi or Grey 300dpi.

Document Size Auto

A4

Letter

Legal

B5

A5

B6

A6

Business Card

Long Paper

User Select

 If you select Auto, you can scan documents of any size without 
making any adjustments to Document Size. For faster scan speeds, 
you can select the exact size of your document from the 
Document Size drop-down list.

 If you select 600 dpi for Quality, you cannot select Auto.

 When Auto Deskew is set to Off, you can select A4, Letter, Legal, 
B5, A5, B6, A6, Business Card or Long Paper (when 
Auto XXX dpi is not selected as the Quality).

 You can select Long Paper when you configure the settings as 
follows:

• Quality: other than Auto

• Auto Deskew: Off 

• Skip Blank Page: Off

File Size Small

Medium

Large

User Select

 You can adjust the file size for the scanned data.

 If you select Colour or Grey in Quality, select the file size for the 
scanned data from the drop-down list.

 If you select User Select, you must select the setting from the control 
panel of the machine.

Setting Options Description
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A Select the Colour or Black and White/Grey to adjust the detection level.

2-sided Scan Off

Long edge

Short edge

To scan both sides of the document, select Long edge or Short edge 
depending on the layout of your original to make sure that the data file 
created appears correctly in the scanned document.

Brightness -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images. 
If the scanned image is too light, set a lower Brightness level and scan 
the document again.

If the image is too dark, set a higher Brightness level and scan the 
document again.

Contrast -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images.

An increase emphasises dark and light areas of the image, while a 
decrease reveals more details in grey areas.

Setting Options Description
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B Set Auto Deskew 1 to Auto if you want to correct the skew (less than 9 mm from the centre of the 
document to the edge) of the scanned data.

C To remove blank pages of the document from the scanned data, set Skip Blank Page 1 to On.

D Select a value between -5 and 5 from the drop-down list to adjust the Skip Blank Page sensitivity.

E Select Number of Documents or Number of Pages in Document Separation settings to split a 
scanned file.

F To continue scanning, set Continuous Scan to On.

G To protect the profile, select On from Use PIN for Authentication and enter a 4-digit PIN number in 
PIN Code.

H Select the authentication method. You can choose Auto, Kerberos or NTLMv2. If you select Auto, the 
authentication method will be detected automatically.

I Enter the Username that has been registered with the CIFS server for the machine (up to 96 characters).

J Enter the Password for access to the CIFS server (up to 32 characters).

K Click Submit.

L Select Date&Time from the General tab.

M Enter the date and time used on the CIFS server.

N Select the time zone from the drop-down list.

O Click Submit.
1 Depending on the condition of the original document, this function may not work correctly.

Scan Using Scan to Network Profiles 7

(ADS-2400N / ADS-3000N)

1 Load your document.

2 Press the ,  or  button to which you have assigned the Network Scan feature.

The machine starts scanning.

(ADS-2800W / ADS-3600W)

1 Load your document.

2 Swipe left or right.

3 Press to Network.
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4 Press a or b to select one of Network server profiles listed.

If the Touchscreen prompts you to enter a PIN, enter the four-digit PIN number for the profile on the 
Touchscreen.

Press OK.

Do one of the following:

 If the Scan to Network profile is complete, go to 8.

 If the Scan to Network profile is not complete, go to 5.

5 Press Options.

6 Configure the following settings as needed: (To configure other settings, press Advanced Settings. 
For more information, see page 194.) 

 2-sided Scan

 Scan Type

 Resolution

 File Type

 Document Size

 File Name

 File Name Style

 File Size

 Auto Deskew

 Skip Blank Page

 User Name

 Document Separation

 Advanced Settings

NOTE
• If you select Secure PDF Single-Page or Secure PDF Multi-Page for File Type, the machine 

asks you to enter a four-digit password using numbers 0-9 before it starts scanning.

• If you select Signed PDF Single-Page or Signed PDF Multi-Page for File Type, you must install 
a certificate to your machine, and then configure the certificate using Web Based Management.

• To save the settings as a shortcut, press Save as Shortcut.
 

7 Press OK.

8 Press Start.

The Touchscreen displays Connecting. If the connection to the Network is successful, the machine 
starts scanning.
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Scan Documents to SharePoint 7

When you select Scan to SharePoint, you can scan a black and white or colour document directly to a 
SharePoint server.

The details required to use Scan to SharePoint can be entered using Web Based Management to set up and 
store the details in an SharePoint Profile.

NOTE
• Scan to SharePoint is available when SharePoint profiles are configured using Web Based Management.

• We recommend Microsoft® Internet Explorer® 8/10/11 for Windows® and Safari 8.0 for Macintosh. Also 
make sure your web browser has both Javascript and cookies enabled. If using a different web browser, 
make sure it is compatible with HTTP 1.0 and HTTP 1.1.
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Start Web Based Management 7

NOTE
To use Web Based Management you must set up the machine using the wireless network method with 
the installation disc (see the Quick Setup Guide).

 

(ADS-2400N / ADS-3000N)

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu. 
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Scan to Net Settings button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 Confirm that your Brother machine is connected to the same network as your computer or mobile 
device.

2 Start your web browser.

3 Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" 
is the machine's IP address).
For example: http://192.168.1.2

NOTE
• You can see your machine’s IP address in the Network menu on the control panel of your machine.

• If you have set a login password for Web Based Management, type your password in the Login box, then 

click .
 

2 The Web Based Management window appears.

(ADS-2800W / ADS-3600W)

Start your web browser.
In your browser’s address bar, type your machine’s IP address (or your print server name). For example: 
http://192.168.1.2. You can use the machine’s LCD to find its IP address. If you have previously set a 
password, type it, and then press .
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Set up a Scan to SharePoint Profile 7

1 Click the Scan tab.

2 Click the Scan to FTP/SFTP/Network/SharePoint menu in the left navigation bar.

3 Select the SharePoint option, and then click Submit.

4 Click the Scan to FTP/SFTP/Network/SharePoint Profile menu in the left navigation bar.
 

5 Select the profile you want to set up or change.

6 In the Profile Name field, type a name for this server profile (up to 15 alphanumeric characters). This 
name appears in Destination in Scan to Network Device from the Scan tab (ADS-2400N / ADS-3000N) 
or on the Touchscreen of the machine (ADS-2800W / ADS-3600W).

7 In the SharePoint Site Address field, copy and paste the full destination address (for example: 
“ftp.example.com”; up to 64 characters) or the IP address (for example: “192.23.56.189”). 

8 Click the File Name drop-down list, and then select a file name prefix from the three preset names 
provided, or from fourteen user-defined names. The file name used for the scanned document will be the 
file name prefix you have selected, followed by the last six digits of the ADF scanner counter and the file 
extension (for example: “Estimate_098765.pdf”). 

9 Select the Colour or Black and White/Grey to adjust the detection level.
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0 Select the quality, file type, document size and 2-sided scan you want to use for the scanned data. 
The following settings can be changed:

Setting Options Description

Quality Colour 100 dpi

Colour 150 dpi

Colour 200 dpi

Colour 300 dpi

Colour 600 dpi

Colour Auto

Grey 100 dpi

Grey 150 dpi

Grey 200 dpi

Grey 300 dpi

Grey 600 dpi

Grey Auto

B&W 100 dpi

B&W 150 dpi

B&W 200 dpi

B&W 300 dpi

B&W 600 dpi

B&W Auto

Auto 100 dpi

Auto 150 dpi

Auto 200 dpi

Auto 300 dpi

Auto 600 dpi

Auto

User Select

 You can select a scanning quality from the Quality drop-down list. 
Higher qualities need more memory and transfer time, but produce 
finer scanned images.

 If you select User Select, you must select the setting from the control 
panel of the machine.
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File Type PDF Single-Page

PDF Multi-Page

JPEG

PDF/A Single-Page

PDF/A Multi-Page

Secure PDF 
Single-Page

Secure PDF 
Multi-Page

Signed PDF 
Single-Page

Signed PDF 
Multi-Page

High Compression 
PDF Single-Page

High Compression 
PDF Multi-Page

XPS

TIFF Single-Page

TIFF Multi-Page

User Select

 You can select the file type you want to use for the scanned data.

 If you select Secure PDF, the machine will ask you to enter a 
four-digit password using numbers 0-9 before it starts scanning.

 If you select Signed PDF, you must install a certificate to your 
machine using Web Based Management. Select Signed PDF from 
Administrator in Web Based Management. See the Network User’s 
Guide.

 PDF/A is a PDF file format intended for long-term archiving. This 
format contains all the information necessary to reproduce the 
document after long-term storage.

 Signed PDF helps prevent data tampering and the impersonation of 
an author by including a digital certificate within the document.

 You can select PDF, Secure PDF, PDF/A, Signed PDF, JPEG or 
XPS if you select Colour or Grey in Quality.

 You can select PDF, Secure PDF, PDF/A, Signed PDF or TIFF if 
you select B&W in Quality.

 You can select PDF, Secure PDF or Signed PDF if you select Auto 
in Quality.

 If you select User Select, you must select the setting from the control 
panel of the machine.

 If you select High Compression PDF, you can select only Colour 
300dpi or Grey 300dpi.

Document Size Auto

A4

Letter

Legal

B5

A5

B6

A6

Business Card

Long Paper

User Select

 If you select Auto, you can scan documents of any size without 
making any adjustments to Document Size. For faster scan speeds, 
you can select the exact size of your document from the 
Document Size drop-down list.

 If you select 600 dpi for Quality, you cannot select Auto.

 When Auto Deskew is set to Off, you can select A4, Letter, Legal, 
B5, A5, B6, A6, Business Card or Long Paper (when 
Auto XXX dpi is not selected as the Quality).

 You can select Long Paper if you configure the settings as follows:

• Quality: other than Auto

• Auto Deskew: Off 

• Skip Blank Page: Off

File Size Small

Medium

Large

User Select

 You can adjust the file size for the scanned data.

 If you select Colour or Grey in Quality, select the file size for the 
scanned data from the drop-down list.

 If you select User Select, you must select the setting from the control 
panel of the machine.

Setting Options Description
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A In the Margin Settings, enter a value between -3 and 3 to add or remove a specific margin at the edge 
of the image.

2-sided Scan Off

Long edge

Short edge

To scan both sides of the document, select Long edge or Short edge 
depending on the layout of your original to make sure that the data file 
created appears correctly in the scanned document.

Brightness -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images. 
If the scanned image is too light, set a lower brightness level and scan 
the document again.

If the image is too dark, set a higher brightness level and scan the 
document again.

Contrast -50

-40

-30

-20

-10

0

+10

+20

+30

+40

+50

Adjust the setting (from -50 to 50) to get the best image. The default 
value of 0 represents an average and is usually suitable for most images.

An increase emphasises dark and light areas of the image, while a 
decrease reveals more details in grey areas.

Setting Options Description
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B Set Auto Deskew 1 to Auto if you want to correct the skew (less than 9 mm from the centre of the 
document to the edge) of the scanned data.

C To remove blank pages of the document from the scanned data, set Skip Blank Page 1 to On.

D Select the a value between -5 and 5 from the drop-down list to adjust the Skip Blank Page sensitivity.

E Select Number of Documents or Number of Pages in Document Separation settings to split a 
scanned file.

F To continue scanning, set Continuous Scan to On.

G To PIN-protect this profile, in the Use PIN for Authentication field, select On. 

H If you have selected On for Use PIN for Authentication field. In the PIN Code field, type a four-digit PIN. 

I To set your authentication method, select Auto, Kerberos, NTLMv2, or Basic from the Auth. Method 
menu. If you have selected Auto, the authentication method will be detected automatically.

J In the Username field, type the user name (up to 96 characters) that has permission to write data to the 
folder specified in the Sharepoint Site Address field. If the user name is part of a domain, enter the user 
name in one of the following styles: 
user@domain
domain\user

K In the Password field, type the password (up to 32 characters) associated with the user name you 
entered in the Username field. Type the password again in the Retype Password field. 

L To set the Kerberos Server Address manually, in the Kerberos Server Address field, type the Kerberos 
Server Address (for example: kerberos.example.com; up to 64 characters). 

M Click Submit.
1 Depending on the condition of the original document, this function may not work correctly.

NOTE
Using the following characters: ?, /, \, ", :, <, >, | or * may cause a sending error.
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Scan Using Web Services (Windows Vista®, Windows® 7, 
Windows® 8, Windows® 8.1 and Windows® 10) 7

If you have installed the driver for scanning via Web Services, the menu that allows you to use Web Services 
for scanning appears in Destination field when you click Scan to Network Device in the left navigation bar 
(ADS-2400N / ADS-3000N) or on the Touchscreen of the machine (ADS-2800W / ADS-3600W). 
For information about installing Web Services, see Install Drivers Used for Scanning via Web Services 
(Windows Vista®, Windows® 7, Windows® 8, Windows® 8.1, Windows® 10) in the Network User’s Guide.

NOTE
• If the Touchscreen or LED indications show “Out of Memory”, decrease the Paper size setting or the 

Resolution setting. For more information, see Configuring Settings for Scanning on page 178.

• Certain characters in the messages displayed on the Touchscreen may be replaced with spaces if the 
language settings of your OS and your Brother machine are different.

 

(ADS-2400N / ADS-3000N)

If using ADS-2400N or ADS-3000N, you need to assign WS Scan to one of the three Network Device Keys. 
For more information, see Assign the Scan Feature to the Network Device Key 1-3 on page 29.

1 Load your document.

2 Press the ,  or  button to which you have assigned the Web Service Scan feature.

The machine starts scanning.

(ADS-2800W / ADS-3600W)

1 Load your document.

2 Swipe left or right.

3 Press WS Scan.

4 Press the type of scan you want to perform.

5 Press a or b to display the destination computer where you want to send the scan.
Press the destination computer.

6 Press Start.
The machine starts scanning.
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Configuring Settings for Scanning 7

If the Touchscreen or LED indications show “Out of Memory”, decrease the Paper size setting or the 
Resolution setting.

1 Open the device settings for your operating system:

Windows Vista®

 (Start) > Control Panel > Hardware and Sound > Scanners and Cameras.

Windows® 7

 (Start) > Control Panel > Hardware and Sound > Devices and Printers.

Windows® 8 and Windows® 8.1

Move your mouse to the lower left corner of your desktop. When the menu bar appears, click 
Settings, and then click Control Panel. In the Hardware and Sound group, click View devices and 
printers.

Windows® 10

Right click  (Start) > Control Panel > Hardware and Sound > View devices and printers.

2 Click your machine, and then click the Scan profiles button.
The Scan profiles dialog box appears.

3 Select the scan profile you want to use. Make sure the scanner selected in Scanner is a Brother machine 
that supports Web Services for scanning.
Click Set as Default.

4 Click Edit. The Edit Default Profile dialog box appears.

5 Select the Source, Paper size, Colour format, File type, Resolution, Brightness and Contrast 
settings.

6 Click Save Profile. The settings will be applied when scanning using the Web Services protocol.

NOTE
If you are asked to select a software application to scan, select Windows® Fax and Scan or 
Windows® Photo Gallery from the list.
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Send Scanned Documents Directly to an Email Address 
(ADS-2800W / ADS-3600W) 7

1 Load your document.

2 Swipe left or right.

3 Press to E-mail Server.

4 Select the email address you want to send the document to by doing one of the following:

 To select an email address from the Address Book, see Select an Email Address from the Address 
Book on page 180.

 To enter an email address manually, see Enter an Email Address Manually on page 180.

 To send scanned data to your email address, press to My E-mail. When your email address on 
the LCD, press Next.

NOTE
• You can select up to 300 email addresses from the Address Book and enter up to 50 email addresses 

manually. The scanned data will be sent to all of the addresses at the same time.

• If you have registered your email address with your user ID and activated Send to My E-mail feature using 
Web Based Management, the to My E-mail button appears when you log on to the machine using 
Secure Function Lock, Active Directory Authentication or LDAP Authentication. If this option is not 
available, update your machine's firmware. Go to your model's Downloads page on the Brother Solutions 
Center at support.brother.com 

 

5 Press OK, and then do one of the following:

 To use default settings, go to 9.

 To change default settings, go to 6.

6 Press Options.

7 Configure the following settings as needed: (To configure other settings, press Advanced Settings. 
For more information, see page 194.) 

 2-sided Scan

 Scan Type

 Resolution

 File Type

 Document Size

 File Name

 File Name Style

 File Size

 Auto Deskew

 Skip Blank Page

 Document Separation

 Advanced Settings

http://support.brother.com 
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NOTE
• To save your new settings as default settings, press Set New Default.

• To restore factory settings, press Factory Reset.
 

8 Press OK.

9 Press Start.
The machine starts scanning, and then sends the scanned document to the email address directly.

NOTE
To save the settings as a shortcut, press Save as Shortcut. For more information, see Shortcut 
Settings (ADS-2800W / ADS-3600W) on page 10.

 

Select an Email Address from the Address Book 7

1 Press Address Book.

2 Press . The keyboard appears on the Touchscreen.

NOTE
• The LDAP protocol allows you to search for email addresses on your server. For information on how to 

configure the LDAP protocol, see Changing LDAP Configuration in the Network User’s Guide.

• The LDAP search results appear on the Touchscreen with  before the local address book search result.

 

3 Enter the initial characters for your search, and then press OK. The machine starts searching the Address 
Book, and then the search results appear.

4 Swipe left or right, or press a or b until you find the name you are looking for. 

5 Press the name from the result.

6 Press Apply.

NOTE
• To register an email address in the Address Book, see Set Up the Address Book (ADS-2800W / 

ADS-3600W) on page 181.

• You can select up to 300 email addresses from the Address Book and enter up to 50 email addresses 
manually. The scanned data is sent to all of the addresses at the same time.

 

Enter an Email Address Manually 7

1 Press Manual. The keyboard appears on the Touchscreen.

2 Enter an email address, and then press OK.

NOTE
You can enter up to 50 email addresses manually. The scanned data is sent to all of the addresses at the 
same time.
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Set Up the Address Book (ADS-2800W / ADS-3600W) 7

The Address Book feature lets you select an email address to send the scanned data directly. You can 
configure the Address Book from the control panel of the machine.

NOTE
You can also configure the Address Book with Remote Setup or Web Based Management.

 

Register an Email Address 7

You can register up to 300 email addresses and enter a name for each address.

1 Swipe left or right, or press d or c to display Scan 2.

2 Press to E-mail Server.

3 Press Address Book.

4 Press Edit.

5 Press Add New Address.

6 Press Name.

7 Enter a name, and then press OK.

8 Press Address.

9 Enter an email address, and then press OK.

0 Press OK.

Change an Email Address 7

1 Swipe left or right, or press d or c to display Scan 2.

2 Press to E-mail Server.

3 Press Address Book.

4 Press Edit.

5 Press Change.

6 Press a or b until you find the email address you want to change.

7 Press the email address. If the email address is used in one or more shortcuts, the shortcut address also 
changes.
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8 Do one of the following:

 To change the name, go to step 9.

 To change the email address, go to step A.

9 Press Name. The keyboard appears on the Touchscreen.

0 Enter a new name, and then press OK.

A Press Address. The keyboard appears on the Touchscreen.

B Enter a new email address, and then press OK.

C Press OK.

NOTE
The Touchscreen displays a list of shortcuts using the email address you changed. The shortcut settings 
change automatically.

 

Delete an Email Address 7

1 Swipe left or right, or press d or c to display Scan 2.

2 Press to E-mail Server.

3 Press Address Book.

4 Press Edit.

5 Press Delete.

6 Press a or b until you find the email address you want to delete.

7 Press the email address.
Press OK.

NOTE
To delete an email address used in a shortcut, delete the shortcut first (see Deleting Shortcuts 
on page 15).
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Set Up a Group 7

You can register up to 20 groups. Each group can have up to 299 email addresses.

NOTE
Before setting up a group, you need to register more than one email address.

 

1 Swipe left or right, or press d or c to display Scan 2.

2 Press to E-mail Server.

3 Press Address Book.

4 Press Edit.

5 Press Setup Groups. 

6 Press Name.

7 Enter a group name, and then press OK.

8 Press Add/Delete.

9 Press a or b until you find the email address you want to add to the group.

0 Press the email address, and then press OK.

A Press OK.

Change a Group 7

You can rename a group, add an email address to the group, and delete an email address from the group.

1 Swipe left or right, or press d or c to display Scan 2.

2 Press to E-mail Server.

3 Press Address Book.

4 Press Edit.

5 Press Change.

6 Press a or b until you find the group you want to change.

7 Press the group name.

8 Do one of the following:

 To rename the group, go to step 9.

 To add an email address to the group, go to step A.

 To delete an email address from the group, go to stepA.
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9 Press Name. The keyboard appears on the Touchscreen.

0 Enter a new group name. Press OK.

A Press Add/Delete.

B Press a or b until you find the email address you want to add or delete.

C Press the email address.

D Press OK.

Delete a Group 7

1 Swipe left or right, or press d or c to display Scan 2.

2 Press to E-mail Server.

3 Press Address Book.

4 Press Edit.

5 Press Delete.

6 Press a or b until you find the group name you want to delete.

7 Press the group name, and then press OK.
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Upload Scanned Documents to the Web 
(ADS-2800W / ADS-3600W) 7

Scan to Web lets you scan a document and upload it directly to Web Services. See the Web Connect Guide.
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Change Scan to PC Settings (Windows®) 7

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

NOTE
• The screens in this guide are from Windows® 7. Screens on your computer may vary depending on your 

operating system.

• If the  icon does not appear in the task tray, click (Brother Utilities) on your desktop, and then 

click the drop-down list and select your model name (if not already selected). Click Scan in the left 
navigation bar, and then click ControlCenter4.

 

2 Click the Device Settings tab (the example below uses Home Mode).
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

3 Click the Device Scan Settings button. The Device Scan Settings dialog box appears.
The following settings can be changed:
 

4 Click the tab for the scan-to action you want to change (Image, OCR, E-mail, or File).

5 Change the settings.
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Setting Description Applicable Feature

Image OCR E-mail File

File Type Select the file type you want to use for the scanned data.

NOTE
• To save the document as a password-protected PDF, 

select Secure PDF (*.pdf) from the File Type 

drop-down list, click the (Set PDF Password) 

button, and enter the password.

• Searchable PDF is a file format that includes the text 
data layer over a scanned image. This layer allows you 
to search the text on the image data. OCR Language 
in the OCR setting must be set to match the language 
in the searchable PDF.

• To save the document as a searchable PDF, select 
Searchable PDF (*.pdf) from the File Type 
drop-down list.

• Several file types such as TIFF, TIFF Multi-Page, PDF, 
Secure PDF and JPEG support file size compression. 
Select Uncompressed or Compressed to adjust the 
file size for TIFF or TIFF Multi-Page. For PDF, Secure 
PDF and JPEG, use the slider to adjust the file size 
(not available for Scan to OCR).

 

Yes Yes Yes Yes

Target Application Select the destination application from the drop-down list. Yes Yes - -

OCR Language Select a language to match the scanned document’s text. - Yes - -

File Name Click the Change button for Image, OCR or E-mail. Enter 
a prefix for the file name if needed.

Click Insert Date in File Name if needed.

Yes Yes Yes Yes

Destination File
Path

Click the Change button, and then the folder icon to 
change the folder where you want to save your scanned 
document.

Yes Yes Yes -

Destination Folder Click the folder icon and browse to the folder where you 
want to save your scanned document. Check 
Show Folder to automatically display the destination 
folder after scanning.

- - - Yes

File Size Priority Adjust the File Size Priority by moving the slider to the 
right or left.

NOTE
File Size Priority can be adjusted depending on your 
selected File Type.

 

Yes - Yes Yes

Resolution Select a scanning resolution from the Resolution 
drop-down list. Higher resolutions need more memory and 
transfer time, but produce finer scanned images.

Yes Yes Yes Yes
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Scan Type Select from a range of scan colour depths.

Black & White

Use for text or line art images.

Grey (Error Diffusion)

Use for photographic images or graphics. (Error Diffusion 
is a method for creating simulated grey images without 
using true grey dots. Black dots are put in a specific 
pattern to give a grey appearance.)

True Grey

Use for photographic images or graphics. This mode is 
more exact because it uses up to 256 shades of grey.

24bit Colour

Uses up to 16.8 million colours to scan the image. 
Although using 24bit Colour creates an image with the 
most accurate colour reproduction, it requires the most 
memory and has the longest transfer time.

Auto

Uses suitable colours for your document automatically.

Yes Yes Yes Yes

Document Size Document size is set to Auto by default. You can scan 
documents of any size without making any adjustments to 
Document Size. For faster scan speeds, select the exact 
size of your document from the Document Size 
drop-down list.

NOTE
• If you select a 1 to 2 document size, the scanned 

image is divided into two documents that are half the 
size of the setting. If you select 1 to 2(A4), the 
scanned image is divided into two A5-size documents.

• To use 1 to 2 scanning, clear the 
Auto Image Rotation check box in the 
Advanced Settings dialog box.

• If you select a 2 in 1 document size, two scanned 
images will be combined into one document.

 

Yes Yes Yes Yes

Brightness Adjust the setting (from -50 to 50) to get the best image. 
The default value of 0 represents an average and is 
usually suitable for most images. You can set the 
brightness level by dragging the slider to the right or left to 
lighten or darken the image. You can also enter a value in 
the box to set the level. If the scanned image is too light, 
set a lower brightness level and scan the document again. 
If the image is too dark, set a higher brightness level and 
scan the document again.

Yes Yes Yes Yes

Setting Description Applicable Feature

Image OCR E-mail File
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Contrast Adjust the setting (from -50 to 50) to get the best image. 
The default value of 0 represents an average and is 
usually suitable for most images. You can increase or 
decrease the contrast level by moving the slider to the 
right or left. An increase emphasises dark and light areas 
of the image, while a decrease reveals more details in 
grey areas. You can also enter a value in the box to set the 
Contrast.

NOTE
The Contrast setting is available only when setting 
Scan Type to Auto, Grey (Error Diffusion), 
True Grey or 24bit Colour.

 

Yes Yes Yes Yes

Default Restore all settings to their factory default values. Yes Yes Yes Yes

Carrier Sheet
Mode

Scan the following documents using the Carrier Sheet. 
For this mode, you can select any setting other than Auto 
from the Document Size drop-down list.

 Large-sized Documents (A3, B4 and Ledger)

Fold the document in half and insert it in the Carrier 
Sheet for 2-sided (duplex) scanning, then both front 
and back pages are combined into a single page. 
Select 2 in 1(A4) for an A3 document, 2 in 1(B5) for a 
B4 document or 2 in 1(Letter) for a Ledger document 
from the Document Size drop-down list.

 Important documents (photos, contracts)

 Thin paper (receipts)

 Irregularly-shaped paper (clippings)

NOTE
• Load only one Carrier Sheet at a time.

• Set the document in the centre of the Carrier Sheet and 
align the top of the document with the top of the Carrier 
Sheet.

 

Yes Yes Yes Yes

Setting Description Applicable Feature

Image OCR E-mail File
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6 Click the Advanced Settings button. The Advanced Settings dialog box appears.
 

Plastic Card Mode Scan cards, such as driving licences or insurance cards, 
using these automatic settings:

 Resolution: 600 x 600 dpi

 Document Size: 2 in 1 (Auto)

 2-sided Scanning: On (Short-edge binding)

 Auto Deskew: Off

 Multifeed Detection: Off

 Auto Image Rotation: Off

NOTE
• To scan a plastic card with different settings, set 

Plastic Card Mode off, Resolution to 600 dpi, and 
Multifeed Detection to Off.

• Load up to five plastic cards at a time.
 

Yes Yes Yes Yes

Setting Description Applicable Feature

Image OCR E-mail File
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7 Change the settings.
The following settings can be changed:

1 Depending on the condition of the original document, this function may not work correctly.

Setting Description Applicable Feature

Image OCR E-mail File Print

Auto Deskew Corrects the skew (less than 9 mm from the centre of the 
document to the edge) of the scanned data. 1

 

Yes Yes Yes Yes Yes

Auto Image 
Rotation

Changes the direction of the document based on the 
text orientation. 1

Yes Yes Yes Yes Yes

Remove 
Bleed-
through / 
Pattern / 
Remove  
Background 
Colour

Prevents bleed-through and removes background colour 
of documents such as newspapers to make the scanned 
data more recognisable. 1

The sensitivity of the Remove Bleed-through / Pattern / 
Background Colour function can be adjusted with the 
slider. Moving the slider towards “High” will make the 
scanner more likely to remove bleed-throughs, patterns 
or background colours, while moving it towards “Low” 
makes the scanner less likely to remove them.

Yes Yes Yes Yes Yes

Skip Blank 
Page

Removes blank pages of the document from the 
scanning results. 1

Yes Yes Yes Yes Yes

Multifeed 
Detection

Uses an ultrasonic sensor to detect when a multifeed 
has occurred. When your machine detects a multifeed, 
you must confirm that the data scanned so far has been 
saved, and then start scanning again at the next page or 
the beginning of the document.

Yes Yes Yes Yes Yes

Display 
Scanning 
Results

Shows the numbers of total pages saved and blank 
pages skipped on your computer screen.

Yes Yes Yes Yes Yes

less than 9 mm

centre of the 
document

docu
ment

right edge of the 
paper feed tray

left edge of the 
paper feed tray

centre of the 
transport path

Scanning
direction
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8 Click OK to close the Advanced Settings dialog box.

9 Click OK to close the Device Scan Settings dialog box.
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Scan Options Using the Touchscreen (ADS-2800W / ADS-3600W)7

Skip Blank Page Function 7

If you set this feature to On, your machine removes blank pages of the document from the scanning results.

Use the slider to adjust the sensitivity of the Skip Blank Page feature. Moving the slider towards “High” makes 
the scanner more likely to skip pages, while moving it towards “Low” makes the scanner less likely to skip pages.

1 Swipe left or right to display the scan-to action you want to perform (to PC, to Network, to FTP/SFTP, 
to E-mail Server, to SharePoint, or to USB).

2 Press Options.

3 Press Skip Blank Page.

4 Press On (or Off).

Adjust the Scanning Position 7

You can adjust the position at which documents are scanned if the output position of images shifts or if 
images are squeezed together or stretched out vertically.

1 Swipe left or right to display the scan-to action you want (to Network, to FTP/SFTP, to Email Server, 
to SharePoint, or to USB).

2 Press Options.

3 Press Advanced Settings.

4 Press Margin Settings.

5 Select a value between -3 and 3.

6 Press OK.

Split and Save a Scanned File 7

When multiple documents have been scanned, you can split and save documents page-by-page by using 
this function. You can also set the number of pages to split a document by.

1 On the machine's LCD, swipe left or right to display the scan-to action you want (to Network, to 
FTP/SFTP, to Email Server, to SharePoint, or to USB).

2 Press Options.

3 Press Document Separation.

4 Press Document Separation again.

5 Press Number of Documents or Number of Pages.
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6 Press Number of Documents or Number of Pages again.

7 Enter the number of documents or pages to split.

8 Press OK.

Scan Specify Area 7

Cropping allows you to capture a portion of the document being scanned.

1 Press  (All Settings).

2 Press Initial Setup.

3 Press Scan offset correction.

4 Select Front Page Offset or Back Page Offset.

5 Adjust the area and press OK.

6 Press .

Automatically Detect Whether a Document Uses Colour 7

Automatically detects whether the document uses colour and generates a scanned image of the document. 
For documents that mix colour and black and white pages, colour pages are scanned in the Colour mode, 
and black and white pages are scanned in the Black & White mode.

1 Swipe left or right to display the scan-to action you want to perform (to PC, to Network, to FTP/SFTP, 
to Email Server, to SharePoint, or to USB).

2 Select the scan-to action you want to perform.

3 Press Options.

4 Press Scan Type.

5 Select Auto.

Auto Colour Detect Adjust 7

When the scan type is set to Auto, you can adjust the detection level of colour, B&W and greyscale.

1 Swipe left or right to display the scan-to action you want to perform (to Network, to FTP/SFTP, to Email 
Server, to SharePoint, or to USB).

2 Select the scan-to action you want to perform.

3 Press Options.

4 Press Advanced Settings.

5 Press Auto Colour Detect Adjust. 

6 Adjust the colour detection level.
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Monitor the Machine’s Status from Your Computer 
(Windows®) 8

The Status Monitor utility is a configurable software tool for monitoring the status of one or more devices, 
allowing you to get immediate notification of error messages.

Do one of the following:

 Double-click the  (Status Monitor) icon in the task tray.

 Click (Brother Utilities) on your desktop, and then click the drop-down list and select your model 

name (if not already selected). Click Tools in the left navigation bar, and then click Status Monitor. The 

Brother Status Monitor screen appears.
 

1 Troubleshooting

Click to access the Status Monitor troubleshooting web page.

2 Visit the Genuine Supplies website

Click to access the Brother genuine supplies web page.

Managing the Machine from Your 
Computer 8

1

2
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Status Monitor Indicators 8

The Brother Status Monitor icon changes colour based on your machine’s status.

1 Click the  (ControlCenter4) icon in the task tray.
The ControlCenter4 window appears.
 

A green icon indicates that your scanner is in a normal stand-by state.

A yellow icon indicates a warning.

A red icon indicates that an error has occurred.

A grey icon indicates that your scanner is offline.
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2 Click Configuration, and then select Preferences.
The ControlCenter4 Preferences window appears.
 

3 Select (or clear) the Start ControlCenter on computer startup check box.

4 Click OK.
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Set Up the Brother Machine from Your Computer 8

Use the Remote Setup application to configure your machine’s settings directly from your computer and 
upload them directly to the machine. The Remote Setup application automatically downloads the settings 
from your machine to your computer and displays them on the screen.

NOTE
If an error dialog box appears, Remote Setup cannot start. Correct the error, and then try to start 
Remote Setup again.

(Windows® only)

• If your computer is protected by a firewall, and is unable to use Remote Setup, you may need to 
configure the firewall settings to allow communication through port number 137 and 161.

• If you are using Windows® Firewall and you installed the scanner driver from the installation disc, 
the necessary Firewall settings have already been made.

 

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
 



Managing the Machine from Your Computer 

200

8

NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 The Remote Setup window appears.

NOTE
You can also start Remote Setup by following the instructions below:

Windows® 

Click (Brother Utilities) on your desktop, and then click the drop-down list and select your model 

name (if not already selected). Click Tools in the left navigation bar, and then click Remote Setup.

 Macintosh 

In the Finder menu bar, click Go > Applications > Brother, and then double-click the Remote Setup icon.
 

http://support.brother.com
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3 Select a menu in the navigation tree and configure the settings as needed (the example below uses 
General Setup in Windows®).

 OK

Click to start uploading data to the machine and exit the Remote Setup application. If an error 
message appears, re-enter the correct data, and then click OK.

 Cancel

Click to exit the Remote Setup application without uploading data to the machine.

 Apply

Click to upload data to the machine without exiting the Remote Setup application.

(ADS-2400N / ADS-3000N)
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(ADS-2800W / ADS-3600W)
 

NOTE
Click the Export button to save all settings for your machine.

Windows®

If your computer is protected by a firewall, and is unable to use Remote Setup, you may need to 
configure the firewall settings to allow communication through port number 137.

If you are using Windows® Firewall and you installed the scanner driver from the installation disc, 
the necessary Firewall settings have already been made.

 Macintosh

If you must change the machine that was registered to your computer during installation of the 
Full Driver & Software Package (see the Quick Setup Guide), or if the network environment has 
changed, you must specify the new machine. Open the Device Selector and select the new machine. 
(For network users only.) (See Configure Network Scanning for Macintosh on page 72.)

For more advanced machine management, use the latest version of BRAdmin Light utility that is 
available as a download from support.brother.com. See the BRAdmin Light Help menu for more 
information about using BRAdmin Light.

 

http://support.brother.com
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Clean the Outside of the Machine 9

1 Wipe the Control Panel with a dry, soft, lint-free cloth to remove dust.
 

2 Unfold the Output Tray and Document stopper.
 

3 Wipe the inside of the Output Tray with a dry, soft, lint-free cloth to remove dust.
 

Routine Maintenance 9
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4 Firmly insert the Output Tray into the machine.
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Clean the Scanner and Rollers 9

A spot of dirt or correction fluid on the glass strip may cause poor-quality scans. If a vertical line appears in 
the scanned data or if parts of the document are missing, you must clean the inside of the scanner.

1 Unplug the machine from the AC electrical socket.

2 Remove the Extendable ADF while releasing the levers on the back side.
 

3 Open the front cover1. 
 

1

1
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4 At the back of the machine, in the ADF unit clean the glass strips12 with a soft lint-free cloth.
 

5 Pinch both sides of the reverse roller cover1 and pull the cover down.
 

6 Slide the reverse roller to the right, and pull it towards you.
 

7 Clean the reverse roller with a soft, lint-free cloth slightly moistened with water.

1 2

1

1
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8 Slide the reverse roller1 to the left edge to place the reverse roller back into the machine.
 

9 Close the reverse roller cover.

0 Clean the pick-up roller from side to side with a soft, lint-free cloth slightly moistened with water.
 

A Close the front cover and attach the Extendable ADF.

1
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NOTE
(ADS-2800W / ADS-3600W)

If you continue to use the machine without cleaning, problems like document jams, multifeeds and misfeeds 
can easily occur. When Scheduled Maintenance alert appears, you must clean the machine promptly.

You can clean the glass strips with a lint-free cloth. When finished, run your fingertip over the glass to see 
if you can feel anything on it. If you feel dirt or debris, clean the glass again, concentrating on that area. 
You may need to repeat the cleaning process three or four times. To test, scan a document after each 
cleaning attempt.

 

 

 

 

When there is a spot of dirt or 
correction fluid on the glass 
strip the scanned sample 
shows a vertical line.

After the glass strip is cleaned 
the vertical line is gone.
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Replace Supplies 9

Part Names, Numbers, and Life Cycles 9

No. Part Name Part No. Standard Replacement 
Cycle

1 Roller kit
 

PRK-A2001 200,000 sheets

2 Carrier Sheet
 

CS-A3001 500 times
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Check Supplies Replacement Cycle (ADS-2400N / ADS-3000N) 9

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray and select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 The Remote Setup window appears.

http://support.brother.com
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3 Select Machine Info. in the navigation tree. The window displays the Pick up Roller Count and 
Reverse Roller Count (the example below uses Windows®).
 

1 Start your web browser.

2 In your browser’s address bar, type your machine’s IP address (or your print server name). For example: 
http://192.168.1.2. You can use the machine’s LCD to find its IP address.

3 Click General.

4 Click Maintenance Information.

5 Click OK.
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Check Supplies Replacement Cycle (ADS-2800W / ADS-3600W) 9

1 On the scanner’s Touchscreen press  (All Settings).

2 Press Machine Info.

3 Press Usage Counter. The Touchscreen displays Reverse Roller Count and 
Pick up roller Count.

NOTE
If the Touchscreen notifications warn you to replace the reverse roller or the pick-up roller, order the 
necessary parts, and then replace the used parts with the new ones.

 

Replace the Pick-up Roller 9

Your machine is equipped with a scan counter that automatically counts how many times the machine has 
scanned. After approximately 200,000 scans, you may have to replace the pick-up roller.

1 Remove the Extendable ADF while releasing the levers on the back side.
 

2 Open the front cover1.
 

1

1
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3 From the front of the machine, firmly pull open the tab of the pick-up roller cover.
 

4 Pull down the green lever 1 towards you and slide the pick-up roller out to the left.
 

NOTE
Be careful not to break the green hook. If it does not pull down easily, gently use a little more force.

 

NOTE
If you have problems with removing the green hook, pull it with more force. Be careful not to break the 
hook by rotating it too forcibly.

For hard operation of the green hook in step 4, turn by the additional of a little force.
 

1

2

3
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5 Take the new pick-up roller and rotate the centre pin towards you. 
 

6 While holding the new pick-up roller as shown in the illustration, make sure the green lever remains 
upright.
 

7 Insert the new pick-up roller into the machine as shown in the illustration.
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8 Rotate the lever back and forth to find a spot where you can slide the pick-up roller into the slot.
 

9 Rotate the green lever until the pick-up roller locks into place.
 

0 Close the pick-up roller cover.

A Close the front cover and attach the Extendable ADF.

B Reset the pick-up roller’s counter (see Reset the Usage Counters on page 219).

NOTE
Confirm the following:

• The Roller Count value is 0.

• The Touchscreen or LED indications do not display a replace pick-up roller message.
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Replace the Reverse Roller 9

Your machine is equipped with a scan counter that automatically counts how many times the machine has 
scanned. After approximately 200,000 scans, you may have to replace the reverse roller.

1 Open the front cover1.
 

2 At the back of the machine, pinch both sides of the reverse roller cover1, and then pull the cover down.
 

3 Slide the reverse roller to the right, and pull it towards you.
 

1

1

1
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4 Slide the new reverse roller1 into the opening on the left and place it into the machine.
 

5 Close the reverse roller cover.

6 Close the front cover.

7 Reset the reverse roller counter (see Reset the Usage Counters on page 219).

NOTE
Make sure you have checked the following:

• The reverse roller count value is 0 (see Check Supplies Replacement Cycle 
(ADS-2400N / ADS-3000N) on page 210).

• The Touchscreen or LED indications do not display either a Replace Roller or Replace Parts message.
 

1
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Reset the Usage Counters 9

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.

The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 The Remote Setup window appears.

http://support.brother.com


Routine Maintenance 

221

9

3 Select Machine Info. in the navigation tree, and then select the Scheduled maintenance counter 
option.
 

 To reset the reverse roller counter, select the Reverse Roller check box.

 To reset the pick-up roller counter, select the Pick up Roller check box.

4 Click Apply.

5 Click OK.
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Reset the Usage Counters (ADS-2800W / ADS-3600W) 9

1 On your scanner’s Touchscreen press  (All Settings).

2 Press Machine Info.

3 Press Usage Counter.

4 Do one of the following:

 To reset the reverse roller counter, press Reverse roller Count.

 To reset the pick-up roller counter, press Pick up roller Count.

5 When the Touchscreen displays a confirmation message, press Yes.

6 Press .
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Packing and Shipping the Machine 9

When you transport the machine, use the packing materials supplied with your machine. If you do not pack 
the machine correctly, any damage that may occur in transit may not be covered by your warranty. The 
machine should be adequately insured with the carrier.

1 Firmly collapse the Extendable ADF.

2 Remove the Extendable ADF 1 while releasing the levers on the back side.
 

3 Firmly push the Output Tray into the machine.
 

4 Wrap the machine in the original bag.
 

1
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5 Pack the machine and the printed materials in the original carton with the original packing material as 
shown below.
 

6 Close the carton and tape it shut.
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Overview 10

This chapter explains how to resolve typical problems you may encounter when using your Brother machine.

Go to your model’s Manuals page on the Brother Solutions Center at support.brother.com to download the 
other manuals.

Identifying The Problem 10

Make sure you have checked the following: 10

 The AC power code is connected correctly and the machine is turned on.

 All of the protective parts have been removed.

 The front cover, reverse roller cover and pick-up roller cover are completely closed.

 The interface cable is securely connected to the machine and the computer.

 The correct driver for the machine has been installed.

 The computer is connected to the correct port on the machine.

Error and Maintenance Messages 10

(For ADS-2800W / ADS-3600W)

As with any sophisticated office product, errors may occur and supplies must be replaced. If this happens, 
your machine identifies the error or required routine maintenance and displays the appropriate message. The 
most common error and maintenance messages are shown in the table.

You can correct most errors and clear routine maintenance messages yourself. If you need more help, the 
Brother Solutions Center offers the latest FAQs and troubleshooting tips.

Visit support.brother.com 

NOTE
(For ADS-2400N and ADS-3000N)

See also LED Indications (ADS-2400N / ADS-3000N) on page 249.
 

Troubleshooting 10

http://support.brother.com/
http://support.brother.com/
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Error message Cause Action

Check Connection The machine is not connected to your 
computer.

Connect the machine to your computer, and then try 
again.

Out of Memory The machine’s memory is full. To clear the error, do one of the following:

 Press any button (ADS-2400N / ADS-3000N) or 

(ADS-2800W / ADS-3600W).

 Turn the machine off and then on by unplugging 
the machine from the AC electrical socket, and 
then plugging the machine in again.

To avoid the error, do one of the following:

 Reduce the numbers of your documents.

 Reduce the resolution setting or file size.

This machine is not 
connected to your 
PC

The machine is not connected to your 
computer.

Connect the machine to your computer, and then try 
again.

Replace Pick up 
roller

The pick-up roller has been used over 
200,000 times.

Replace the pick-up roller with a new one. Scanning 
errors may occur if you do not replace the part. See 
Replace the Pick-up Roller on page 213.

Replace Reverse 
roller

The reverse roller has been used over 
200,000 times.

Replace the reverse roller with a new one. Scanning 
errors may occur if you do not replace the part. See 
Replace the Reverse Roller on page 217.

Replace pick up and 
reverse roller

Both the reverse roller and the pick-up 
roller have been used over 
200,000 times.

Replace the reverse roller and the pick-up roller with 
new ones. Scanning errors may occur if you do not 
replace the parts. See Replace the Pick-up Roller 
on page 213 and Replace the Reverse Roller 
on page 217.

Unable to Scan XX

(XX is an error code.)

A machine error has occurred. Turn the machine off and then on, and then try to 
scan again. If the error is not cleared after turning 
the machine off and on, make a note of the error 
message and report it to your Brother dealer or 
Brother customer service.

Scan error due to 
length, reduce 
length

The scanned documents have 
exceeded the maximum allowed 
length.

To scan documents longer than the maximum 
allowed length, decrease the resolution of the 
documents.
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Document Jam/
Too Long

 The Paper Guides are not set to 
the correct document size.

 The settings are not suitable for 
your document.

 Paper dust has accumulated on 
the surface of the pick-up roller or 
reverse roller.

Clear the document jam (see Document Jam 
on page 229), and then do the following:

 Adjust the Paper Guides to fit the width of the 
document. If Scan Size is set to Auto and you are 
scanning a document that contains multiple 
page sizes, insert narrow pages straight and as 
close to the centre of the machine as possible. 
If you are not feeding the document straight, 
use Continuous Scanning.

 Confirm the settings. See Important in Document 
Jam on page 229.

 Clean the pick-up roller and reverse roller. See 
Clean the Scanner and Rollers on page 205.

Multifeed 
detection

Multiple pages were fed at the same 
time.

Clear the multifeed. See Document Jam 
on page 229.

Unusable Device An unusable device is inserted in the 
USB port.

Disconnect the device. Turn the machine off and then 
on by unplugging the machine from the AC electrical 
socket, and then plugging the machine in again.

Unusable 
USB Device

An unsupported USB device is 
inserted in the USB port.

Remove the unsupported USB device, such as a 
mouse or mobile device that does not support USB 
flash drive mode, from the USB port.

USB Hub 
Not Supported

A hub or USB flash drive with a hub is 
inserted in the USB port.

Remove the unsupported device, such as a USB hub 
or USB flash drive with a hub, from the USB port.

Insufficient USB 
Storage

The inserted USB flash drive is full. Press any button (ADS-2400N / ADS-3000N) or 
Close (ADS-2800W / ADS-3600W), and then do one 
of the following:

 Delete unused files or folders from the USB flash 
drive, and then try again.

 Use a USB flash drive that has available space.

USB Access Error The USB flash drive was removed 
while it was being accessed.

Press any button (ADS-2400N / ADS-3000N) or 
Close (ADS-2800W / ADS-3600W).

USB Write-protected The inserted USB flash drive is 
write-protected.

Remove the write-protected USB flash drive, press 
any button (ADS-2400N / ADS-3000N) or 
Close (ADS-2800W / ADS-3600W), and then do 
one of the following:

 Turn the USB flash drive’s write-protection off, 
and then try again.

 Use a USB flash drive that is not write-protected.

Too Many Files on 
USB

Your machine cannot save to a USB 
flash drive if it contains too many files.

Remove the USB flash drive, press any button 

(ADS-2400N / ADS-3000N) or (ADS-2800W / 

ADS-3600W). Delete unused files or folders from 
the root folder of the USB flash drive, and then try 
again.

Error message Cause Action
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File Name Cannot Be 
Used

The maximum sequential number 99 
sequential number for the file name 
has been reached.

Press any button (see File Name Cannot Be Used 
(Scan to USB) on page 253) (ADS-2400N / 

ADS-3000N) or (ADS-2800W / ADS-3600W), 

and then do one of the following:

 Delete unused files from the USB flash drive and 
then try again.

 Change the file name. See Save Scanned 
Documents on a USB Flash Drive on page 137.

No Profile set No Scan to FTP/SFTP profile or Scan 
to Network profile is registered.

Configure the Scan to FTP/SFTP profile or the Scan 
to Network profile before using Scan to FTP or Scan 
to Network. See Scan Documents to an FTP Server 
on page 142, Scan Documents to an SFTP Server 
on page 151 or Scan Documents to a Shared 
Folder / Network Location (Windows®) 
on page 160.

No Certificate The certificate does not exist, or is 
corrupted.

Configure the settings under Signed PDF in the 
Administrator tab in Web Based Management. 
See Scan Documents to an FTP Server 
on page 142 or Scan Documents to a Shared 
Folder / Network Location (Windows®) 
on page 160.

Address Book Full The Address Book is full. Delete unnecessary email addresses and then try 
again.

Registration Failed (Email Address)

The email address is too long.

You can enter an email address that contains up to 
64 characters.

(Shortcut)

The maximum number of email 
addresses in a shortcut has been 
reached.

Delete unnecessary email addresses and then try 
again.

Shortcuts Full The maximum number of shortcuts 
has been reached.

Delete unnecessary shortcuts and then try again.

Cannot Delete The email address is registered in a 
shortcut.

You cannot delete an email address used in a 
shortcut. Delete the shortcut first, and then try again.

Access Denied Secure Function Lock is on. Call your administrator to check your Secure 
Function Lock settings.

See Secure Function Lock 3.0 (ADS-2800W / 
ADS-3600W) on page 39.

Scheduled 
Maintenance alert

Periodic maintenance is required.
(Every 5,000 pages) 

Clean the pick-up roller and reverse roller and clear 
the counter.

See Clean the Scanner and Rollers on page 205.

Error message Cause Action
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Document Jam 10

Documents can jam in the ADF if: 

 the documents are not inserted or fed correctly

 the documents are too long

 multiple pages are fed at the same time (multifeed)

Follow the steps below to clear a document jam:

1 Take out any paper that is not jammed from the ADF.

2 Open the front cover by pinching the cover release levera.
 

3 Pull the jammed document out of the machine.
 

NOTE
Check for ripped paper inside the machine. Remove any ripped paper you find inside the machine.

 

1
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4 Close the front cover.

5 Press any button (ADS-2400N / ADS-3000N) or  (ADS-2800W / ADS-3600W).

NOTE
When clearing the multifeed, you must confirm that the data scanned so far has been saved, and then start 
scanning again at the next page or the beginning of the document.

 

IMPORTANT
• To avoid damage to the jammed document, DO NOT pull the document out before opening the front cover.

• Take out any paper from the ADF before closing the front cover.

• To avoid future document jams, do the following:

• Close the front cover completely by pushing it gently in the centre.

• Configure the settings for your document correctly.

• Clean the reverse roller and pick-up roller. To clean the reverse roller, see Replace the Reverse Roller 
on page 217 for instructions on how to pull the reverse roller out from the machine. Clean the rubber side 
of the reverse roller with a soft, lint-free cloth moistened with water, and then put the reverse roller back 
into the machine. To clean the pick-up roller, see Clean the Scanner and Rollers on page 205.

• Stagger the pages, and then load your document. See Load Documents on page 59.

• Make sure your document is acceptable for the machine. See Acceptable Documents on page 50.

• Load your document correctly. See Load Documents on page 59.

• Load no more than 50 pages at a time.

• To avoid a jams when using long paper, you must select Long Paper for Scan Size or Document Size.
 

When you scan from your computer

• Change Scan Settings (ControlCenter4) (Windows®) on page 98

• Change Scan Button Settings from Brother iPrint&Scan (Mac) on page 104

When you scan from the machine (ADS-2800W / ADS-3600W)

Confirm the following settings on the Touchscreen:

(Scan to USB/FTP/Network/Email Server)

• Scan Type: Colour or Black and White

• Skip Blank Page: Off
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Operational and Software Difficulties 10

IMPORTANT
For technical help, you must contact Brother customer support.

 

If you think there is a problem with your machine, check the table below and follow the troubleshooting tips.

You can resolve most problems yourself. If you need additional help, the Brother Solutions Center offers the 
latest FAQs and troubleshooting tips, visit support.brother.com 

Using non-Brother supplies may affect the scan quality, hardware performance, and machine reliability.

Scanning Difficulties 10

Difficulty Cause Suggestions

TWAIN or WIA errors 
appear when starting 
to scan. (Windows®)

The TWAIN or WIA driver has not been 
selected as the primary source in your 
scanning application.

Make sure the Brother TWAIN or WIA driver is 
selected as the primary source in your scanning 
application. For example, in Nuance™ 
PaperPort™ 14SE, click Scan Settings, and then 
Select to select the Brother TWAIN/WIA driver.

TWAIN errors appear 
when starting to scan. 
(Macintosh)

The TWAIN driver has not been 
selected as the primary source in your 
scanning application.

Make sure the Brother TWAIN driver is selected as 
the primary source in your application. 
You can also scan documents using the 
ICA Scanner Driver.

OCR does not work. The scanner resolution is too low. Increase the scanner resolution.

Vertical lines are seen 
in the scanned image.

Paper dust has accumulated on the 
surface of the glass strips.

Clean the glass strips inside the machine. 
See Clean the Scanner and Rollers on page 205.

The scanned image is 
missing.

 The Paper Guides are not adjusted 
to fit the width of the document.

 The Auto Deskew feature was set to 
On when the document was 
scanned.

 The settings are not suitable for your 
document. For example, a Letter/A4 
size document was fed when 
Executive/A5 was selected as 
document size.

 Adjust the Paper Guides to fit the width of the 
document. When Scan Size is set to Auto and 
you are scanning a document that contains 
multiple page sizes, insert narrow pages straight 
and as close to the centre of the machine as 
possible. If the document does not stay straight 
while feeding, use Continuous Scanning.

 Set Auto Deskew to Off.

 Make sure the document size settings are 
suitable for your document.

Configure the margin settings and adjust the 
scanning position. For more information, see 
Split and Save a Scanned File on page 194.

http://support.brother.com
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The scanned image is 
skewed.

 The Paper Guides are not adjusted 
to fit the width of the document.

 The Auto Deskew feature was set to 
Off when the document was 
scanned.

 The Long Paper setting is selected.

 Adjust the Paper Guides to fit the width of the 
document. If Scan Size is set to Auto and you 
are scanning a document that contains multiple 
page sizes, insert narrow pages straight and as 
close to the centre of the machine as possible. If 
the document does not stay straight while 
feeding, use Continuous Scanning.

 Set Auto Deskew to On.

 Select a setting other than Long Paper.

Scanning is too slow. The resolution is not suitable for your 
document.

Decrease the scanner resolution. 
Set scan size to a setting other than Auto.

The document was not 
fed.

 Paper dust has accumulated on the 
surface of the pick-up roller or 
reverse roller.

 Too many documents are loaded in 
the ADF at a time.

 There are foreign objects in the 
ADF.

 Your document is too thin or too 
thick.

 Remote Setup is in progress.

 Paper ejection has paused.

 The reverse roller cover is not 
closed correctly.

 Clean the reverse roller and pick-up roller. 
To clean the reverse roller, see Replace the 
Reverse Roller on page 217 to learn how to pull 
the reverse roller out from the machine, clean 
the rubber side of the reverse roller with a soft, 
lint-free cloth moistened with water, and then 
attach the reverse roller in the machine. 
To clean the pick-up roller, see Clean the 
Scanner and Rollers on page 205.

 Make sure the maximum number of pages is 
suitable for your document. See Acceptable 
Documents on page 50.

 Remove any foreign objects or ripped paper 
from the ADF.

 Make sure your document is acceptable for the 
machine. See Acceptable Documents 
on page 50.

 Cancel Remote Setup.

 Remove any paper from the ADF.

 Securely cover the reverse roller cover until the 
hooks fit into the front cover.

The document is 
jammed.

 Paper dust has accumulated on the 
surface of the pick-up roller or 
reverse roller.

 There are foreign objects in the 
ADF.

 Your document is not acceptable for 
the machine.

 Clean the reverse roller and pick-up roller. 
To clean the reverse roller, see Replace the 
Reverse Roller on page 217 to learn how to pull 
the reverse roller out from the machine, clean 
the rubber side of the reverse roller with a soft, 
lint-free cloth moistened with water, and then 
install the reverse roller in the machine. To clean 
the pick-up roller, see Clean the Scanner and 
Rollers on page 205.

 Remove any foreign objects or ripped paper 
from the ADF.

 Make sure your document is acceptable for the 
machine. See Acceptable Documents 
on page 50.

Difficulty Cause Suggestions
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The order of the output 
document pages 
changes.

The Output Tray has been positioned 
so that it does not match the size of the 
document.

Carefully position the Output Tray so that it 
matches the size of the document. 

The scan quality is 
poor.

 Paper dust has accumulated on the 
surface of the pick-up roller or 
reverse roller.

 Paper dust has accumulated on the 
surface of the glass strips inside the 
machine.

 The resolution is too low.

 Clean the reverse roller and pick-up roller. To 
clean the reverse roller, see Replace the 
Reverse Roller on page 217 to learn how to pull 
the reverse roller out from the machine, clean 
the rubber side of the reverse roller with a soft, 
lint-free cloth moistened with water, and then 
install the reverse roller in the machine. To clean 
the pick-up roller, see Clean the Scanner and 
Rollers on page 205.

 Clean the glass strips inside the machine. See 
Clean the Scanner and Rollers on page 205.

 Increase the scanner resolution.

The machine pauses 
for about 
three seconds 
between each page 
when scanning.

If you scan continuously, the internal 
temperature of the machine may 
increase, causing the machine to enter 
the motor save mode.

NOTE
The length of the pause may vary 
depending on the scanning 
conditions.

 

This is normal and you may continue to scan. 

Bleed-through is seen 
in the scan data.

The settings are not appropriate for the 
type of document being scanned.

Select the Remove Bleed-through / Pattern / 
Remove Background Colour check box.

Colours in the 
scanned data are 
dark.

The settings are not appropriate for the 
type of document being scanned.

Do one of the following:

 Select the Remove Bleed-through / Pattern / 
Remove Background Colour check box, and 
then scan from your computer.

 Increase brightness, and then scan from your 
computer.

 Increase contrast, and then scan from your 
computer.

 Change Scan Type to Grey or Colour, and then 
scan from your computer.

A page that is not a 
blank page is skipped.

 The document is too light.

 Skip Blank Page is set to On.

Set Skip Blank Page to Off.
Alternatively, use a lower Skip Blank Page 
sensitivity setting.

Cannot scan a long 
document.

Long Paper is not selected for the 
document size.

Select Long Paper for the document size. If you 
cannot select Long Paper, when scanning from the 
machine’s Control Panel, set Skip Blank Page to off 
and set Scan Type to an option other than Auto. 
Then, you can select Long Paper for the document 
size.

Difficulty Cause Suggestions
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Software Difficulties 10

A multifeed occurs. The document is not loaded correctly. Load your document correctly (see Standard-size 
Documents on page 59), and then try again.

Cannot scan. Secure Function Lock is on. Call your administrator to check your Secure 
Function Lock settings.

See Secure Function Lock 3.0 (ADS-2800W / 
ADS-3600W) on page 39

Cannot scan thick 
cards successfully.

Either the card placement or scan 
settings may be incorrect.

Set your card sideways. Scan using the following 
settings:

Plastic card mode: Off

Resolution: 600 dpi

Document Size: Auto

Multifeed detection: Off

The edge of your 
document does not 
scan correctly, or the 
scan is stretched when 
scanning a thick 
document.

A thick document hits the output tray. Scan your document without using the output tray.

Auto Start Scan does 
not start. 
(ADS-2800W/
ADS-3600W)

The settings for Auto Start Scan (the 
9th Shortcut tab) are incorrect.

Confirm the settings for Auto Start Scan (the 9th 
Shortcut tab).

See Auto Start Scan on page 8

Difficulty Cause Suggestions

Cannot install 
software.

— (Windows® only)

Run the scanner driver on the installation disc to 
repair and reinstall the software.

Cannot start 
ControlCenter4 
(Windows®).

— If the  icon does not appear in the task tray, 

click (Brother Utilities) on your desktop, and 

then click the drop-down list and select your model 
name (if not already selected). Click Scan in the left 
navigation bar, and then click ControlCenter4.

Cannot configure the 
settings to scan from 
the Control Panel of 
the machine.

(ADS-2400N / 
ADS-3000N)

— Use Remote Setup. See Set Up the Brother 
Machine from Your Computer on page 199.

Difficulty Cause Suggestions
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Network Difficulties 10

Cannot save the 
settings in Remote 
Setup or Web Based 
Management.

 The machine is processing.

 The machine is being configured 
from the machine’s Control Panel.

 Wait until the machine finishes processing and 
then try again.

 Stop configuring the machine from the Control 
Panel.

Cannot start Remote 
Setup.

 The machine is turned off.

 The machine is not connected to 
your computer.

 An error has occurred.

 The machine is scanning.

 The machine is being configured 
from the machine’s Control Panel.

 Turn the machine on and then try again.

 Connect the machine to your computer and then 
try again.

 Clear all errors, and then try again.

 Wait until scanning has finished and try again.

 Stop configuring the machine from the Control 
Panel.

Difficulty Suggestions

Cannot scan over the network. Make sure your machine is powered on, online and in Ready Mode. Check the 
current network settings.

See Troubleshooting in the Network User’s Guide.

The network scanning feature does 
not work.

 Windows®

You must configure the third-party Security/Firewall Software to allow 
Network scanning. To add port 54925 for Network scanning, use the 
information below:

Name: Enter any description, for example Brother NetScan

Port number: Enter 54925

Protocol: Select UDP

Refer to the instruction manual supplied with your third-party 
Security/Firewall Software or contact the software manufacturer.

 Macintosh

(Brother iPrint&Scan)

In the Finder menu bar, click Go > Applications, and then double-click the 
Brother iPrint&Scan icon. The Brother iPrint&Scan window appears. Click 
the Select your Machine button, and then follow the on-screen instructions 
to reselect your network machine.

(TWAIN driver)

In the Finder menu bar, click Go > Applications > Brother > TWAIN 
Driver Utility, and then double-click the Device Selector icon. The Device 
Selector window appears. Reselect your network machine, make sure 
Status is idle, and then click OK.

Difficulty Cause Suggestions
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Other Difficulties 10

The Brother software cannot be 
installed.

 Windows®

If the Security Software warning appears on the computer screen during the 
installation, change the Security Software settings to permit the Brother 
product setup program or other program to run.

 Macintosh

If using a firewall function of anti-spyware or antivirus security software, 
temporarily disable it, and then install the Brother software.

Cannot connect to wireless network.
(ADS-2800W / ADS-3600W)

Check the wireless network settings.

See Troubleshooting in the Network User’s Guide.

Reset the network settings. See Reset the Machine (ADS-2400N / ADS-3000N) on page 241.

See Reset the Machine (ADS-2800W / ADS-3600W) on page 242.

How to check the machine’s 
IP address. (ADS-2400N / 
ADS-3000N)

(ADS-2400N / ADS-3000N)

1. Start the ControlCenter application.

2. Click the Device Settings tab.

3. Click the Scan to Net Settings button. The Web Based Management 
window appears.

4. Select Network tab.

5. Click Wired.

Cannot recognise the NFC card. Set NFC to On.

Difficulty Cause Suggestions

The machine is in 
Sleep Mode (power 
save mode).
(ADS-2800W / 
ADS-3600W)

The machine is idle and the period of 
time specified by the Sleep Time setting 
has elapsed.

Do one of the following:

 Press .

 Press .

 Scan using your computer.

 Open the top cover.

 Load your document.

 Touch the screen.

 Touch an IC Card to the NFC reader.

The machine is not 
turned on.

The machine was plugged in without 
waiting for 60 seconds after pulling out 
the plug.

Turn the machine off, wait 60 seconds, and then 
turn the machine on.

The machine is in 
Offline Mode.

The machine is not connected to the 
computer.

Connect the machine to the computer, and then 
turn the machine on.

Difficulty Suggestions
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Machine Information 10

Check the Serial Number (ADS-2400N / ADS-3000N) 10

1 Start the application.

Windows®

1 Click the (ControlCenter4) icon in the task tray, and then select Open from the menu.
The ControlCenter4 window appears.

2 Click the Device Settings tab (the example below uses Home Mode).

3 Click the Remote Setup button.
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NOTE
If using Advanced Mode, click the  (Settings) icon to access Device Settings.
 

 

 Macintosh

1 In the Finder menu bar, click Go > Applications > Brother.

2 Double-click the Remote Setup icon.

NOTE
• To use Remote Setup, go to your model's Downloads page on the Brother Solutions Center at 

support.brother.com and download Remote Setup from Utilities.

• Remote Setup for Mac supports USB connections only.

• Remote Setup for Mac supports macOS 10.13 or earlier.
 

2 The Remote Setup window appears.

http://support.brother.com
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3 Select Machine Info. in the navigation tree. The Serial No. appears (the example below uses Windows®).
 

Check the Serial Number (ADS-2800W / ADS-3600W) 10

1 On your machine’s Touchscreen press  (All Settings).

2 Press Machine Info.

3 Press Serial No. The Touchscreen displays the machine’s serial number.

WLAN Enable/Disable (ADS-2800W / ADS-3600W) 10

1 Press  (All Settings).

2 Press Network.

3 Press WLAN.

4 Press a or b to display WLAN Enable.

5 Press WLAN Enable.

6 Press On (or Off).
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LAN Enable/Disable 10

ADS-2800W/ADS-3600W

1 Press .

2 Press Network.

3 Press Wired LAN.

4 Press a or b to display Wired Enable. 

5 Press  Wired Enable.

6 Press On (or Off).

ADS-2400N/ADS-3000N

1 Open the front cover.

2 Press and hold  and  for about five seconds until the machine beeps.

To disable LAN: press and hold  and  for about five seconds until the machine beeps.

USB Enable/Disable 10

ADS-2800W/ADS-3600W

1 Press .

2 Press Initial Setup.

3 Press USB/PC Port.

4 Press On (or Off).

5 Press OK for two seconds to reboot the machine. 

ADS-2400N/ADS-3000N

1 Open the front cover.

2 Press and hold  and  for about five seconds until the machine beeps.

To disable USB: press and hold  and  for about five seconds until the machine beeps.

3 The machine reboots. 
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Reset Functions 10

The following reset functions are available:

 Network

You can restore the network settings, such as the password and IP address information, to factory 
settings.

 Address Book (ADS-2800W / ADS-3600W)

You can reset the Address Book setting.

 All Settings

You can restore all settings to factory settings.

We recommend performing this procedure before transferring, or disposing of, the machine.

NOTE
Unplug the interface cable before you select Network or All Settings.
 

Reset the Machine (ADS-2400N / ADS-3000N) 10

1 Open the front cover 1.
 

2 Do one of the following:

 Press  for about five seconds until the machine beeps to reset the network.

 Press  for about five seconds until the machine beeps to reset the IPsec.

 Press  for about five seconds until the machine beeps to reset the periodic cleaning counter.

 Press  for about five seconds until the machine beeps to reset the pick-up roller counter.

1
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 Press  for about five seconds until the machine beeps to reset the reverse roller counter.

 Press   for about five seconds until the machine beeps to reset the pick-up roller counter 

and reverse roller counter.

Reset the Machine (ADS-2800W / ADS-3600W) 10

1 Press  (All Settings).

2 Press a or b to display Initial Setup.

3 Press Initial Setup, and then Reset.

4 Press the type of reset you want.

5 Press OK for two seconds to restart the machine.
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A

General A

NOTE
This chapter provides a summary of the machine’s specifications. For additional specifications, visit 
support.brother.com 

 

1 Measured diagonally.
2 Measured when the machine is connected to your computer.
3 When 2-sided (duplex) scanning.
4 The USB port, wired LAN port and NFC (only for applicable model) are activated. 

The USB port is connected.
5 Measured when the machine's USB, wired LAN connection are activated and USB Flash Drive is connected.
6 Measured when the machine's USB, wired LAN and NFC (only for applicable model) connection are activated and USB Flash Drive is connected.

Specifications A

Model ADS-2400N 5 ADS-3000N 5 ADS-2800N 5 ADS-3600N 6

Memory Capacity Standard 256 MB 512 MB

Power Source AC: 220 - 240 V, 50/60 Hz

Touchscreen LCD (Liquid Crystal Display) - Touchscreen 93.4 mm TFT 
Colour LCD 1

Approx. Power Consumption 2 Scanning 3 27 W 30 W 27 W 30 W

Ready 4 2.5 W 3.6 W 3.3 W 4.4 W

Sleep 1.3 W 2.2 W 1.4 W 2.3 W

Power Down 0.12 W

http://support.brother.com
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Model ADS-2400N ADS-3000N ADS-2800W ADS-3600W

Dimensions  

Approx. Weights 4.45 kg (ADS-2400N / 
ADS-3000N) 

4.55 kg (ADS-2800W / 
ADS-3600W)

Temperature Operating Between 5°C and 35°C

Storage Between 0°C and 40°C

306 mm

25
0 

m
m

182 mm

258 mm

306 mm

19
9 
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Scanner A

1 For the latest driver updates for the version of macOS you are using, visit support.brother.com 

Direct Scan Feature (Scan to USB) A

1 USB Mass Storage standard up to 64 GB
Supported formats: FAT12/FAT16/FAT32/exFAT

Humidity Operating Between 20% and 80%

Storage Between 10% and 90%

ADF (Automatic Document Feeder) Up to 50 pages (Paper: 80 g/m2 Legal size, or less than 5 mm)

Document 
Size

Multiple Paper Width Between 51 mm and 215.9 mm

Length Between 51 mm and 355.6 mm

Single Paper Width Between 51 mm and 215.9 mm

Length Between 51 mm and 5000 mm

Colour/Black Yes / Yes

TWAIN Compliant Windows® Windows® XP 32 bit (SP3) / Windows Vista® / Windows Server® 2003 R2 32 bit 
(SP2) / Windows Server® 2008 / Windows Server® 2008 R2 / 
Windows Server® 2012 / Windows Server® 2012 R2 / Windows® 7 / 
Windows® 8 / Windows® 8.1 / Windows® 10

Macintosh OS X 10.8.5, 10.9.x, 10.10.x, 10.11.x 1

WIA Compliant Windows® Windows® XP 32 bit (SP3) / Windows Vista® / Windows® 7 / Windows® 8 / 
Windows® 8.1 / Windows® 10

ICA Compliant Macintosh OS X 10.8.5, 10.9.x, 10.10.x, 10.11.x 1

ISIS™ Compliant Windows® Windows Vista® / Windows® 7 / Windows® 8 / Windows® 8.1 / Windows® 10

Colour Depth Input 30 bit colour Processing

Output 24 bit colour Processing

Resolution Interpolated Up to 1,200 dpi × 1,200 dpi

Optical Up to 600 dpi × 600 dpi

Scanning Width 215 mm

Greyscale 256 levels

Max. Speed For detailed specifications, visit www.brother.com 

Compatible Media USB flash drive 1 1

Interface Interface USB 2.0 Hi Speed

Model ADS-2400N ADS-3000N ADS-2800W ADS-3600W

http://www.brother.com
http://support.brother.com
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Interfaces A

1 Your machine has a Hi-Speed USB 2.0 interface. The machine can also be connected to a computer that has a USB 1.0/1.1 interface.
2 Your machine has a USB 3.0 SuperSpeed interface. The machine can also be connected to a computer that has a USB 2.0/USB 1.1/USB 1.0 

interface.
3 Third-party USB ports are not supported.
4 See Network on page 246.

See Supported Protocols and Security Features in the Network User’s Guide.

Network A

NOTE
For more information about the Network specifications, see the Network User’s Guide.

 

1 If you require more advanced scanner management, use the latest Brother BRAdmin Professional utility version available as a download from 
support.brother.com 

USB (ADS-2400N / ADS-2800W)
Hi-Speed USB 2.0 1, 3

Use a USB 2.0 cable (Type A/B) that is no more than 2 metres long.
(ADS-3000N / ADS-3600W)
USB 3.0 SuperSpeed Port 1, 2

LAN 4 Use an Ethernet UTP cable category 6 or later.

Wireless LAN
(ADS-2800W / 
ADS-3600W)

IEEE 802.11b/g/n (Infrastructure/Ad-hoc Mode)
IEEE 802.11g/n (WiFi Direct)

LAN You can connect your machine to a network for Network Scanning and Remote Setup. Also 
included is Brother BRAdmin Light 1 Network Management software.

Wireless Network 
Security (ADS-2800W / 
ADS-3600W)

WEP 64/128 bit, WPA-PSK (TKIP/AES), WPA2-PSK (AES), Enterprise WPA/WPA-PSK 
(AES), EAP, EAP RAST, PEAP, EAP TTLS, EAP TLS

Setup Support Utility 
(ADS-2800W / 
ADS-3600W)

WPS 
WLAN Assistant

http://support.brother.com
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Computer Requirements A

SUPPORTED OPERATING SYSTEMS AND SOFTWARE FUNCTIONS

Computer Platform and 
Operating System Version

Supported 
Computer 
Software 
Functions

Computer 
Interface

Minimum 
Processor Speed

Minimum 
RAM

Recommended 
RAM

Hard Disk Space 
to Install

For 
Drivers

For 
Applications

Windows® 
Operating 
System

Windows® XP 
32 bit (SP3) 1

Scanning USB

10/100/
1000Base-TX 
(Ethernet)

Wireless 4 
802.11b/g/n

Intel® Pentium® II 
or equivalent

128 MB 256 MB 150 MB 1 GB

Windows 
Vista® 1

Intel® Pentium® 4 
or equivalent 64 bit 
(Intel® 64 or 
AMD64) supported 
CPU

512 MB 1 GB 500 MB 1 GB

Windows 
Server® 2003 
R2 32 bit 
(SP2) 2, 3

Windows 
Server® 2008 2

Windows 
Server® 2008 
R2 2

Windows 
Server® 2012 2

Windows 
Server® 2012 
R2 2

Windows® 7 1

Windows® 8 1

Windows® 8.1 1

Windows® 10 1

1 GB 
(32 bit)

2 GB 
(64 bit)

1 GB (32 bit)

2 GB (64 bit)

650 MB 1 GB

Macintosh 
Operating 
System

OS X 10.8.5
OS X 10.9.x
OS X 10.10.x
OS X 10.11.x

Scanning USB 5

10/100/
1000Base-TX 
(Ethernet)

Wireless 4 
802.11b/g/n

Intel® Processor 2 GB 2 GB 80 MB 1 GB

Conditions:
1 Nuance™ PaperPort™ 14SE supports Windows® XP 32 bit 

(SP3), Windows Vista®, Windows® 7, Windows® 8, 
Windows® 8.1 and Windows® 10.

2 • The Desktop Experience Pack is needed.
• This operating system does not support the supplied 

applications.
3 Server OS supports Scanner Driver Only.
4 ADS-2800W and ADS-3600W.
5 Third-party USB ports are not supported.

For the latest driver updates, visit support.brother.com 

All trademarks, brand and product names are the property of their 
respective companies.

http://support.brother.com
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B

Entering Text (ADS-2800W / ADS-3600W) B

When you need to enter text into the machine, the keyboard appears on the Touchscreen.
 

NOTE
• To change between lower-case or upper-case, press .

• To toggle between keyboard layouts (letters, numbers, or symbols), press .
 

Inserting Spaces B

To enter a space, press Space. Or, move the cursor forward by pressing c.

NOTE
The characters that are available may differ depending on your country.

 

Making Corrections B

If you entered an incorrect character and want to change it, press d to move the cursor to highlight the 
incorrect character, and then press . Enter the correct character. You can also insert letters by moving the 
cursor and entering a character.

Press  for each character you want to erase, or press and hold  to erase all the characters.

Appendix B
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LED Indications (ADS-2400N / ADS-3000N) B

The LED indications shown in the table below are used in the illustrations in this chapter.

 or 
The LED is off.

 or 
The LED is on.

 or 
The LED is blinking.

LEDs Machine Status 
 Ready (USB connected)

The machine is ready to scan and connected to a 
USB device.

 Ready (Computer connected)

The machine is ready to scan and connected to your 
computer.

 Ready (Network Device 1)

The machine is ready to scan and connected to 
Network Device 1.
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 Ready (Network Device 2)

The machine is ready to scan and connected to Network 
Device 2.

 Ready (Network Device 3)

The machine is ready to scan and connected to Network 
Device 3.

 Connecting (Scan to PC)

The machine is connecting to scan to a computer.

 Connecting (Scan to Network Device 1)

The machine is connecting to scan to Network Device 1.

LEDs Machine Status 
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 Connecting (Scan to Network Device 2)

The machine is connecting to scan to Network Device 2.

 Connecting (Scan to Network Device 3)

The machine is connecting to scan to Network Device 3.

 Scanning (Scan from PC)

The machine is scanning from a computer.

 Sending (Scan to Network Device 1)

The machine is scanning to the device that you assigned 
to Network Device 1.

LEDs Machine Status 
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 Sending (Scan to Network Device 2)

The machine is scanning to the device that you assigned 
to Network Device 2.

 Sending (Scan to Network Device 3)

The machine is scanning to the device that you assigned 
to Network Device 3.

 All Pages Were Skipped

All scanned pages were skipped as blank pages. Press 
any button, and then do one of the following:

 Place your document, face down, top edge first in the 
ADF.

 Set Blank Page Skip to Off by doing one of the 
following:

• See Change Scan Settings (ControlCenter4) 

(Windows®) on page 98.

• See Scan Using Brother iPrint&Scan (Mac) 
on page 104.

• See Change Scan to PC Settings (Windows®) 
on page 186.

• See Scan Options Using the Touchscreen 
(ADS-2800W / ADS-3600W) on page 194.

LEDs Machine Status 
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 Out of Memory (Scan to USB)

The machine memory is full and the machine cannot scan 
the entire document.
To clear the error, do one of the following:

 Press any button.

 Turn the machine off and on by unplugging the 
machine from the AC electrical socket, and then 
plugging the machine in again.

To prevent the error, do one of the following:

 Reduce the number of your documents.

 Decrease the resolution setting or file size.
 Too Many Files on USB (Scan to USB)

Your machine cannot save to a USB flash drive if the drive 
contains too many files. Remove the USB flash drive, 
press any key, and then do one of the following:

 Delete unused files or folders from the root folder of the 
USB flash drive, and then try again.

 Use a USB flash drive that contains fewer than 
999 files.

 File Name Cannot Be Used (Scan to USB)

The maximum sequential number for the file name has 
been reached. Press any button, and then do one of the 
following:

 Delete unused files from the USB flash drive, and then 
try again.

 Change the file name by doing one of the following:

• See Change Scan Settings (ControlCenter4) 
(Windows®) on page 98.

• See Scan Using Brother iPrint&Scan (Mac) 
on page 104.

• See Change Scan to PC Settings (Windows®) 
on page 186.

• See Save Scanned Documents on a USB Flash 
Drive on page 137.

LEDs Machine Status 
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 Write Protect

Media is write protected. To clear the error, press Stop.

Scheduled Maintenance Alert

Scheduled maintanance alert counter is up to max. Please 
clean the rollers in the machine and reset the counter.

 Access Error

Media has been pulled out. To clear the error, press Stop.

 Authenticate Error (Scan to FTP)

The FTP user name and password you have entered are 
incorrect or not configured correctly.

Confirm that the user name and password are configured 
or entered correctly, and then try again.

LEDs Machine Status 
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 Server Time Out (Scan to FTP)

Check the following and then try again:

 The network settings are correct.

 Your wireless access point/router is turned on.

 The remote FTP server is turned on.

 The name (or IP address) of the FTP remote server is 
correct.

 Sending Error (Scan to FTP)

Check the following and then try again:

 You have writing permission for the destination folder.

 The hard disk containing the destination folder is not 
full. (If the hard disk is full, free some disk space, and 
then try again.)

 Out of Memory (Scan to FTP)

The machine memory is full and the machine cannot scan 
the entire document. To clear the error, do one of the 
following:

 Press any button.

 Turn the machine off and then on by unplugging the 
machine from the AC electrical socket and then 
plugging the machine in again.

To prevent the error, do one of the following:

 Reduce the numbers of your documents.

 Decrease the resolution setting or file size.
 Out of Memory (Scan to PC)

Check the following and then try again:

 You have write permissions for the destination folder.

 The hard disk containing the destination folder is not 
full. (If the hard disk is full, free some disk space, and 
then try again.)

LEDs Machine Status 
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 Out of Memory (WS Scan)

Check the following and then try again:

 You have write permissions for the destination folder.

 The hard disk containing the destination folder is not 
full. (If the hard disk is full, free some disk space, and 
then try again.)

 Sleep Mode

The machine is in Sleep Mode.

Do one of the following to wake up the machine:

 Press the Power key.

 Open the ADF cover.

 Load your document.

 Touch the screen.

 Touch an IC Card to the NFC reader (ADS-3600W 
only).

The machine enters Ready mode.
 Document Jam

Clear the document jam (see Document Jam 
on page 229), and then do the following:

 Select Long Paper (Auto) from the Scan Size or 
Document Size drop-down list when scanning a long 
document.

To change the settings, do one of the following:

 See Change Scan Settings (ControlCenter4) 
(Windows®) on page 98.

 See Change Scan Button Settings from Brother 
iPrint&Scan (Mac) on page 104.

 See Change Scan to PC Settings (Windows®) 
on page 186.

LEDs Machine Status 
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 Ejecting Paper

The machine is ejecting paper. 

 Stop Ejecting

To pause ejecting the document or plastic cards, press 
Stop. To resume ejecting, press Stop again.

 Remote Setup

Remote Setup is in process. To cancel Remote Setup, 
click the Cancel button in the Remote Setup window on 
your computer.

 Scan Exceeded a Specific Area

The machine has scanned more than five metres of a 
document with the Long Paper setting. To clear the error, 
press Stop.

LEDs Machine Status 
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 Multifeed Detection Error

A multifeed has occurred. To clear the error, press Stop.

 ADF Cover Open

ADF cover is open.

 Pick-up Roller Alert

The pick-up roller counter has reached its limit. To clear 
the error, do the following:

 Reset the pick-up roller counter.

 Reverse Roller Alert

The reverse roller has been used over 200,000 times.

To clear the error, do the following:

 Reset the reverse roller counter.

LEDs Machine Status 
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 Pick-up Roller & Reverse Roller Alert

The pick-up roller and reverse roller have been used over 
the limit. Replace the supplies, and then to clear the error, 
do one of the following:

 Reset the pick-up roller counter.

 Reset the reverse roller counter.

 Pick-up Roller Alert, Reverse Roller Alert, and 
Scheduled Maintenance Alert

The pick-up roller and reverse roller have been used over 
the limit and periodic cleaning counter exceeds the limit. 
Replace the supplies, and then to clear the error, do the 
following:

 Reset the pick-up roller counter.

 Reset the reverse roller counter.

 Reset the periodic cleaning counter.
 Pick-up Roller Alert and Scheduled Maintenance Alert

The pick-up roller has been used over the limit and periodic 
cleaning counter exceeds the limit. Replace the supplies, 
and then to clear the error, do the following:

 Reset the pick-up roller counter.

 Reset the periodic cleaning counter.

 Revserse Roller Alert and Scheduled Maintenance 
Alert

The reverse roller has been used over the limit and 
periodic cleaning counter exceeds the limit. Replace the 
supplies, and then to clear the error, do the following:

 Reset the reverse roller counter.

 Reset the periodic cleaning counter.

LEDs Machine Status 
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Service Call Indications B

If an error cannot be cleared by the user, the machine indicates that a service call is needed by lighting up all 
the LEDs.
 

If you see the service call indication shown above, turn the machine off and then on, and then try to scan 
again.

If the error is not cleared after turning the machine off and then on, press Stop. The LEDs light up as shown 
in the table below to indicate the error type:

Make a note of the error code and report it to your Brother dealer or Brother customer service.

Error Code Network 
Device 1

Network 
Device 2

Network 
Device 3

Scan to 
PC

Scan to 
USB

Error 
Indicator

Power 
Indicator

A7: Not a ROM of 
matching colour 
Parameter to CIS Maker

A9: Detected a special 
scanning error
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Scan Settings 10

When using your machine and a computer to scan:

Category Setting Option
Configurable 
Settings in 

TWAIN

Configurable 
Settings in 

CC4

Basic Settings

2-sided Scan Off / Long Edge / Short Edge
  

Scan Type
Auto / Black and White / True Grey / 24bit Colour

  

Grey (Error Diffusion)
  

Resolution

100 dpi / 150 dpi
  

200 dpi / 300 dpi / 600 dpi
  

400 dpi
  

1200 dpi
  

File Type

PDF Single-Page / PDF Multi-Page / JPEG / 
TIFF Single-Page / TIFF Multi-Page

-
 

PDF/A Single-Page / PDF/A Multi-Page / Secure 
PDF Single-Page / Secure PDF Multi-Page / 
High Compression PDF Single-Page / 
High Compression PDF Multi-Page / 
Searchable PDF Single-Page / Searchable PDF 
Multi-Page

-
 

Signed PDF Single-Page / Signed PDF Multi-Page - -

Windows Bitmap (.bmp) / Portable Network 
Graphics (.png) / XPS

-
 

Document Size

Auto / A4 / Letter / Legal / JIS B5 / A5 / JIS B6 / A6 / 
Business Card / Long Paper (Auto)

  

Executive / Index Card / Photo / Photo L / Photo 2L / 
Post Card 1 / Post Card 2 (Double)/ Folio

  

1 to 2(A3) / 1 to 2(Ledger) / 1 to 2(B4) / 1 to 2(A4) / 
2 in 1(A4) / 2 in 1(Letter) / 2 in 1(A5) / 2 in 1(B5)

-
 

Custom
 

-

File Size (Compression 
rate adjustment)

- -
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Image Processing

Auto Deskew On / Off
  

Remove Background 
Colour

Bleed-through / Remove Background Colour
  

Colour Tone Adjustment

Auto
 

-

Custom Brightness   

Contrast   

Shadow  

-

Highlight  

-

Gamma  

-

Greyscale Adjustment Brightness / Contrast
 

-

Auto Colour Detect Adjust Auto Colour Detect Adjust
 

-

Skip Blank Page Skip Blank Page
  

Margin Setting for 
Cropping

Top: between -3.0 mm and 3.0 mm
Left: between -3.0 mm and 3.0 mm
Right: between -3.0 mm and 3.0 mm
Bottom: between -3.0 mm and 3.0 mm

 

-

Punch Hole Removal Paint colour White / Background colour
 

-

Edge Emphasis On (Low, Middle, High) / Off 
 

-

Boldface Formatting On (Low, Middle, High) / Off 
 

-

Blurred Character 
Correction

On / Off
 

-

B&W Inversion On / Off
 

-

Noise Reduction On (Low, Middle, High) / Off 
 

-

Remove Ruled Line Vertical / Horizontal / Vertical and Horizontal
 

-

Edge Fill White / Black
 

-

Colour Drop Chromatic Colour / Red / Green / Blue / Custom
 

-

Special Mode

Multifeed Detection On / Off
  

Layout
None / 2in1: Long Edge / 2in1: Short Edge / 
1to2: Long Edge / 1to2: Short Edge

 

-

Carrier Sheet Mode On / Off
  

Plastic Card Mode On / Off
  

Detail Settings
Continuous Scan On / Off

  

Single Page Scan On / Off
 

-

Category Setting Option
Configurable 
Settings in 

TWAIN

Configurable 
Settings in 

CC4
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When using your machine’s control panel and a computer to scan:

Category Setting Option

Configurable 
Settings from 

CC4 
(ADS-2400N / 
ADS-3000N / 
ADS-2800W / 
ADS-3600W)

Configurable 
Settings in 

Control Panel 
(ADS-2800W /
ADS-3600W)

Saving 
Settings to 
a shortcut 

(ADS-2800W /
ADS-3600W)

Basic 
Settings

2-sided Scan Off / Long Edge / Short Edge
   

Scan Type

Auto / Black and White / True Grey / 24bit 
Colour

   

Grey (Error Diffusion)
 

- -

Resolution

100 dpi
 

- -

150 dpi / 200 dpi / 300 dpi / 600 dpi
   

400 dpi
 

- -

1200 dpi
 

- -

File Type

PDF Single-Page / PDF Multi-Page / JPEG / 
TIFF Single-Page / TIFF Multi-Page

   

PDF/A Single-Page / PDF/A Multi-Page / 
Secure PDF Single-Page / High Compression 
PDF Single-Page / High Compression PDF 
Multi-Page / Searchable PDF Single-Page / 
Searchable PDF Multi-Page

 

- -

Signed PDF Single-Page / Signed PDF 
Multi-Page

- - -

Windows Bitmap (.bmp) / Portable Network 
Graphics (.png) / Microsoft Office Word (*.docx) 
/ Microsoft Office PowerPoint (*.pptx) / XPS

 

- -

Secure PDF Multi-Page / Signed PDF 
Single-Page

- - -

Document Size

Auto / A4 / Letter / Legal / JIS B5 / A5 / JIS B6 / 
A6 / Business Card / Long Paper (Auto)

   

A3 / Ledger / JIS B4 / Executive / Index Card / 
Photo / Photo L / Photo 2L / Post Card 1 / 
Post Card 2 (Double) / Folio

 

- -

1 to 2(A3) / 1 to 2(Ledger) / 1 to 2(B4) / 
1 to 2(A4) / 2 in 1(A4) / 2 in 1(Letter) / 
2 in 1(A5) / 2 in 1(B5)

 

- -

Custom - - -

File Size 
(Compression rate 
adjustment)

-
 

- -
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Image 
Processing

Auto Deskew On / Off
   

Remove Background 
Colour

Bleed-through / Remove Background Colour
 

- -

Colour Tone 
Adjustment

Auto - - -

Custom Brightness    

Contrast    

Shadow - - -

Highlight - - -

Gamma - - -

Greyscale Adjustment Brightness / Contrast - - -

Auto Colour Detect 
Adjust

Auto Colour Detect Adjust - - -

Skip Blank Page Skip Blank Page
   

Document Separation Off / Number of Documents / Number of Pages -
  

Margin Setting for 
Cropping

Top: between -3.0 mm and 3.0 mm
Left: between -3.0 mm and 3.0 mm
Right: between -3.0 mm and 3.0 mm
Bottom: between -3.0 mm and 3.0 mm

- - -

Punch Hole Removal Paint colour White / Background colour - - -

Edge Enhancement - - - -

Boldface Formatting - - - -

Blurred Character 
Correction

On / Off - - -

Noise Reduction - - - -

Remove Ruled Line Vertical / Horizontal / Vertical and Horizontal - - -

Edge Fill White / Black - - -

Colour Drop Chromatic Colour / Red / Green / Blue / Custom - - -

Special 
Mode

Multifeed Detection On / Off
 

- -

Carrier Sheet Mode On / Off
 

- -

Plastic Card Mode On / Off
 

- -

Detail 
Settings

Continuous Scan On / Off
   

Detect End of Page On / Off - - -

Category Setting Option

Configurable 
Settings from 

CC4 
(ADS-2400N / 
ADS-3000N / 
ADS-2800W / 
ADS-3600W)

Configurable 
Settings in 

Control Panel 
(ADS-2800W /
ADS-3600W)

Saving 
Settings to 
a shortcut 

(ADS-2800W /
ADS-3600W)
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When using only your machine’s control panel to scan:

Category Setting Option

Configurable 
Settings in 

Control Panel 
(ADS-2800W / 
ADS-3600W)

Saving 
Settings to 
a shortcut 

(ADS-2800W / 
ADS-3600W)

Basic Settings

2-sided Scan Off / Long Edge / Short Edge
  

Scan Type
Auto / Black and White / True Grey / 24bit Colour

  

Grey (Error Diffusion) - -

Resolution

100 dpi - -

150 dpi / 200 dpi / 300 dpi / 600 dpi
  

400 dpi - -

1200 dpi - -

Auto
  

File Type

PDF Single-Page / PDF Multi-Page / JPEG / 
TIFF Single-Page / TIFF Multi-Page

  

PDF/A Single-Page / PDF/A Multi-Page / 
Secure PDF Single-Page / Secure PDF Multi-Page / 
High Compression PDF Single-Page / 
High Compression PDF Multi-Page / Searchable 
PDF Single-Page / Searchable PDF Multi-Page

  

Signed PDF Single-Page / Signed PDF Multi-Page
  

Windows Bitmap (.bmp) / Portable Network 
Graphics (.png) / XPS

- -

Document Size

Auto / A4 / Letter / Legal / JIS B5 / A5 / JIS B6 / A6 / 
Business Card / Long Paper (Auto)

  

A3 / Ledger / JIS B4 / Executive / Index Card / 
Photo / Photo L / Photo 2L / Post Card 1 / 
Post Card 2 (Double)/ Folio

- -

1 to 2(A3) / 1 to 2(Ledger) / 1 to 2(B4) / 1 to 2(A4) / 
2 in 1(A4) / 2 in 1(Letter) / 2 in 1(A5) / 2 in 1(B5)

- -

Custom - -

File Size (Compression 
Rate Adjustment)

-
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Image Processing

Auto Deskew On / Off
  

Remove Background 
Colour

Bleed-through / Remove Background Colour - -

Colour Tone Adjustment

Auto - -

Custom Brightness   

Contrast   

Greyscale Adjustment Brightness / Contrast - -

Auto Colour Detect Adjust Auto Colour Detect Adjust
  

Skip Blank Page Skip Blank Page
  

Document Separation Off / Number of Documents / Number of Pages
  

Margin Setting for 
Cropping

Top: between -3.0 mm and 3.0 mm
Left: between -3.0 mm and 3.0 mm
Right: between -3.0 mm and 3.0 mm
Bottom: between -3.0 mm and 3.0 mm

  

Punch Hole Removal Paint colour White / Background colour - -

Edge Enhancement - - -

Boldface Formatting - - -

Blurred Character 
Correction

On / Off - -

Noise Reduction - - -

Remove Ruled Line Vertical / Horizontal / Vertical and Horizontal - -

Edge Fill White / Black - -

Colour Drop Chromatic Colour / Red / Green / Blue / Custom - -

Special Mode

Multifeed Detection On / Off - -

Carrier Sheet Mode On / Off - -

Plastic Card Mode On / Off - -

Detail Settings
Continuous Scan On / Off

  

Detect End of Page On / Off - -

Category Setting Option

Configurable 
Settings in 

Control Panel 
(ADS-2800W / 
ADS-3600W)

Saving 
Settings to 
a shortcut 

(ADS-2800W / 
ADS-3600W)
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